PART A

CONCEPT: A Conceptual Environmental Design Tool

DISCUSSION
Index

1 Abstract .............................................................................................................................................. 4

2 Design Tools ........................................................................................................................................ 6
  2.1 Definition .......................................................................................................................................... 6
  2.2 Computer Modelling and Efficient Design ...................................................................................... 6
    2.2.1 Increasing Design Confidence ................................................................................................. 6
    2.2.2 The Validity of Design Tools ................................................................................................... 7
    2.2.3 Making a Difference .................................................................................................................. 7
  2.3 Building Performance ..................................................................................................................... 8
    2.3.1 Lighting Analysis and Simulation ............................................................................................... 9
    2.3.2 Shadow Analysis ...................................................................................................................... 11
    2.3.3 Thermal Performance Analysis ................................................................................................ 11
    2.3.4 Computational Fluid Dynamics ............................................................................................... 13
  2.4 Towards Integration ......................................................................................................................... 13

3 A Conceptual Design Tool .................................................................................................................. 15
  3.1 Conceptual Design .......................................................................................................................... 15
  3.2 Next Generation Design Tools ......................................................................................................... 15
  3.3 A New Approach .............................................................................................................................. 16
  3.4 An Intelligent Interface ................................................................................................................... 17
    3.5.1 3D Cursor System .................................................................................................................... 18
    3.5.2 Relationship Mapping ............................................................................................................... 20
    3.5.3 Nodal Manipulation .................................................................................................................. 20
  3.6 Graphical Display of Inputs and Outputs ......................................................................................... 21
    3.6.1 Establishing a 3D Viewpoint ...................................................................................................... 21
    3.6.2 Working in 3D .......................................................................................................................... 22
    3.6.3 Displaying Calculations in 3D ................................................................................................. 22
  3.7 Multi-level Inputs .............................................................................................................................. 23
    3.7.1 Progressive Data Input .............................................................................................................. 23
    3.7.2 Process Modelling ..................................................................................................................... 24
  3.8 Use of Components and Library Data ............................................................................................... 25
    3.8.1 Material Libraries .................................................................................................................... 26
  3.9 Interoperability with Other Tools .................................................................................................... 26

4 The Implementation ............................................................................................................................ 29
  4.1 Automatic data gathering .................................................................................................................. 29
    4.1.1 Surface Areas .......................................................................................................................... 29
    4.1.2 Volumes ................................................................................................................................... 30
4.1.3 Intersection Points ................................................................. 31
4.1.4 Adjacency ........................................................................ 31

4.2 Shadow Analysis ..................................................................... 32
  4.2.1 Sunrise and Sunset ............................................................ 33
  4.2.2 Horizontal and Vertical Shadow Angles (HSA & VSA) ....... 34
  4.2.3 Viewing From Sun ......................................................... 34
  4.2.4 Overshadowing ............................................................... 34
  4.2.5 Isolating Individual Shadows ......................................... 35
  4.2.6 Shadow Profiles ............................................................. 36

4.3 Stereographic Analysis .......................................................... 37

4.4 Solar Exposure ........................................................................ 38
  4.4.1 Global, Beam and Diffuse Irradiance ......................... 38
  4.4.2 Shading Factor ............................................................... 40
  4.4.3 Solar Exposure Graphs .................................................. 41
  4.4.4 Angular-Dependant Reflectivity ................................... 41

4.5 Shading Device Design ......................................................... 42
  4.5.1 Solar Profiles ............................................................... 43
  4.5.2 Solar Extrusions ............................................................ 43

4.6 Daylight Factor ....................................................................... 44
  4.6.1 Geometric Method ......................................................... 44
  4.6.2 Internally Reflected Component ................................... 45
  4.6.3 Translation Into Illumination ....................................... 45

4.7 Artificial Lighting .................................................................... 46

4.8 RADIANCE Output ............................................................... 46

4.9 Thermal Performance .......................................................... 47
  4.9.1 Internal Temperatures .................................................. 47
  4.9.2 Heating and Cooling Loads ......................................... 48
  4.9.3 Passive Design Analysis .............................................. 49
  4.9.4 Isolated Component Analysis ..................................... 50

4.10 Statistical Acoustics .............................................................. 51

4.11 Acoustic Raytracing .............................................................. 53
  4.11.1 Sprayed Rays ............................................................... 53
  4.11.2 The Image Method ...................................................... 54
  4.11.3 The Hybrid Image Method ......................................... 55
  4.11.4 Relating Room Geometry to Room Response ............... 56
  4.11.5 Derived Information .................................................. 57

5 Conclusion ................................................................................. 60

Bibliography .............................................................................. 62
1 ABSTRACT

“Environmental design replaces structure as the principal problem of architectural science” [Cowan, 1966]. In response, more than 20 years later, Manning writes: “Despite enormous amounts of research that has been undertaken into many aspects of building environment, and the store of knowledge that has accumulated, design of the environment too often appears to be a matter of chance. Users of today’s new buildings are just as liable as were users of earlier buildings to be uncomfortable.” [Manning, 1987].

A significant amount of the research referred to by Manning has been directed into the development of computer software for building simulation and performance analysis. A wide range of computational tools are now available and see relatively widespread use in both research and commercial applications.

The focus of development in this area has long been on the accurate simulation of fundamental physical processes, such as the mechanisms of heat flow though materials, turbulent air movement and the inter-reflection of light. The adequate description of boundary conditions for such calculations usually requires a very detailed mathematical model. This has tended to produce tools with a very engineering-oriented and solution-based approach.

Whilst becoming increasingly popular amongst building services engineers, there has been a relatively slow response to this technology amongst architects. There are some areas of the world, particularly the UK and Germany, where the use of such tools on larger projects is routine. However, this is almost exclusively during the latter stages of a project and usually for purposes of plant sizing or final design validation. The original conceptual work, building form and the selection of materials being the result of an aesthetic and intuitive process, sometimes based solely on precedent.

There is no argument that an experienced designer is capable of producing an excellent design in this way. However, not all building designers are experienced, and even fewer have a complete understanding of the fundamental physical processes involved in building performance. These processes can be complex and often highly inter-related, often even counter-intuitive.

It is the central argument of this thesis that the needs of the building designer are quite different from the needs of the building services engineer, and that existing building design and performance analysis tools poorly serve these needs.
It will be argued that the extensive quantitative input requirement in such tools acts to produce a psychological separation between the act of design and the act of analysis. At the conceptual stage, building geometry is fluid and subject to constant change, with solid quantitative information relatively scarce. Having to measure off surface areas or search out the emissivity of a particular material forces the designer to think mathematically at a time when they are thinking intuitively.

It is, however, at this intuitive stage that the greatest potential exists for performance efficiencies and environmental economies. The right orientation and fenestration choice can halve the air-conditioning requirement. Incorporating passive solar elements and natural ventilation pathways can eliminate it altogether. The building form can even be designed to provide shading using its own fabric, without any need for additional structure or applied shading. It is significantly more difficult and costly to retrofit these features at a later stage in a project’s development.

If the role of the design tool is to serve the design process, then a new approach is required to accommodate the conceptual phase. This thesis presents a number of ideas on what that approach may be, accompanied by some example software that demonstrates their implementation.
2 DESIGN TOOLS

2.1 Definition

The term design tool is generally applied to a wide range of techniques, from the use of tabulated data sheets and manual calculation methods, through to sophisticated computer analysis software. In the context of this work, the term is used to describe computer software developed to replace laborious manual calculations used to inform the design decision-making process. Using a computer to perform the mathematical component makes it possible to study effects not previously considered in many building designs.

2.2 Computer Modelling and Efficient Design

Performance modelling and simulation are becoming increasingly important in building design, particularly during the building services phase. The forthcoming CIBSE Application Manual on energy and environmental modelling is set to endorse computer modelling as part of the engineering design process [Ruyssevelt 1997].

Whether driven by social conscience or purely financial concerns, there is a concurrent move towards better performing and more efficient buildings. Many designers see the increased use of modelling and simulation tools as a way of achieving this.

2.2.1 Increasing Design Confidence

Building design is full of uncertainty. Whether it is the architect uncertain of how much light a window might let in, or the mechanical engineer uncertain of exactly how much solar gain to allow for, this lack of surety results in a significant amount of over-design.

It is standard practice throughout the building industry to include safety factors and margins for error within design calculations. Studies have shown that these are generally between 5 and 10% [Parsloe 1995, Brittain 1996]. However, research by the Building Services Research and Information Association (BSRIA) suggests that such small margins, when applied many times at different points within a design, can result in a cumulative design margin of up to 60% [Race 1997].

There are many valid reasons for the use of safety factors, from uncertainties over the validity of a calculation method to the dubious accuracy of a manufacturer’s material specification. In some cases the information required in a design may be difficult to properly quantify, such as the variability of a material’s thermal resistance with moisture content. The spare capacity that
results from over-design may even be desirable, allowing for future expansion or even deterioration in a system’s performance over time.

Whilst the use of design tools may not automatically eradicate high safety margins and over-design, experience shows that they can significantly increase a designer’s confidence in the solution [Palmer 1997]. Most design margins result from the perceived application of a generalised solution to a very specific problem. As the use of most advanced simulation tools begins with the entry of a very detailed model, the results produced at least appear to be more specific to the actual problem they are being applied to.

2.2.2 The Validity of Design Tools
The underlying assumption here is that results produced by a design tool are more accurate than manual calculations or rules of thumb. Some doubt does exist over the true validity of computer simulation methods when compared directly with real buildings [Bunn 1995], however, there is relatively little doubt about their improved accuracy over other calculation methods.

This has been shown in any number of projects where sophisticated thermal analysis and computational fluid dynamics (CFD) applications have been used. The increased number of design parameters that can be considered and the level of detail to which performance can be simulated is far beyond the scope of any manual method.

There is always potential for the inappropriate application of a design tool, or even the input of erroneous data. However, this is true of any method.

2.2.3 Making a Difference
Since the early 1960’s, the use of computer modelling and simulation tools within the building industry has steadily increased. These tools have progressed from simple single-task applications with limited input and output requirements [Howard 1960, Belchambers, et al 1961], to quite sophisticated modelling systems that can simultaneously analyse a range of performance parameters.

However, after nearly 30 years of development, there is still some scepticism as to the necessity and applicability of such tools to the design process. The basic question still remains: “Does the use of simulation and validation tools actually produce better buildings?”

The main focus in the development of design tools has been the accurate simulation of natural processes, heat flow through materials, the turbulent movement of air and the inter-reflection of
light. The result is a range of software tools well suited to the task of detailed design validation. However, the user interfaces and specialist skills required to properly drive them mean that they are still very much part the engineering domain, used only in the final stages of a project.

The real challenge is to make these tools applicable to the earlier stages of design, where a more informed analysis of possible alternatives can yield the most benefit and the greatest cost savings, both economic and environmental. Specialist skills may still be required, but just as important is the ability to translate the loosest architectural sketch into a valid input model and translate the result into fundamentally solid design feedback.

This is where computer modelling and simulation can really lead to better and more efficient buildings, both in terms of their internal environment and the environmental impact on their surroundings.

2.3 Building Performance

The invention of the Carrier air-conditioning system is seen by many as having liberated the architect from the constraints of climate. The capability of mechanical services to produce a controllable and comfortable internal environment within any building is almost unquestioned in modern architecture.

This capability is well understood by architects and, together with artificial lighting technology, underpins the majority of building design. However, there is still a significant demand for non-mechanically serviced and naturally lit buildings as the social and economic benefits of passive environmental controls gain recognition amongst both architects and clients.

Unfortunately, there is concern as to the finite capacity of natural systems, compared to the perceived infinite capacity of mechanical systems. This make designers wary of passive design solutions unless they can be rigorously validated and clearly shown to work in each specific case. This is where modelling plays its part, making it more viable to use windows and vents instead of electric lights and air-conditioning by providing some assurance that the same levels of occupant comfort can be achieved.

The rest of this chapter is a brief analysis of exactly what performance characteristics can be modelled using existing design tools and how those results can be used to aid building design.
2.3.1 Lighting Analysis and Simulation

The aim of any form of lighting simulation is to be able to predict lighting levels at points within a space or over an entire surface. The process of accurately calculating these levels can become quite involved given the complex nature of surface inter-reflection. As a result, there exist a range of methods of varying sophistication for lighting analysis and simulation.

The simplest means of calculating light levels is to simply sum the contribution of each visible light source. This is known as the point-by-point method and takes account of the distribution pattern of each source. Indirect light and diffuse reflections off surrounding surfaces are not considered. This is a useful method for examining the distribution of light from multiple sources. The resulting levels significantly underestimate actual levels, however they offer important feedback at the design stage of a lighting system.

Calculating natural light levels is more difficult as diffuse light from the sky dome itself is often the main source, not just the direct sun. As cloud cover is a significant variable, a model of the distribution of light over the sky has to be used. The Commission Internationale de l’Eclairage (CIE) define a number of such models, for overcast, uniform and sunny conditions. These models were developed for use with the Daylight Factor method of daylight estimation, which is defined by CIE as follows:

‘The Daylight Factor is the ratio of the daylight illumination at a point on a given plane due to light received directly or indirectly from a sky of assumed or known luminance distribution, to the illumination on a horizontal plane due to an unobstructed hemisphere of this sky. Direct sunlight is excluded for both values of illumination.’ [Longmore 1968]

Daylight factors can be calculated manually using the British Research Station (BRS) Daylight Factor Protractors or lighting applications such as Adeline from the International Energy Agency (IEA).

More sophisticated methods of lighting analysis make use of full rendering techniques. The aim when using more advanced lighting simulation tools is to produce realistic images of the spaces within a geometric building model that correspond as closely as possible to what would actually be found if that space were real. There are many applications that produce rendered images from three dimensional models. However, there is a major difference between photo-realistic rendering and actual lighting simulation.
The following extract explains this difference quite succinctly. This is taken from notes written by Greg Ward to accompany the RADIANCE lighting simulation tool developed at Lawrence Berkeley Laboratories.

“Photo-realistic rendering places emphasis on the appearance of its output rather than the techniques used to derive it. Anything goes, basically, as long as the final image looks nice. There is no attempt to use physically realistic values for the light sources or the surface reflectances. In fact, the light sources themselves often have physically impossible characteristics like $1/r$ falloff (as opposed to $1/r^2$) or there is a lot of ambient lighting that comes from nowhere but somehow manages to illuminate the room. (You are probably saying “Hey! Doesn’t RADIANCE use an ambient term?” The answer is yes, but only as a final approximation of the interreflected component. The renderers I’m talking about use the ambient level as the main source of illumination!) Also surfaces typically have colour but there is no reflectance given, so all the surfaces appear to have the same brightness.”

“Physically-based rendering, on the other hand, follows the physical behavior of light as closely as possible in an effort to *predict* what the final appearance of a design might be. This is not an artist’s conception any more, it is a numerical simulation. The light sources start in the calculation by emitting with a specific distribution, and the simulation computes the reflections between surfaces until the solution converges.” [Ward 1994]

Light levels shown in images generated from detailed simulations of the physical processes of light are actual levels that can be read directly. This means that they have direct relevance to a particular design, indicating if levels are too low or if sources of glare discomfort are present. Post-processing of such image can be used to overlay contour lines or even to derive more complex information such as illuminance levels, daylight factors, glare indexes and even visual comfort.

The most sophisticated of lighting simulation techniques involves the analysis of flux transfer between surfaces. Known as “radiosity”, this technique requires that all surfaces be divided into small patches that exchange light energy within a closed system. The computation is iterative, progressively refining the energy exchange until the variance between iterations is insignificant. Ashdown [1994] gives a comprehensive account of this technique and its practical application.
Radiosity is very computationally intensive. For the most part, it is limited to relatively simple scenes with mostly diffuse surfaces. Highly specular surfaces or very complex geometry can lead to excessive convergence times.

Hybrid techniques which combine radiosity with ray-tracing are used in some simulation tools. These involve tracing light rays in the reverse direction, from a point on the surface of an object back to its sources of direct and indirect light. RADIANCE is an example of a tool that uses a hybrid technique. It uses a geometric rays to determine the portion of other surfaces visible from sample points. Ambient light levels are then iteratively calculated for all points by interpolating between sample points.

A less accurate method is that of geometric ray-tracing. This technique is adequate for representing the effects of direct lighting and low order reflection, but does not represent high order interreflection or diffuse light well at all. This tends to be the technique used by most photo-realistic rendering applications used for artistic visualisation.

### 2.3.2 Shadow Analysis

An adjunct to lighting simulation is the analysis of sun penetration and solar shading. Whilst there are a number of dedicated shadow and reflection analysis applications available, such as SR [Owen and Roy, 1989] and SunCast [IES 1997], shadow analysis is mainly performed using CAD-based rendering and visualisation tools. Applications such as ArchiCAD and Microstation are examples of CAD packages with in-built solar position routines.

Many thermal analysis tools include functions for calculating and displaying shadows, such as FACET [IES 1997] and TAS [EDSL 1995].

### 2.3.3 Thermal Performance Analysis

The aim of thermal analysis is twofold:

- To accurately predict the internal temperatures of spaces within a model,
- To calculate heating and cooling loads.

Once again, there are a wide range of simulation techniques with varying levels of sophistication and accuracy.

The most basic method of heat load analysis is based on the *Building Loss Coefficient (BLC)* which is a function of the U-Value and surface area of each element in the building fabric. This single figure quantifies the amount of heat loss over the entire building for a given temperature...
difference between inside and outside. Climate data can then be used determine incident solar radiation on surfaces and then calculate heating and cooling loads required if some static internal conditions are to be maintained. The Carrier method as described in the AIRAH/Department of Housing and Construction Design Aid - Air Conditioning is an example of this technique.

Such methods are known as steady state calculations as there is no accounting for the thermal response of the building fabric to cyclical fluctuation in temperature. There are a number of methods of calculating the non-steady state or dynamic response of a building. The simplest of these is the Admittance method as described in Section A9 of 1986 CIBSE Guide. This is based on a steady state calculation but simulates the dynamic performance as fluctuations about a mean.

More advanced methods such as the ASHREA Response Factor and the Finite Difference Method more accurately represent the dynamic response of buildings. These are significantly more computationally intensive and require a very precise building model. Simulation tools based on these methods, such as TAS, DOE-2 and ESP(r), are widely used and have undergone a number of validation processes.

By accurately modelling the physical processes of heat and air flow, it is possible to simulate more complex thermal systems such as under-floor heating, chilled beams, displacement ventilation, passive solar elements and natural ventilation systems. Such tools can also calculate sensible and latent loads, radiant temperatures, inter-zonal exchange and internal solar gains tracked through multiple zones.

The main use of these tools has been in the design and analysis of air-conditioning plant. Once a geometric model is created and internal spaces zoned, internal temperatures and plant load for any space or group of spaces can be determined from actual recorded weather data. Loads can be applied to a plant schematic and the effects of diversity, pull-down and coincident loads more accurately considered when sizing air-handling units or even individual A/C outlets.

Standard practice is to size the required plant by summing the peak loads in each zone and applying a simple diversity factor to account for occupancy and sun movement. Using more sophisticated tools, peak heating and cooling loads can be determined from maximum hourly loads in each zone, taken over the entire year. Such loads take full consideration of fresh air requirements based on actual outside air conditions as well as changes in occupancy level and usage throughout each day. This level of accuracy, and the potential for increased efficiency at each component, can result in significant energy savings.
2.3.4 Computational Fluid Dynamics

Computational Fluid Dynamics (CFD) is a technique used for the prediction of airflow patterns, temperature distribution and contaminant movement within buildings and other enclosed spaces. This is a very computationally intensive technique, with some models sometimes requiring several days to converge on a solution.

CFD is well suited to the assessment of airflow in complex spaces such as atria, malls and high heat load areas as well as modelling smoke propagation. Its main benefit in design is its ability to model air movement and temperature distribution in fine detail, allowing complex natural ventilation and displacement ventilation designs to be simulated and validated. This can lead to significant savings in plant and equipment, as well as greater levels of occupant comfort.

2.4 Towards Integration

There have been a number of attempts at some level of integration within these diverse areas of building performance. An excellent example of this is the Archipack software suite for the thermal design of buildings [Szokolay, 1987]. This integrated climatic analysis with solar geometry and a simple thermal analysis engine based on the admittance method.

More recently, ongoing development of the FACET suite includes acoustic analysis, electrical and mechanical system design, thermal simulation, psychrometrics and shadow analysis. Whilst this consists of a number of individual applications, consistent data models and file formats allows building information to be shared amongst them.

The 4D <Virtual Environmental> System being developed by Integrated Environmental Systems (IES) is another example of an attempt at high level integration. It includes a range of dynamic performance analysis tools linked to the one building model, the 4D-IDM file. These consist of visualisation and animation tools, terrain modelling and landform generation, CFD, fire and smoke modelling and egress analysis.

A number of organisations and associations have been formed to promote and facilitate this integration. The International Building Performance Simulators Association (IBPSA), as defined in their newsletter ibpsaNEWS, was established to “advance and promote the science of building performance simulation in order to improve the design, construction, operation and maintenance of new and existing buildings worldwide”.

The International Alliance for interoperability (IAI) is another group formed by a number of construction companies and CAD software vendors with the aim of improving the inter-
communication of building and project information. Founded initially in North America, there is now also a UK chapter. The main focus of their work so far appears to have been the establishment of *Industry Foundation Classes* (IFC), a set of standard object definitions and data structures for describing building elements.

The gradual integration and standardisation of design tools is a logical progression if performance analysis and simulation is to gain wider penetration and acceptance within the building industry.

The one application that appears to be taking a slightly different approach is the *Building Design Advisor* (BDA). This is being undertaken as part of the Building Technologies Program, Environmental Energy Technologies Division at Lawrence Berkeley National Laboratories.

This software integrates a number of simulation tools and databases, however, it attempts to accommodate the initial schematic phase of building design as well as the detailed specification of final components and systems [Papamichael 1997]. Whilst not likely to be available until late 1998, it represents a substantially new approach. An approach that recognises the designers role at the earliest stages of design.

This is the area least well served by existing design tools yet, it is argued here, with the greatest potential for their use. It is hoped that BDA and the software described in this work will go some way to filling this void.
3 A CONCEPTUAL DESIGN TOOL

3.1 Conceptual Design

The conceptual stage of design occurs very early in the design process. This is the time when a vast array of competing requirements are shaping the initial building form, when geometry, materials and orientation are still being formulated. As these are arguably the three most important determinants of building performance, this is the most crucial stage of a project.

Conceptual design is an iterative process of generating ideas that then need to be evaluated and tested, for rejection or further refinement. Traditional methods of testing an idea involve quick perspective sketches, simple geometric analysis on a drawing board, or even small hand-calculations. The main criteria for these tests is speed. Being able to quickly reject impractical ideas can save significant amounts of time. Each newly rejected idea providing one more clue to a more acceptable one.

A major part of this testing process is play - simply playing around or experimenting with an idea until it is shown to work or not. The purpose of this is to gain some understanding, both spatially and operationally, of the full requirements of the final form [Akin 1978]. Using traditional techniques, the range of testing is quite limited.

In order to make environmental performance a practical consideration at this early stage, thereby informing the decision-making process as much as any other consideration, real and useful feedback has to be produced from what is often ill-defined and abstract information. The precise and detailed input requirements of most existing design tools preclude this. To use them, the designer must first enter the small amount of hard data they do have, and then arbitrarily quantify whatever else is needed before a result can be produced.

Overcoming this requires a completely different approach from the concise, solution-based nature of existing analysis tools.

3.2 Next Generation Design Tools

In preparation for the development of a new energy simulation tool, based on an amalgamation of two existing programs BLAST and DOE2, the US Department of Defence and Department of Energy co-sponsored two workshops on next-generation building energy simulation tools [Crawley, et al 1996].
The first workshop involved only developers and expert users of such applications whilst the second was open to general users. Participants were led through a series of creative brainstorming exercises designed to highlight areas requiring further development. The ideas produced were then collated and prioritised by vote to represent the group view.

In summarising the results of both workshops, the authors state: “Surprisingly, not many new or unusual ideas were brought up - even with a group of building energy simulation developers and users. The hundreds of ideas generated during both workshops showed instead that the field of building energy simulation still has many fundamental problems that need to be addressed. The developers will not stretch the boundaries and capabilities of simulation until more basic simulation issues are resolved.” [Crawley, et al 1997].

This is perhaps a pessimistic view that needs some qualification. Firstly, the context of both workshops was centred heavily on energy simulation and thermal analysis tools, and secondly, the participants of both workshops had significant exposure to the use of such tools. How much this affects their expectations of future tools is probably demonstrated by the workshop results.

Despite this, a number of very useful ideas were documented. In the following sections, a number of these ideas will be analysed and interpreted to form the substructure of a new conceptual design tool.

### 3.3 A New Approach

In order to be used at the earliest stages in the design of a building, any next-generation design tool must overcome the psychological separation between design and analysis that existing tools have created. As discussed previously, the primary cause of this is the detailed nature and amount of input required to describe a building model. Having to enter this data very early in the design acts to interrupt the process of iterative decision-making and forces the designer to prematurely make a series of arbitrary decisions just to produce a model acceptable to the tool.

A conceptual design tool must make the process of entering this data part of the design process itself. This is only possible if there are enough tangible benefits associated with having a model in such a format. The key to this is feedback, producing real and useful design feedback at every stage of the modelling process from data entry right through to final analysis. This places the focus firmly on the interface, the means by which the user describes and interacts with the model.
The aim is to have the creation of a simulation model replace, to some extent, the act of sketching. The primary role of the sketch is to assist the designer formalise ideas and test them against a range of design constraints [Akin 1978]. Therefore, to function similarly, the simulation model must represent building form and assist in the visualisation of the design. This advocates a very geometric approach to representation.

The challenge in this approach is to produce an interface within which geometric modelling is as simple and ‘loose’ as a sketch, yet can be used for detailed analysis at any stage in its construction. In addition, just as sketches develop and become more sophisticated, so too must the geometric model and its analysis. Further, a sketch can focus in on a very small area of a model or only one aspect of its nature. This must be true of the simulation tool as well.

3.4 An Intelligent Interface

Accommodating these requirements requires a very flexible interface, capable of satisfying the following requirements:

- Reducing the perceived input requirements to define a model,
- Maximum utilisation of whatever information is input,
- Allowance for constant development and refinement of the model.

Reducing input requirements and making the maximum use of whatever is input requires a step beyond traditional geometric interfaces that focus on geometric entities. Instead, focusing on architectural entities imbues the model with additional information which an intelligent interface can then use to automatically extract its own data or infer reasonable default values for items not directly input.

Additionally, basic relationships between architectural elements can be used to create geometric relationships between objects that can significantly reduce the time required when inputting and editing the model.

The rest of this section details the approach taken in the creation of an intelligent interface that attempts to satisfy all of the requirements stated above. The following concepts are considered fundamentally important in the development of such an interface:

- Interactive modelling and editability
- Full graphical display of inputs and outputs.
- Multi-level inputs for all calculations
- Simultaneous performance analysis
- Use of components and library data
- Interoperability with other tools
3.5 Interactive Modelling and Editability

The heart of any conceptual design tool must be its geometric modelling interface. As discussed previously, existing CAD interfaces are quite inappropriate to the inexact and interactive requirements of preliminary idea testing. At this stage, creating a model should be just about as simple as sketching it.

Sketches are usually quite simple and quick to produce. Several may be needed at different angles to test a particular idea. As such, they are disposable. The use of a computer sketching tool is only productive if:

- It is as quick and simple to create as traditional techniques,
- it can be used in place of a number of different sketches or
- it is editable and malleable enough to evolve along with an idea.

Using an innovative cursor system and increasing the editability of the model using techniques drawn from graphic design tools, it is hoped that the interface produced as part of this work meets all of the above criteria.

3.5.1 3D Cursor System

Very few designers sketch exclusively in two dimensions. Perspective views are an important tool for visualising spatial relationships between objects. As such, the ability to create objects within perspective views is considered very important. This has a number of ramifications for the type of cursor system to be used.

In applications such as AutoCAD and Microstation, the cursor is essentially two-dimensional. The orientation and offset of the working plane can be changed, but movement is restricted to this plane. Therefore, to create an object, the right cursor plane must be established first. Such a system does not allow for changes in this plane mid-creation or whilst an object is being moved.

There are a number of ways of implementing a fully 3D cursor. The method chosen here is to use keyboard modifiers to interactively alter the axis in which the cursor moves. This allows changes in height or direction at any time, even whilst dragging an object or node.

A 3D cursor position is determined from the 2D pointer by generating an imaginary ray travelling from the eye point through the picture plane at the pointer position and then through the cursor plane. Where this ray intersects the cursor plane is the 3D cursor position. The Shift and
Control keys are used here to alter the cursor plane from the X-Y plane to the X-Z or Y-Z planes, located at the current cursor position.

![Diagram of cursor planes](image)

*Figure 3.1 - Interactively changing cursor plane.*

To move a point up in Z whilst dragging using this technique, the user simply holds down the *Shift* or *Control* key, drags the 2D pointer up until the right height is reached, releases the modifier key and continues to drag the point into position. Experience has shown this to be an extremely intuitive method that most users pick up relatively quickly.

3.5.1.1 Object Snapping

In order to accurately relate objects spatially, the concept of snap points is widely used in many CAD packages. This allows a defined point on one object to be exactly aligned with a defined point on another. Object snapping provides a high degree of numerical accuracy even for objects created within a sketch-like environment.

The cursor snap mode can be set to any of the following mode at any time using either the mouse or keyboard:

- Off,
- Grid only,
- Nearest model node,
- Orthographic movement in one axis only
- Axial alignment with existing model nodes
- Intersection points between lines
- Mid-points of lines
- Object centre points
3.5.1.2 Restricted Movement

When working with objects that are geometrically related to others, there are times when their movement may be restricted. An example of this occurs when moving the nodes of a plane. In this case, the plane equation is already defined so, irrespective of the 3D cursor plane, such nodes will only ever move within the plane of the parent object.

Similarly, window and door entities inside a wall are also locked to movement within the plane of their parent object. In addition, no nodes are allowed to move outside the defining 3D polygon of the parent.

There are other more complex situations, such as when moving the nodes of an extruded object. In this case, each node will only move along the line of the extrusion vector. The full implementation of both the 3D cursor system and object snapping is discussed in Section B-7.

3.5.2 Relationship Mapping

Defining automatic geometric relationships between building elements can reduce data entry time and substantially increase model editability. It basically means deriving the geometry of one element from the geometry of another, and storing the rules used. If these rules are edited at a later time, or the parent element moved, the geometry of the child is automatically updated. If implemented correctly, for example, moving part of the floor plan or adjusting its height should automatically update the walls and ceiling of a space. Even changing the height of the first stair riser should update all others.

These relationships also extend to child objects such as windows and doors. Any movement of a parent object must automatically update the position of child objects. This is a simple matter during rotations and translations, however, resizing and rescaling must also be accommodated. The full implementation of a relationship mapping system is discussed in Section B-10.

3.5.3 Nodal Manipulation

The manipulation of the individual nodes that make up an object is an important part of any interface as it allows for increased flexibility in what geometry can be modelled. The user can take advantage of the efficiencies offered by a parametric base, but be able to add, delete or move individual nodes to form a much more complex element.

Similarly, groups of elements can be stretched by simply selecting a group of nodes and moving them together. This is very similar to the techniques used in most 2D vector graphics packages.
It also greatly improves the editability of the model once created. The selection and manipulation of object nodes is discussed in Section B-13.

3.6 **Graphical Display of Inputs and Outputs.**

The very nature of the architectural design process is visual. This is especially true of the early stages of design where the building form itself is still being established. The ability to visualise a geometric model in three dimensions is therefore considered very important.

There are three elements to working in 3D:

- the ability to manipulate and change views quickly and interactively
- the ability to generate geometry in perspective
- the ability to analysis results spatially.

3.6.1 **Establishing a 3D Viewpoint**

The purpose of three dimensional representation of building models varies with different applications. In CAD programs, three dimensional and perspective projections are used primarily for the verification of model geometry and for presentation images. This requires two systems of viewpoint generation, a relatively simple method for selecting variable angle isometric and axonometric views and a more precise method of selecting perspective viewing positions and a view vector. Given options for cutting planes and camera lens settings, establishing the right perspective view of a model can be an involved and iterative process.

Rendering and visualisation programs have similar requirements to CAD. Geometric modelling requires the ability to quickly and interactively change viewpoint, whilst generating a rendered image usually requires the precise specification of camera position and lens settings.

In a conceptual design tool, precision is not as important as interactivity. Ideally, the process of selecting a three dimensional view should be as simple as examining an object in the hand, twisting and turning it at will. This assists the designer build up a spatial understanding of their design. Similarly, switching from perspective and orthographic projection should also be a simple and instantaneous process, especially when creating or positioning objects.

The notion of interactive view manipulation has been tackled by a number of virtual reality engines, emerging as plug-ins to well known web browsers. Whilst these are based on the premise that the user will want to travel around within a model, most provide an *Examine* mode to quickly rotate around and examine the model as described above. The implementation of this
mode on many of these tools highlights two problems: What origin point and what axis to rotate around.

A significant amount of testing has been done in this work to develop a technique of model examination that is both simple and intuitive. This involved a number of methods of selecting the focus point and setting the sensitivity of the rotation angle to mouse movement.

The result is a system in which the focus point is always set to the centre of the view grid. This ensures that the model is always within view at all rotation angles. In addition, separating horizontal and vertical mouse movements into azimuth and altitude angles overcomes the problem of a changing ‘up’ vector. This is always maintained as the Z axis even though the view moves up and down. This way control is always retained and it is relatively easy to reset the view.

View rotation is simply a matter of dragging with the right mouse button in the model canvas. This can be done even whilst adding and dragging a node, simple press the right mouse whilst continuing to hold down the left. The perspective distortion is set using the view distance, the distance between the virtual eye and centre of the model. As discussed in Part B, this can be set interactively using the +/− keys while pressing the Control key.

### 3.6.2 Working in 3D

As discussed in Section A-3.4.1, the use of a fully 3D cursor system, together with snapping and relationship mapping between objects produces an environment in which modelling in 3D is relatively simple and intuitive.

### 3.6.3 Displaying Calculations in 3D

Most existing analysis tools provide very little visual feedback during calculations. This means that the process being undertaken is essentially hidden from the user, who has to trust in the fact that what is being modelled is correct. Mistakes in modelling that are not immediately visually apparent must be determined from a close examination of any output.

Whilst the majority of calculations are not inherently visual, there are techniques that can be used to make them more so. For example, when using sampling or ray-tracing techniques, it is a simple matter to display each point or ray as it is generated and tested. This acts to provide an indication of how the calculation is progressing as well as allowing the user to identify possible problems with the model by observing anomalies in the display. Such techniques have been
implemented in this application during surface area, volume, daylighting and acoustic calculations.

3.7 Multi-level Inputs

In the context of the workshop described previously, the desire for multi-level user input referred to the desire for users to specify almost a proficiency level, using which the software tool could adjust the requirement for detailed input for a specific calculation. Essentially novice and expert modes.

In a broader context, a more appropriate implementation of this is to structure calculations around a full set of basic assumptions and default values, any of which the user can change at any time. Inexperienced users, or those requiring a quick result, need only specify whatever level of information they have at the time.

This touches on two important and related areas, the potential for progressive data input and process modelling.

3.7.1 Progressive Data Input

Progressive data input refers to the ability to enter only a small sub-set of data required to model a particular process and generate results almost immediately. As the design is gradually resolved, more detailed information is added to the model, making the results progressively more accurate. This makes the process of modelling far more responsive.

There are, of course, issues with the validity of results based on default values, however, the same limitations are true of simplified manual and rule-of-thumb methods. These are well understood and accounted for by most practitioners. Where accurate results are more critical, more information is provided. This allows the designer to control both the effort and accuracy required for a result, not the application developer.

Given the detailed input requirements of most modelling systems, any information shortfall must be filled somehow by default or inferred values. There are many ways to derive or collect this data.

3.7.1.1 Using an Intelligent User Interface

A great deal of information can be inferred from the context in which an object is created or from the group of actions that may have preceded it. Similarly, it is possible to provide a number of alternate means of invoking the same action, each with different consequences for associated
data. This way the user need only select a different icon or menu item in order to enter the same initial values, but with a completely different set of defaults. For the advanced user, the ability to change the default inferences may be appropriate.

3.7.2 Maintaining an Architectural Knowledge Base

Traditional CAD applications concentrate on the drawing process rather than modeling, the lines that define an element only provide clues as to its function. In a modelling tool however, knowledge as to the function of an element is essential. Such information facilitates the scheduling and cost tracking of components, automatic generation of building characteristics (percentage north glazing, floor area or lighting energy per metre squared), and allows analysis engines to react differently to different elements. This means that such an application must have some internal representation that a particular object is a floor, for example, as well as what it might mean to be a floor.

Whilst there are some fundamental elements common to most architectural designs, the correct assignment of elements must be left to the building designers ultimate discretion. It is a relatively simple matter to define wall, floor, ceiling, roof, window or door elements. However, how does one classify an external shading device, or a series of columns.

3.7.3 Automatic Data Gathering

Given a defined geometry, information such as the surface area of walls, the volume of spaces and areas of intersection are relatively simple to extract. Thus, if the 3D modelling interface can be made sufficiently simple and intuitive, inputting the geometry of a building can obviate a significant amount of numeric data input as this can be derived directly by the application when required.

3.7.2 Process Modelling

The convenors of the two workshops described in Section 3.2 highlighted what they called the 'schizophrenia of developers'. On the one hand, there was an almost universal desire for all modelling to be based on fundamental physical processes at the most detailed level. On the other, there was a concession that some simpler models requiring much less user input and computation time were sometimes just as valid.

This questions the necessity for the results of design tools to be perfectly accurate. Manual methods of estimating performance, such as those in the CIBSE Guide, contain quite a few
highly simplified models that are known not to correlate well with actual physical processes. However, experience suggests that they usually result in a good design response.

David Bartholemew describes this as ‘validity defined as usefulness’ [Bartholemew 1997] and suggests that it is not actually necessary for a model to capture natural processes particularly well in order to be useful. What is important is the practical application and relevance of its output.

3.7.2.1 Absolute and Relative Accuracy

It is argued here that there needs to be at least two levels of modelling and analysis. The first, early in the process, to provide interactive design feedback. For quickly testing the viability of an idea, the comparison of multiple options and even the preliminary estimation of element sizes.

The absolute accuracy requirement at this level is quite low. What is more important is its relative accuracy, being able to immediately assess changes resulting from a particular set of design decisions compared to the original condition. This acts to guide the decisions-making process in the right direction. At this stage, all that is required is an indication that a problem may exist, its absolute magnitude can be the subject of second level analysis if it becomes more important.

The second level of analysis needs a more detailed and comprehensive model and is more likely to be based on fundamental physical processes. In this case absolute accuracy is important. This is the level of existing design tools and some interoperability with the conceptual design tool is essential.

3.8 Use of Components and Library Data

The exchange of electronic data is becoming more important in all industries. The ability to exchange ideas and design information with other architects and consultants is an essential part of any practice. To facilitate this, it must be possible to encapsulate all of the data required to describe a building model so that the receiver is not disadvantaged by not having the same weather files or material libraries.

As a result, an attempt has been made in this work to include all of the information that describes the model and its analysis in the one file. The file itself is structured into a series of ‘chunks’. Each chunk has a small header and contains information relating to either building geometry, material specification, calculation results or climatic data.
This internal structure has two advantages. The first is that other applications, which may not require the entire data set in a file, can search through and respond only to the chunks they actually want. Secondly, version information can be included in each header in order to maintain some backward compatibility between product releases.

A preliminary analysis of compression algorithms showed that the structure of data within a file is an important factor determining overall compression ratios. Many encoding routines work on large files by breaking them up into discrete segments, usually with a size based on a power of 2. Similarly pattern matching is also done in small segments.

In order to optimise the compression ratios within the data files produced by this application, care has been taken to ensure that the data structure of each object is byte aligned on an even byte number and that, when stored, these are each sized to a power of two. This was allowed for in the design of each node, object, zone and ray data structure to ensure that there was minimal increase in file size. The result is that compression ratios for the model files used in this application average between 8:1 and 12:1 using LZW and Huffman type encoding.

3.8.1 Material Libraries

The design of the material library within the application makes provision for specific manufacturer data to be included. At the simplest level this means space for a manufacturer’s name and an order number.

At a more complex level, it allows manufacturers to specify and lock the dimensions of their own library objects. This means that, for example, a library containing a range of aluminium windows could be provided that has accurate performance specifications for each element based on actual glass/frame ratios and production costs.

With more work, it is hoped that this type of consideration will induce manufacturers to provide material libraries of their own product ranges and maintain up-to-date versions on web sites or mailing lists.

3.9 Interoperability with Other Tools.

At the most simple level, interoperability means providing some basic interface with another application. The most usual form of this is the output of data in a file format that can be read by the other application. A more sophisticated system may use inter-process communication
protocols, such as IPC on a unix system or Dynamic Data Exchange (DDE) in Windows, to transfer the data directly.

Interoperability with CAD systems can be achieved by supporting the DXF file format, a de-facto standard amongst such applications. Similarly, this allows communication with a range of rendering and visualisation tools. Support for more task-specific tools such as RADIANCE may require the output of model data in its own native format. In these cases, greater interoperability would mean providing a means of controlling parameters important to the generation of the data file.

A further level of interoperability would be to recognise features in other applications which can be used to create efficiencies. One example of this is in the generation of RADIANCE data. As this tool uses radiosity techniques to calculate the distribution of light on each surface and then iteratively solve for inter-reflection, a wide variation in object size can lead to inaccuracies and increased calculation times. As a result, a means of breaking up large surfaces (such as floors and ceilings) into a number of much smaller ones can greatly increase the accuracy of generated results, as shown in Figure 3.2.

Figure 3.2 - Interpolation of geometry into output more efficient for use by other applications such as RADIANCE and CFD tools.

A further example of this is the interface with computational fluid dynamics applications. The complexity and efficiency of the form-fitted grid is integral to the amount of time required to converge on a fluid flow solution. If the output data is already aligned to specific grid points, the task of creating the optimum grid can be automatically carried out by the CFD application itself.

The required data is also significantly different in format from the geometric data used to model the building. Using Cartesian coordinates, angled planes must also be reduced to a complex set
of axially aligned planes. Including this level of intelligence within a tool can make a relatively simple task out of jobs that would not normally be considered. Figure 3.3 shows an automatically generated CFD model of an entire inner city development being used for wind studies.

Figure 3.3 - Inner city development model, automatically orthogonalised by conceptual design tool to create data more appropriate for an efficient CFD solution.
4 THE IMPLEMENTATION

The following is a summary of the algorithms selected for use in the performance analysis of the geometric model. As these are mostly implementations of widely published algorithms, only details specific to their use within this work is discussed.

4.1 Automatic data gathering.

Using only a simple set of geometric analysis algorithms, it is possible to automatically derive a significant amount of data that the user would normally have to enter manually. This automatic generation of data is an important aspect of new generation design tools, making them much more efficient and easier to use.

4.1.1 Surface Areas

The surface area of a plane is automatically calculated each time its geometry changes as a result of rotation, scaling or the movement of any of its nodes. The algorithm to calculate this needed to be able to handle polygons of any degree of complexity, both concave and convex, with any number of vertexes.

The method chosen is based on the fact that the length of the cross-product of any two vectors is equivalent to the area of a parallelogram formed by two parallel and equal vectors. Thus, the surface area of a triangle can be calculated as half of the cross-product of any two of its sides.

![Figure 4.1 - Diagram showing the length of the cross-product of a triangle as equal to the area of an equivalent parallelogram.](image-url)
The surface area of a complex polygon is therefore calculated by summing the cross-product of each triangle formed by subsequent vertices. In a concave polygon, the direction of the cross-product of each consecutive triangle will change.

![Diagram showing the surface calculation method.](image)

By summing each cross-product as a vector, the overall surface area of any polygon is given by halving the absolute value of the total, taking into account the areas of child windows, doors, panels and voids.

### 4.1.2 Volumes

Volume calculations had to be very resilient and able to handle zones that are not fully enclosed or have overlapping surfaces. As a result, a sampling algorithm was chosen.

Using this method, the extent of the zone is first calculated and then grided against one of the primary axis. The resolution and axis of this grid can be specified for each zone. A pseudo-random ray is then generated somewhere within each grid square and tested for intersection with each planar element belonging to that zone.

The distance between the two extreme intersection points, multiplied by the area of the grid square, represents the volume contributed by that square. If less that two objects are intersected, the volume contribution is zero. The sum of all contributions gives the volume of the zone.

The accuracy of this algorithm can be set by the user and is very quick to calculate. However, it does not handle very thin concave polyhedrons well so the grid axis must be manually chosen to compensate for this. Each volumetric ray is displayed as it is generated. This way, real-time visual feedback can be used to determine if an axis is inappropriate for a particular zone and a more appropriate one selected. For almost all building applications, however, the default Z axis is usually the most applicable.
4.1.3 Intersection Points
The intersection point between a line and plane is a very simple calculation. Determining if this point falls inside or outside a complex 3D polygon is slightly more difficult.

It is possible to test if a point is internal to a polygon by summing the angles created from that point and each subsequent set of two vertexes. The direction of the normal to each equivalent triangle is calculated and determines if the angle is added or subtracted. If the absolute value of this summation is equal to 2 PI, then the point is internal. If it is zero, the point is external.

![Diagram showing angle-based method of determining whether a point is internal or external to a polygon.](image)

Inside = 360°  
Outside = 0°

4.1.4 Adjacency
Adjacency means determining the intersection area between two planes. This must be determined, for example, when two zones butt up against each other. Whilst it is possible to work out the exact profile of a complex intersection area, a sampling algorithm was used as it proved more resilient and is a simple method capable of handling any particular configuration.
and level of complexity. It also provided a useful level of visual feedback during the calculation to allow its validity to be checked in real-time.

Using this method, a small amount of pre-processing is performed to determine the number of objects that share the same plane equation. A number of points are then generated in pseudo-random positions within a grid over the entire extent of the test surface. Any points internal to two or more planes contribute the surface area of their grid square to the adjacent portion. The sum of all contributions gives the total area of intersection.

Adjacent FLOOR-FLOOR or CEILING-CEILING objects are not tested as the result is meaningless and indicates intersecting zones or an error in zone layout. In most buildings, floors and ceilings share the same plane so all ceilings would have to be tested against each other, significantly increasing calculation time for no gain. For zones above and below, ceilings should normally be adjacent to the floor above and visa-versa.

Accurate knowledge of adjacency is important as geometric elements can be defined as having one material when exposed to the outside, and another when adjacent to another building zone. For example, a wall may be cavity brick when exposed or plaster-coated single brick when adjacent. This allows zones to be interactively dragged around and repositioned in their entirety without having to adjust walls divisions. In addition, this is vital if adjacent walls from different zone are not to be double-counted during cost analysis and thermal mass calculations.

4.2 Shadow Analysis

Shadows are generated from geometric objects by projecting vertices from a virtual sun onto a receiver plane. The azimuth and altitude of the virtual sun is calculated using formulae first proposed by Spencer [1965]. Values for solar declination and the equation of time are
determined using formulae proposed by Carruthers, et al [1990], as shown in the following pseudo-code:

```c
// Solar declination as per Carruthers et al.
t = 2 * M_PI * ((iJulianDate - 1) / 365.0);
fDeclination = (0.322003 - 22.9711 * cos(t) - 0.357898 * cos(2*t) - 0.14398 * cos(3*t) + 3.94638 * sin(t) + 0.019334 * sin(2*t) + 0.05928 * sin(3*t));

// Convert degrees to radians.
fDeclination = (fDeclination / 180.0) * M_PI;

// Equation of time as per Carruthers et al.
t = ((279.134 + 0.985647 * iJulianDate) * M_PI) / 180.0;
fEquation = (5.0323 - 100.976 * sin(t) + 595.275 * sin(2*t) + 3.6858 * sin(3*t) - 12.47 * sin(4*t) - 430.847 * cos(t) + 12.5024 * cos(2*t) + 18.25 * cos(3*t));

// Convert seconds to hours.
fEquation = fEquation / 3600.00;

// Difference (in minutes) from reference longitude.
fDifference = (RAD2DEG(fLongitude - fTimeZone) * 4) / 60.0;
```

The real distance between the Earth and the Sun is used to specify the position of the sun. This is simply a matter of rotating the sun by its azimuth and altitude about the centre of the model, using a radius of 1.496e11 metres.

### 4.2.1 Sunrise and Sunset

Sunrise and sunset times are calculated symmetrically about solar noon using the method outlined by Spencer [1965]. In this method the actual times of sunrise and sunset are considered to occur when the very top edge of the sun is parallel with the horizon. As a result, 0°50’ is added to sunrise and sunset angles to allow for the radius of the sun. Sunrise and sunset times are displayed in local time.
4.2.2  **Horizontal and Vertical Shadow Angles (HSA & VSA)**

Horizontal and vertical shadow angles are calculated for individual planes using the method proposed by Spencer [1965]. This same method appears in several other publications [Phillips 1983, Szokolay 1996], as shown in the following pseudo-code:

\[
\begin{align*}
\text{HSA} &= \text{fSolarAzimuth} - \text{fNormalAzimuth}; \\
\text{top} &= \sin(\text{fSolarAltitude} - \text{fNormalAltitude}); \\
\text{bot} &= \cos(\text{fSolarAltitude} - \text{fNormalAltitude}) \times \cos(\text{HSA}); \\
\text{VSA} &= \text{atan}(\text{top}/\text{bot});
\end{align*}
\]

4.2.3  **Viewing From Sun**

The design of shading devices and the analysis of sun penetration can benefit significantly from an appreciation of the model from the sun’s perspective. As the sun’s rays are very close to parallel when they hit the Earth, this involves generating an orthographic view of the model from the same azimuth and altitude as the sun. This view can be extremely useful when manually creating or editing solar shades or simply determining overshadowing.

![View From Sun](image)

**Figure 4.6** - East facing shading system designed using view from sun position.  
*Note the change in shading depth from north to south.*

4.2.4  **Overshadowing**

Overshadowing analysis is simply a matter of projecting shadows onto the ground or on specific planes tagged as shaded surfaces. Using tagged planes allows both overshadowing and internal sun penetration to be displayed. Figure 4.7 shows two overshadowing examples whilst Figure 4.8 shows an instance of both sun penetration and a reflective light shelf.
4.2.5 Isolating Individual Shadows

During overshadowing analysis, it is often necessary to isolate or highlight the shadows of one or more buildings from amongst many. This can be done in this application by simply varying the transparency of key buildings. In the following example, the background buildings have been made 50% transparent whilst one was made 25% and another fully opaque.

*Figure 4.7 - Examples of overshadowing projection on the ground and on a contoured surface.*

*Figure 4.8 - An instance of both internal sun penetration and a reflective lightshelf.*
Figure 4.9 - The isolation of buildings for either total or additional overshadowing.

The second image in Figure 4.9 shows only the additional overshadowing created by the two buildings. This is achieved by holding down the Shift key when selecting shadow display, which simply reverses the sort order of shadow polygons. This type of analysis is essential for inner-city councils when assessing new building proposals.

4.2.6 Shadow Profiles

Another important aspect of overshadowing is the shadow profile. This is simple the outline of shadow produced by a building over time. This is displayed as a sequence of shadow diagrams which can be overlaid to form a single image, or output to sequential files to form an animated GIF or AVI movie file.
4.3 **Stereographic Analysis**

Sun path diagrams are an extremely useful tool for both the siting of buildings and the design of shading devices. In the one diagram, overshadowing for an entire year can be displayed. These are constructed by projecting the hemispherical sky dome onto a flat diagram, usually circular. A number of methods are available for translating solar altitude into a diagrammatic radius. Stereographic projection is the most widely used method and has been adopted in this application as it provides the greatest accuracy at low sun angles. A comprehensive analysis of alternate methods can be found in the *Environmental Science Handbook* [Szokolay 1980].

The stereographic diagram used here, as shown in Figure 4.11, is constructed directly from solar geometry. The path of the sun through the sky dome is based on its actual altitude and azimuth calculated at each hour for the selected location. Thus hour lines show the characteristic figure 8 of the analemma. The two halves of the year are differentiated using solid and dotted lines.
The projection of model geometry onto the stereographic diagram involves tracing each line as a number of discrete segments. This describes each straight line as a curve when projected onto the sky dome. This is more accurate than a number of simplified methods in common use that only project object vertices [Szokolay 1980, Phillips 1983].

The displayed diagram is only valid for a single focus point. If a planar object is selected, the diagram is generated from its geometric centre and a warning stating this is displayed.

The generation of shade patches this way is still quite quick, allowing the diagram itself to be interactive. Thus, moving or dragging the focus point within the model automatically updates the display. This level of interactivity means that a full overshadowing analysis at numerous points around a site can be carried out in minutes once a model has been built.

4.4 Solar Exposure

Once the position of the sun and incidence angles have been determined, the solar exposure of any surface can be calculated. This is done as either instantaneous irradiance or integrated irradiation over an entire day, month or year. In order to determine the amount of incident radiation, the following parameters are required:

- Global, beam and diffuse solar irradiance
- Percentage shading or overshadowing
- Angular dependant reflectivity, if applicable

4.4.1 Global, Beam and Diffuse Irradiance

Values for global and diffuse solar irradiance on a horizontal surface are calculated in two alternate ways depending on their use. When used as part of the thermal analysis of the model, hourly values for each day of the year are read directly from the location data file. These values are based on recorded meteorological weather data and are linked directly to cloud cover, solar-temperature and absolute humidity.

When explicitly calculating instantaneous solar exposure for comparative analysis, recorded irradiation data can be misleading as values are used in isolation, with no information as to other external conditions such as cloud cover. In order to average out spurious fluctuations in these cases, values for global and diffuse irradiation are derived from average daily irradiation figures, as displayed in the monthly climate summary. The method used to derive instantaneous global and diffuse values this way is given by Szokolay [1987].
Once these two values have been read from the location file or derived from averaged monthly data, the amount of beam irradiance on a surface normal to the sun can be calculated using a method also described by Szokolay [1987].

To accurately quantify solar exposure, the effects of direct, diffuse and reflected irradiance must be considered.

4.4.1.1 Direct Irradiance
The direct component is that irradiance which results from direct exposure to the sun. This depends on the angle of incidence of the direct irradiance as well as the percentage of the surface currently in shade. The method of determining percentage shading is described in Section A-4.4.2.

4.4.1.2 Diffuse Sky Irradiance
Diffuse irradiance refers to that component of the total that arrives from all angles over the entire sky dome. This is dependant on the tilt angle of the surface. Obviously horizontal surfaces are exposed to the entire sky dome whilst vertical surfaces are exposed to only half. This is a simple linear relationship with tilt angle.

The effects of geometric obstruction and overshadowing on the diffuse component is difficult to determine geometrically. An accurate method would require determining the average percentage of the sky dome visible from all points over the entire surface. The calculation of this value even for a single point is quite computationally intensive.

As a result it is assumed in this application that, whilst the diffuse component will have some effect on solar collection and sol-air temperature, this effect is not deterministically significant. Thus no consideration of overshadowing is applied to the diffuse component.

This can lead to some anomalies within the model. For example, a floor element whose surface normal faces upwards would receive full diffuse radiation from the entire sky dome, even though almost entirely obscured. As the small amount of diffuse radiation that may impact on the floor is picked up by the windows that it must first pass through, objects defined as a FLOOR are not considered in diffuse radiation calculations. Similarly, any portion of a planar object that is adjacent to another zone is also not considered, regardless of the orientation of its surface normal.
The application itself automatically orients the surface normals of objects created within its own 3D interface. Thus, correcting orientation is only a consideration when using imported geometry from DXF files and CAD models.

4.4.1.3 Ground Reflected Irradiance

Ground reflected irradiance is simply that component of the total that is reflected off the ground plane. This is dependant on tilt angle in the opposite way to diffuse sky irradiance. In the application, no consideration for geometric obstruction is applied to this component either.

A default ground reflectivity of 0.2 is assumed unless explicitly set in the Preferences dialog box.

4.4.2 Shading Factor

The shading factor for a surface is calculated geometrically and is given as the percentage of that surface currently shaded from direct sun. This is calculated by generating a series of pseudo-random points distributed over the surface. Geometric rays are then traced from each point towards the sun.

If an opaque object is intersected at any point, that ray returns a value of one (1.0). If only transparent objects are intersected, the ray returns the cumulative effect of each object’s transparency (<1.0). If no objects are intersected, the ray returns a value of zero (0.0). The shading percentage is simply the sum of the return values of each ray divided by the number of rays generated.

Figure 4.12 - An example of shading factor calculations being used to determine the transmission characteristics of angled shading mesh at different times of the year.

In order to optimise calculation time, the distribution density of rays is determined from the entire model extents. This means that smaller objects generate less rays. This reduction in accuracy is in keeping with the less significant effects of smaller objects. The current
distribution density can be set manually, and is actually displayed as white dots on the surface whenever the instantaneous exposure on a single object is calculated.

### 4.4.3 Solar Exposure Graphs

Solar exposure values can be graphed for any time of the day at any date. This information can be displayed as either hourly values throughout the day or as an average hourly distribution for each month of the year. These graphs show hourly values for total available irradiation, actual incident irradiation, any portion reflected off tagged surfaces and the percentage in shade for the selected object. Average hourly distributions can be shown for each of the above to understand when peak direct solar gains occur during the entire year.

![Figure 4.13 - Graphs of daily and annual solar exposure for a selected surface.](image)

### 4.4.4 Angular-Dependant Reflectivity

If the object receiving the radiation is defined as a transparent WINDOW, an additional angular-dependent transmission factor is applied to the beam component to account for changing reflectivity with incidence angle. This is based on Fresnel’s expression [Lynes 1968]:

\[
\text{reflected} = 0.5 \times (\sin^2(i-r)/\sin^2(i+r)) + (\tan^2(i-r)/\tan^2(i+r));
\]

where \( r = \text{Internal refraction angle} \) (\( r = \sin(i)/\text{refractiveIndex} \)).

\( i = \text{Incidence angle}. \)

The refractive index is a basic material parameter that can be set for each glass type within the application. A default refractive index of 1.52 (based on 6mm clear float) is used if this value is not set.

An increased reflected component acts to reduce the amount of radiation transmitted through a transparent element. Thus angular dependant reflectivity of glass is an important consideration when calculating direct solar gain though windows and the effects of coverings on a solar collector. This effect has been incorporated into both the shadow and reflection routines. This can be observed as changes in sun patch brightness at sharper sun angles.
4.5 Shading Device Design

A simple methodology for the automatic generation of optimised shading devices is implemented in the application. Given a window and a limiting set of dates and times, it is possible to determine the exact geometry of an optimal shading device. This is simply a matter of determining the plane equation of each shade and then projecting the path of the sun onto it. This must be done for each vertex of the selected window. For horizontal shades, the effects of the analemma must be considered at each side if the shade is to work over a range of dates.

Once all of the vertexes have been projected at the selected date and each limiting time, a modified convex hull algorithm is used to determine the final shape of the required shade. A modification to this algorithm was required as the convex hull shape is not truly optimum. In the case of a rectangular window facing roughly north, the edges of a horizontal shade are actually concave at some points, as shown in Figure 4.14.

![Figure 4.14 - Detail showing sun path lines from which the modified convex hull algorithm generates the required profile.](image)

This same method can be used to generate shades at any angle and with both horizontal and vertical elements. Optimised solar pergolas are also possible as the altitude of the sun when normal to the window can be determined at both the current date (used for the cut-off angle) and in mid-winter (used for maximum penetration).

![Figure 4.15 - Examples of automatically generated shading devices.](image)
4.5.1 **Solar Profiles**

There will be times when such a parametric shade is not suitable for a particular application. To allow for this, sun paths can be projected onto any surface from any point. This creates a solar profile line which is clipped to the extent of the selected surfaces. Figure 4.16 shows an example of the use of such profile lines to design a complex shading hood that exactly shades the bottom corners of a rectangular window.

![Solar Profiles](image.png)

*Figure 4.16 - A complex shading hood optimised using solar profiles projected from each corner of the window.*

4.5.2 **Solar Extrusions**

When considering overshadowing and solar access rights, it is often necessary to limit the height of a building based on a particular solar time. This can be easily achieved by extruding a plane towards the sun at some set of limiting dates and times. These planes can then be used to automatically cut the building envelope to ensure overshadowing does not occur.

![Solar Extrusions](image.png)

*Figure 4.17 - The use of projected solar access planes to control the overshadowing effects of new buildings.*
4.6 Daylight Factor

An estimate of daylighting levels and glare within a building is fundamental to fenestration design. Whilst the accurate calculation of such levels is quite computationally intensive, a manual method based on the British Research Station (BRS) Daylight Factor Protractors is widely used as a first approximation.

The Daylight Factor at a point within an enclosure is a function of three components, the sky component, externally reflected component and internally reflected component [Longmore 1968]. The calculation of Daylight Factor in this application uses a geometric method for determining the sky and externally reflected components and the standard BRS formulae for the internally reflected component.

4.6.1 Geometric Method

At each measurement point a series of geometric rays are generated. These rays are evenly distributed over the surface of an imaginary dome using an iterative geodesic triangulation technique. The altitude of each ray and the equation defining the type of sky (CIE Uniform or Standard Overcast sky) is used to determine the reference return value for that ray.

If the ray does not intersect any object and has a positive altitude, it returns the full reference value to the sky component. If one or more transparent objects are intersected, the return value is modified by the cumulative effect of each object’s transparency and is also added to the sky component.

If an external opaque object is intersected, the ray is terminated and the return value further modified by the external surface reflectivity of that object and added to the externally reflected component. The altitude of each such ray is also added to a running average maximum elevation of external obstructions for each window. This is for later use in the determination of the internally reflected component. If an internal object is intersected, the internal surface reflectivity of that object is added to a running average values.

Figure 4.19 shows a daylight factor calculation in progress. As each ray is displayed as it is traced, this visual feedback can be used to check the validity of the model, making sure rays travel through windows and do not ‘leak’ out of opaque parts of the enclosure.
Once all rays have been traced, the ratio of the total sum of all possible return values versus actual return values becomes the sky and reflected components.

4.6.2 **Internally Reflected Component**

The internally reflected component is calculated using the standard BRS formulae. This formulae is based on average surface reflectivity’s at different heights and returns a room averaged value that is independent of actual position. This is the same formulae used in published manual methods.

The parameters used in this formulae are collected during the geometric calculation, being the average reflectivity of surfaces above and below point height as well as the average elevation and reflectivity of external obstructions.

4.6.3 **Translation Into Illumination**

If the daylight factor at a particular point and the design sky illuminance for the current location is known, then a representative value for illumination for a uniform or CIE overcast sky can be calculated. This is simply the product of the two, given in Lux.

The resulting value is neither a minimum nor an average, but a representative design value of useful interior daylight available over approximately 85% of the working year (taken from 9:00am to 5:30pm).
This relationship is useful as it can be reversed to actually determine a daylight factor. If the required illumination for a particular task is known, then the daylight factor required to provide that level 85% of the time is simply given by:

\[
\text{DaylightFactor} = \frac{\text{DesignSkyIlluminance}}{\text{RequiredIllumination}};
\]

4.7 Artificial Lighting

Artificial lighting levels are calculated using the point-by-point method. This is a geometric algorithm in which the contribution of each light source is simple summed at points within the enclosure. The luminance distribution of each light source is used to modify contributed levels based on the off-axis angle of each point. The inverse square law is then used to account for geometric spreading.

This is a simple method for determining direct light levels from both regularly and irregularly spaced luminaires. It is a useful tool for ensuring adequate minimum light levels and is mainly intended for use in this application as a comparative measure. This method takes no account of diffuse light or inter-reflection between illuminated surfaces.

The lumen method of artificial lighting design is not implemented as it is considered to promote an inefficient distribution of luminaires where localised task lighting may be more suitable. The point-by-point method can be used in place of the lumen method to design and analyse regular arrays as well as localised lighting.

4.8 RADIANCE Output

For a more accurate analysis of both natural and artificial light levels, the geometric model can be converted into a RADIANCE model. RADIANCE is a public domain lighting simulation tool produced by Greg Ward at Lawrence Berkeley Laboratories. It is widely used for lighting design and has been extensively validated. Images are generated using the fundamental physical properties of light transfer and inter-reflection based on a hybrid radiosity/raytracing technique.

The conversion routines within the application are quite sophisticated, making use of primitives native to the package and even generating a RADIANCE Instruction File (RIF) to control program execution. RADIANCE is freely available for Unix workstations and for DOS machines as part of the ADELINE package.
4.9 Thermal Performance

To calculate internal temperatures and monthly heating and cooling loads, the Admittance Method is used as described in the CIBSE GUIDE Volume A, Design Data [1986]. Some methods of accounting for solar gain are taken from Szokolay [1987], as described in Section A-4.4.1.

This method is based on a steady state analysis and simulates the dynamic response of a building by calculating cyclical variation about a 24 hour mean temperature. Steady state conditions are used to determine the relationships between energy flows, the thermal characteristics of each space and air temperatures. The thermal response of the building fabric is then used to determine the dynamic response of each space.

This method was selected as it strikes a balance between accuracy and simplicity, being quick to calculate whilst providing quite detailed performance feedback.

It should only be considered as a first level approximation of thermal performance. As such, the absolute accuracy of the results are not that important. However, the relative accuracy of the results are very good, allowing for the detailed comparison of options to guide the design as it is being developed. Interoperability with more sophisticated applications that use the response factor method are currently being developed.

4.9.1 Internal Temperatures

As a first level approximation, the admittance method is an excellent tool. It allows the calculation of internal temperatures with full consideration of:

- The effects of thermal mass,
- The effects of internal radiant temperatures,
- The effects of air infiltration and static ventilation rates,
- The effects of occupancy and equipment gains,
- Direct and indirect solar gain.

From this calculation, a 24 hour temperature profile of each zone in a building can be determined. The influence of adjacent zones at different temperatures is not well defined in the CIBSE Guide, except as an additional gain to be added to the space load. As the internal conditions of each zone in this application are undefined at the beginning of a calculation, and the order in which zone temperatures are calculated is arbitrary, it is not possible to properly consider inter-zonal flow during the first calculation. As the method is steady state based, pre-conditioning each zone by starting the calculation a number of days earlier is of no significant benefit. However, a single day’s preconditioning is always performed to obtain an approximate temperature record for the previous day. This assumes that no building element has a thermal lag greater than 24 hrs.

As a result, once the internal temperatures have been determined using the base CIBSE method, an additional set of iterations are performed using stored adjacency data to update inter-zonal heat flows. Each calculation is very simple and continues until the maximum change in each zone is less than 0.1 of a degree.

Figure 4.20 - An example of a 24 hr temperature profile of a house in summer calculated using the Admittance Method, picking up the relatively high internal temperatures of its roofspace.

4.9.2 Heating and Cooling Loads

Heating and cooling loads are calculated using internal air volumes and the difference between internal dry-bulb temperatures and the heating and cooling thermostat settings for each zone. This provides an estimation of the required sensible loads to maintain bulk air temperature within the specified range.
It is important to note that these values are not to be considered as plant loads. They are simply sensible space loads. No allowance is made for latent gains due to occupancy or equipment. Estimated costs are calculated based on electrical utility rates and the specified system efficiency. They are displayed simply to provide a more meaningful value to the results and facilitate the approximate cost/benefit analysis of various options.

### 4.9.3 Passive Design Analysis

Heat load analysis assumes the building is air-conditioned. Whilst this is reasonable for commercial buildings, it is not so for many residential and industrial buildings. Some form of performance feedback for passively controlled buildings is also necessary in a conceptual design tool.

This is achieved by generating a cumulative frequency graph of internal zone temperatures showing the number of hours per year that the temperature was a particular value. The vertical scale thus represents the number of hours whilst the horizontal scale represents temperature. For example, the internal temperature of a particular zone may have been between 20-21°C for 1325 hours, whilst between 30-31°C for only 86 hours.
The white area in the centre background of the graph indicates the comfort band set for the currently selected zone. The current zone is highlighted in red with all other zones shown in yellow. The distribution of outside air temperatures is also displayed as a dotted blue line for direct comparison.

Using this graphical technique, it is possible to quickly appreciate the performance of unconditioned zones as well as zones conditioned only part of the time. If the graph is highest within the lightest gray area, then the zone is performing well, remaining within its specified comfort zone most of the time. If not, it either requires more heating or cooling, depending on which side of the comfort band.

### 4.9.4 Isolated Component Analysis

In order to properly devise a passive design strategy, some feedback as to the relative contribution of each component of the thermal stress on the building is required. This is provided in the form of an average hourly distribution of temperatures and gains for each month of the year, as shown in Figure 4.23.
Figure 4.23 – A comparison of the annual distributions of fabric, ventilation and solar gains in a passively controlled building.

These show the maximum and minimum effects of each of the following components throughout the year:

- Average hourly internal temperatures,
- Average hourly conduction gains,
- Average hourly direct solar gains,
- Average hourly solar excess gains as a result of radiation on opaque elements,
- Average hourly internal gains from appliances and equipment and
- Average hourly ventilation gains.

4.10 Statistical Acoustics

Having the geometric model of a building, within which the internal volume of each space is known as well as the surface area and material definition of each element, the calculation of statistical reverberation times becomes a trivial task. As a design tool, the room averaged reverberation time is still one of the first objective measures to be calculated, even by specialist acoustic consultants. In some cases, it is the only objective measure calculated.

Within the material database, the Sabine absorption coefficients for each octave between 63 Hz and 16 kHz are stored for each material as shown in Figure 4.24.
As part of the calculation, an analysis of the distribution of absorption coefficients is performed in order to determine the most appropriate method to use. There are three possible methods, the standard Sabine formula for fairly reverberant rooms, the Norris-Eyring formula for rooms in which high absorption that is similarly distributed on all surfaces, and the Millington-Sette equation for rooms with widely varying absorption. A more detailed explanation of the implementation and use of these formulae is given in Section B-23.

An example of the calculated RT results for a space is shown in Figure 4.25, together with the accompanying text output.

Figure 4.24 - An example of the sound absorption coefficients stored for each material.

Figure 4.25 - A statistical reverberation time graph for an auditorium with a widely varying distribution of sound absorption.
Volume:  7298.279 m³
Surface Area:  3223.010 m²

Optimum RT (@500Hz for Speech):  1.06s
Optimum RT (@500Hz for Music):  1.75s

Volume per Seat:  3.649 m³
Minimum (For Speech):  5.94 m³
Minimum (For Music):  9.38 m³

Method: Millington-Sette (Widely varying)

4.11 Acoustic Raytracing

The basis of the geometric approach to acoustic analysis used within this application is discussed in an early paper by the author, included here as Appendix A. To summarise, geometric acoustics can not be used to fully describe all aspects of the acoustic performance of an enclosure. However, given the very strong relationship between room geometry and acoustic behavior, and the fact that at the conceptual stage of design it is that very geometry that is being decided upon by the designer, any information as the acoustic ramifications of design decisions is considered invaluable.

As a result, a wide range of geometric acoustic analysis methods have been implemented to assist with enclosure design. These range from basic geometric analysis to the reverse integration of the impulse response to obtain decay times.

4.11.1 Sprayed Rays

The most basic form of geometric analysis is to simply generate a number of rays within an enclosure and trace their path. Making such a method quick to calculate and relatively interactive, allowing the user to drag the source point to different locations and having the rays automatically updated, starts to make this both an analysis and a design tool.

As a result, acoustic rays can be sprayed around an enclosure at any range of angles and to any reflection depth. Whenever the geometry of that enclosure changes in any way, the rays are automatically regenerated to reflect the changed conditions. This allows reflectors to be
interactively positioned at the optimum angle and entire room plans to be optimised for an even first order distribution.

![Image](image.png)

**Figure 4.26 - Sprayed acoustic rays being used to indicate the distribution, relative level and relative delay of reflections off selected surfaces.**

In addition to the geometric ray path, rays are displayed in colour. Rays with a delay relative to the direct sound of greater than 100ms are shown in red. A gradual change from yellow to red occurs for rays between 50ms and 100ms delay. Both relative delay and relative level can be displayed as text at the termination of each ray.

### 4.11.2 The Image Method

A slightly more complex analysis is to determine the possible reflection paths between a sound source and any number of receiving points. This involves an exhaustive test of all reflections off all surfaces within the model. This is done by generating phantom images of the source position by reflecting it about each plane in the model. The visibility of this image is then tested for each receiver point and the reflection sequence stored for each valid ray. For second order reflections the phantom images are then further reflected about each plane, and so on.

Calculation times using this method increase exponentially, being equivalent to the number of planes in the model to the power of the reflection depth. In a typical enclosure of around 100 planes, fourth or fifth order reflection are not unrealistic with a calculation time of between one and two hours.

As this method is exhaustive, it calculates all possible reflection paths up to the specified reflection depth. Once the geometric path of each ray has been calculated and stored, it is possible to determine its time delay and sound level relative to the direct sound at any frequency for which there is sound absorption data for the materials intersected along the way.

The relative delay is simply determined from the path difference between the ray and the direct sound arriving at the receiver. When calculating the speed of sound, a default internal
temperature of 20°C and a relative humidity of 60% is assumed. To determine the relative sound level, the effects of geometric spreading, boundary absorption and the molecular absorption of air are applied. Sound levels are taken relative to the direct sound at each receiver point, so are shown as a negative decibel value.

4.11.2.1 Angle-Dependant Absorption Coefficients
A facility has been included in this work for the provision of angle-dependant absorption coefficients, as discussed in Appendix A. However, due to the relative difficulty obtaining these values for a wide range of commonly used building materials, the final application only allows the specification of single coefficients at each octave. Future work will reactivate this feature.

4.11.3 The Hybrid Image Method
Given the exponential increase in calculation time required by the Image Method, Vorlander [1989] proposed a hybrid method combining elements of random ray tracing with the image method. Using this technique, the point receiver is replaced by a sphere of finite radius. A number of random rays are then generated to a depth set by the user. Each segment of a ray is tested to see if it intersects any part of the sphere. If so, there is a significant chance that there exists another ray, reflecting off the same sequence of boundary objects, but passing exactly through the centre of the sphere. As both the current image position and reflection sequence is known, it is a simple matter to trace the new ray from the centre of the intersected sphere to the image point, testing to see if it is a true ray of not.

The benefits of this method are quite significant. Rays can be generated with as great a reflection depth as required without the corresponding exponential increase in calculation time. Once a ray has been generated, it can be tested against as many spherical receivers as can be specified within the enclosure. Thus the time spent calculating one ray may yield any number of true rays for any number of receiver points at any depth.

4.11.3.1 Ray Distribution Algorithms
Unlike the method of images, this algorithm samples only from the set of real rays within the enclosure and is by no means exhaustive. Therefore a number of algorithms for the generation of sampled rays have been developed. This means that rays can be selected at random, based on a fixed interval, restricted to a given range of angles or only off a specified plane. As a result it is necessary to keep in mind the bias that any of these choices place on the acoustic measures derived from a particular set of rays.
Experience with this algorithm has shown it to be a remarkably fast and effective means of overviewing the behaviour of an enclosure. Using a single calculation of perhaps 10000 rays at a depth of 32 reflections may take up to an hour, but will yield a sample impulse response for as many points of interest as are required.

As a quantitative tool, however, there can be no measure of the fraction of real images actually represented, even at the lowest orders of reflection. This can be overcome, to a degree, by increasing the radius of each sphere relative to the room volume in order to catch and test more rays.

4.11.4 Relating Room Geometry to Room Response

Once reflections have been calculated, the application simultaneously displays the echogram immediately beneath the geometric paths of each ray. Selecting a ray within the model with the mouse highlights both the ray and its echo. Similarly, selecting an echo also highlights the geometric ray.

This direct relationship between the room response and the geometry of each ray allows a significant amount of both objective and intuitive analysis. As well as simply getting a feel for how sound waves are being reflected within the enclosure, it is also possible to instantly detect spurious echoes and, by simply selecting it, instantly see the path it took, as shown in Figure 4.27. Rotating the 3D model using the right mouse button displays only the selected ray in 3D so a full appreciation of the surfaces it reflects off can be gained.

Similarly, holding the left mouse down whilst dragging it over the echogram continually highlights the closest echo. In order to quickly get a feel for the paths of high-level reflections, the mouse can be dragged near the top of the decay curve. To view the low level reflections, the mouse is dragged further down the curve. An example of this is included in the tutorial manual in Part C.
4.11.5 Derived Information

There are a number of ways to display the information that can be derived from these reflected rays. The aim is to present results in a way that is not only meaningful, but can also serve as a basis for further interactive exploration.

4.11.5.1 Reflection Point Analysis

When one or more planes are selected, the reflection points of each ray with those planes can be displayed. This provides an indication of those areas of a surface that are actually contributing to the reflection of sound between the source and the receiver. It is possible to quickly cycle through the reflection points for each receiver position using the Ctrl+PageUp and Ctrl+PageDn keys.

In the unix version, the relative sound level of each reflection is indicated by shades of yellow. This allows the more significant reflections to be easily discerned. This is more difficult in the Windows version, so will be fully implemented in future work.
When reflection points are displayed, the graph immediately underneath displays the statistical distribution of reflection angle. This graph shows the percentage of rays reflecting off the surface in specified increments. Thus it is possible to determine if the greater proportion of rays are at normal or grazing incidence. This can help determine the most appropriate type of absorber to use on that surface.

4.11.5.2 Lateral Energy and Polar Diagrams

Another important aspect of the acoustic performance of any space is the angular distribution of reflections arriving at the receiver point. An even distribution throughout all angles provides a more intimate feeling of being surrounded by the sound. This information can be displayed as either the distribution of phantom images or as a polar diagram.

Once again, the user can interactively select images or polar rays with the mouse. Using the right mouse button, the exact path of the corresponding ray can also be examined.
4.11.5.3 Integrated Energy

Schroeder [1965] has shown that performing a reverse integration on the impulse response produces a smooth decay curve equivalent to the ensemble average of many such decays. It is therefore possible to display this integrated decay curve and to calculate lines-of-best-fit for use in the estimation of both reverberation time and early decay time, as shown in Figure 4.30. Such a graph can also be used to estimate how exponential the decay within an enclosure actually is.

It is possible to increase the accuracy of the lines-of-best-fit using two interactive cursor points to set the range over which it is calculated. These can be positioned such that deficiencies within the decay, due to a lack of higher order reflections, can be obviated.
5 **CONCLUSION**

The primary aim of this work was to produce something akin to an environmental design calculator. A tool capable of evaluating any aspect of a design, from the smallest of details to the overall environmental impact of materials and fabric. As such, this work represents a new approach to the integration of environmental engineering and building design, two pursuits that, until relatively recently, were synonymous.

There are other organisations attempting similar tasks. The IES package described in Section A-2 is a perfect example. What differentiates the work presented here, however, is its focus on conceptual design. This is the earliest most defining stage of design, where each decision has the most potential and the greatest effect in terms of environmental performance. It is hoped that this work goes some way towards filling the void in this area.

A tool such as that described in Part B is never actually finished. However, it is hoped that a solid foundation has been established as a base for its ongoing development.

It is fitting then that this thesis should conclude with a list of ideas for additional ‘features’ still left to implement:

- **A joint research project has begun with CSIRO, using the 3D geometric engine developed here as a front end to their Cheetah and MIXC natural ventilation engines. This is seen as a prelude to more closely interfacing with other thermal analysis tools such as CAMEL, CheeNATH, TAS and DOE2.**

- **The inclusion of simple natural ventilation analysis. It is intended that this begin with the simple estimation of buoyancy and wind driven pressures at each aperture and then progress to bulk air flows in a multi-zone model.**

- **As the geometry is known, as well as internal surface temperatures at each hour of the day, the next version will use the same routines as for natural lighting calculations to determine radiant temperatures at each sensor point. This is simply a matter of storing the surface index and distance for each sprayed ray and updating radiant temperatures whenever surface temperatures change. With air flow data from MIXC, this would be used to map thermal comfort measures such as Predicted Mean Vote (PMV) and Percentage Dissatisfaction (PPD) throughout a space.**
• This version includes the calculation of incident solar radiation on any surface. The next step is to more fully incorporate solar collector design and wind power generation using real recorded weather data and conversion efficiencies to determine energy availability. These could then be matched against load profiles (using appliance operational profiles) for a more accurate estimation of required storage capacity.

• More consideration of life cycle assessment and cost-benefit analysis using embodied energy, greenhouse gas emissions and even off-gassing as part of the equation. The geometric modelling system here is considered to form a useful link between the actual building design and the quantification of environmental and life cycle data.

• Calculating inter-zonal sound transmission and sound propagation within large indoor and outdoor spaces.

• The ability to define more detailed surface textures for output in VRML, RADIANCE and POV-Ray files.

...
BIBLIOGRAPHY


---


## Index

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PREFACE</strong></td>
<td>5</td>
</tr>
<tr>
<td>1.1 Introduction</td>
<td>5</td>
</tr>
<tr>
<td>1.2 Technical Introduction</td>
<td>6</td>
</tr>
<tr>
<td><strong>Some Fundamentals</strong></td>
<td>7</td>
</tr>
<tr>
<td>2.6 Working with Windows</td>
<td>7</td>
</tr>
<tr>
<td>2.7 Terminology Used in This Manual</td>
<td>7</td>
</tr>
<tr>
<td><strong>Basic Interaction</strong></td>
<td>8</td>
</tr>
<tr>
<td>3.6 Workspace Layout</td>
<td>8</td>
</tr>
<tr>
<td>3.7 Using the Mouse</td>
<td>9</td>
</tr>
<tr>
<td>3.8 Using the Keyboard</td>
<td>9</td>
</tr>
<tr>
<td>3.9 Entering Numeric Data</td>
<td>10</td>
</tr>
<tr>
<td><strong>Operational Concepts</strong></td>
<td>13</td>
</tr>
<tr>
<td>4.6 Interactive Modes</td>
<td>13</td>
</tr>
<tr>
<td>4.7 Selection Modes</td>
<td>13</td>
</tr>
<tr>
<td>4.8 The About Point</td>
<td>14</td>
</tr>
<tr>
<td><strong>File Management</strong></td>
<td>15</td>
</tr>
<tr>
<td>5.6 Model and Data Files</td>
<td>15</td>
</tr>
<tr>
<td><strong>View Management</strong></td>
<td>17</td>
</tr>
<tr>
<td>6.6 Graphic Representation</td>
<td>17</td>
</tr>
<tr>
<td><strong>The Cursor System</strong></td>
<td>19</td>
</tr>
<tr>
<td>7.6 An Interactive 3D Cursor</td>
<td>19</td>
</tr>
<tr>
<td>7.7 Cursor Snap Modes</td>
<td>20</td>
</tr>
<tr>
<td><strong>Object Selection</strong></td>
<td>22</td>
</tr>
<tr>
<td>8.6 Selecting an Object</td>
<td>22</td>
</tr>
<tr>
<td>8.7 Keyboard Modifiers</td>
<td>23</td>
</tr>
<tr>
<td><strong>Adding and Deleting Objects</strong></td>
<td>24</td>
</tr>
<tr>
<td>9.6 Creating Objects</td>
<td>24</td>
</tr>
<tr>
<td>9.7 Object Types</td>
<td>25</td>
</tr>
<tr>
<td>9.8 Deleting Objects</td>
<td>27</td>
</tr>
<tr>
<td>9.9 Copying Objects</td>
<td>27</td>
</tr>
<tr>
<td><strong>Object Relationships</strong></td>
<td>29</td>
</tr>
<tr>
<td>10.6 Relationship Types</td>
<td>29</td>
</tr>
<tr>
<td>10.7 Linking Two or More Objects</td>
<td>30</td>
</tr>
<tr>
<td>10.8 Unlinking Objects</td>
<td>30</td>
</tr>
<tr>
<td>10.9 Fixing Links</td>
<td>30</td>
</tr>
<tr>
<td><strong>Object Transformations</strong></td>
<td>31</td>
</tr>
<tr>
<td>11.6 Types of Transformation</td>
<td>31</td>
</tr>
<tr>
<td>11.7 Interactive Transformation</td>
<td>32</td>
</tr>
<tr>
<td>11.8 Nudging or Keyboard Translation</td>
<td>32</td>
</tr>
<tr>
<td>11.9 Direct-Input Translation</td>
<td>32</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>24</td>
<td>Reverberation Times</td>
</tr>
<tr>
<td>24.6</td>
<td>Statistical Acoustics</td>
</tr>
<tr>
<td>25</td>
<td>Acoustic Raytracing</td>
</tr>
<tr>
<td>25.6</td>
<td>General Overview</td>
</tr>
<tr>
<td>25.7</td>
<td>The Image Method and Distributed Rays</td>
</tr>
<tr>
<td>25.8</td>
<td>Spraying Rays</td>
</tr>
<tr>
<td>25.9</td>
<td>The Concept of Sound Rays</td>
</tr>
<tr>
<td>26</td>
<td>Environmental Impact and Embodied Energy</td>
</tr>
<tr>
<td>26.6</td>
<td>A Bridge Between Design and LCA</td>
</tr>
<tr>
<td>26.7</td>
<td>Greenhouse Gas Emissions</td>
</tr>
<tr>
<td>27</td>
<td>Material Costs Estimation</td>
</tr>
<tr>
<td>28</td>
<td>File Formats</td>
</tr>
<tr>
<td>28.6</td>
<td>Binary and ASCII Files</td>
</tr>
<tr>
<td>28.7</td>
<td>Binary Files Used By CONCEPT</td>
</tr>
<tr>
<td>28.8</td>
<td>ASCII Files Used By CONCEPT</td>
</tr>
<tr>
<td>29</td>
<td>DXF Files</td>
</tr>
<tr>
<td>29.6</td>
<td>DXF Translation</td>
</tr>
<tr>
<td>29.7</td>
<td>DXFOUT: Writing a DXF File in AutoCAD</td>
</tr>
<tr>
<td>29.8</td>
<td>Reading and Writing DXF Files in CONCEPT</td>
</tr>
<tr>
<td>30</td>
<td>3DS Files</td>
</tr>
<tr>
<td>30.6</td>
<td>3DS Translation</td>
</tr>
<tr>
<td>30.7</td>
<td>3DSOUT: Writing a 3DS File in AutoCAD</td>
</tr>
<tr>
<td>30.8</td>
<td>Reading 3DS Files in CONCEPT</td>
</tr>
<tr>
<td>31</td>
<td>Element Data</td>
</tr>
<tr>
<td>31.6</td>
<td>Establishing a Standard Material Definition</td>
</tr>
<tr>
<td>31.7</td>
<td>Available Material Libraries</td>
</tr>
<tr>
<td>32</td>
<td>Bibliography</td>
</tr>
</tbody>
</table>
1 PREFACE

1.1 Introduction

CONCEPT was written as a demonstration of the ideas presented in Part A of this thesis. Fundamental to its development was the idea that architectural science concerns are best addressed at the earliest, most conceptual stages of design, not only at the end of the process where nothing but a few cosmetic changes are possible. To enable this, Architects need simple, intuitive graphical design tools that apply well established analysis algorithms and present the results in a meaningful and directly applicable manner.

As a comprehensive environmental design tool for architects and building designers, CONCEPT integrates a simple and intuitive 3D modelling interface with solar, thermal, lighting and acoustic analysis algorithms. This allows simultaneous feedback on the full effects of any design decision. As such it represents an entirely new approach to environmental design, providing a framework within which building performance issues can be assessed and managed right from the most conceptual stages.

The most significant feature of CONCEPT is its interactive approach to performance analysis. Change the type of carpet on the floor and compare changes in the room’s acoustic impulse response, its reverberation time, monthly heat loads and internal temperatures. Add a new window and immediately see its thermal effect, weighing that up against changes in daylight factor, incident solar radiation and overall building cost. Spray acoustic rays around an enclosure and watch them change as the source is moved or the angles of reflective surfaces are altered.

CONCEPT can be used to:

- Display and animate complex shadows and reflections.
- Generate interactive stereographic diagrams for overshadowing analysis.
- Calculate monthly heat loads and hourly temperatures for any zone.
- Calculate the incident solar radiation on any surface and its percentage shading.
- Work out daylight factors and artificial lighting levels at any point.
- Read and write AutoCAD DXF files as well as other 3D model formats.
- Generate full schedules of material costs and environmental impact.
- Perform full geometric acoustic analysis of enclosures of any shape.
- Quickly calculate statistical reverberation times in any space.
- Estimate the required size of rainfall collection tanks.

CONCEPT is the only application of its kind to include comfort, environmental impact and embodied energy analysis alongside capital and running costs, for direct comparison.
significant part of CONCEPT was the development of its innovative 3D interface. A traditional CAD interface was not considered suitable for early design development, where the geometry is subject to constant change and real quantitative data is scarce. Thus a comprehensive relational CAD system was designed that exploits a surprisingly simple set of inherent relationships between building elements to simplify the modelling process and vastly increase its editability.

1.2 Technical Introduction

CONCEPT was written using Borland C++, versions 3.1 through 5.01. It has been extensively tested on a number of different machines ranging from a 286 laptop to a Pentium II 350 NT Server, under Windows 3.X™, Win95™ and NT™. It has been used on Novell, PCNFS, NetBUI and TCP/IP networks and tested by a number of student groups as part of undergraduate architectural science courses since 1994.
2  SOME FUNDAMENTALS

2.6  Working with Windows

Before you begin working with CONCEPT, you should understand the basics of Microsoft®
Windows 95™ and Windows NT™. Because CONCEPT operates in the Windows
environment, it uses the standard Windows rules for selecting menus, menu items, and
options in dialog boxes. Before using CONCEPT, therefore, you should know how to:

• Open, move within and cancel dialog boxes.
• Work with buttons, text, lists, check boxes, etc.
• Choose and cancel menu commands.

For more detailed information, refer to the Microsoft Windows User's Guide.

2.7  Terminology Used in This Manual

The following list explains terms you need to know in order to follow instructions in the
online help.

Choose:
To pick an item that begins an action (applies to menu commands and command buttons
in dialog boxes and in the main workspace).

Click:
To press and release the left mouse button.

Deselect:
To use the left mouse button or space bar to unmark a selected item (applies to check
boxes, option buttons, list boxes and text).

DoubleClick:
To press and release the mouse button twice in quick succession.

Drag:
To hold down the left mouse button while moving the mouse.

Select:
To mark an item by highlighting it with the left mouse button or space bar (applies to
check boxes, option buttons, list boxes and text).

Specify:
To type text or a number in a text box.
3 **Basic Interaction**

3.6 **Workspace Layout**

The main workspace of CONCEPT consists of six major sections, as outlined in Figure 1 immediately below. In addition to the standard MS Windows menu, status and tool bars, CONCEPT provides three additional windows.

*Model Canvas*

This sub-window provides a 3D view of the current building model. You can select different views or rotate the current view using the mouse or keyboard.

*Information Panels*

This window displays model information, the exact form and content of which is dependant on which panel is active.

*Direct Input Area*

This area is occupied by a group of six controls for direct data entry. Use these when you wish to enter the coordinates of an object’s node or to accurately move selected objects.

![Figure 1: CONCEPT Client Area](image)

There is also another window which appears only after acoustic rays have been calculated. This is known as the Graph Canvas and displays various information relating to inter-reflected acoustic rays. It will disappear again whenever acoustic rays are erased.
3.7 Using the Mouse

The mouse functions as you would normally expect in any Windows application. When used in the Model canvas, the left mouse button is used for selecting and dragging objects or nodes whilst the right mouse button rotates the current perspective view. Double-clicking the left mouse button on an object enters node mode whilst double-clicking the right mouse button will invoke the Object Properties or Edit Node dialog box, depending on the current selection mode.

3.8 Using the Keyboard

As keyboard functionality is shared between the Model canvas and other controls in the workspace, some keys may function differently depending on the window that has the current focus. When focus is set to the Model canvas the cursor keys are used to rotate and pan the view. When entering coordinate data in the direct input area, however, the cursor keys need to be used to move within and between the text edit boxes.

In order to accommodate this, CONCEPT automatically switches between two modes, *default mode* when all input is directed to the Model canvas, and *dialog mode* functioning in a manner similar to a Windows dialog box for moving between and editing controls.

In either case, the *TAB* key will always increment the current focus to the next control, the *End* key will always enter dialog mode and the *Escape* key will always reset to default mode.

3.8.1 Default Mode

As explained above, this mode directs all keyboard input to the Model canvas. This allows the cursor and function keys to be used to manipulate the model view. CONCEPT automatically resets to this mode whenever the *Mouse* is clicked in the Model canvas, the *TAB* key is used to move the focus out of the Direct-Input area, or the *Escape* key is pressed. In addition to menu shortcuts, the following keys are active in this mode:

*Cursor keys*

Rotate the model in perspective or pan the model in orthographic view. Holding down the Shift key rotates or pans in much smaller increments. In perspective, holding down the Control key pans the view.

*+/- keys*

Zooms in and out of the current view. Holding down the Control key at the same time adjusts the focal length of the perspective lens, increasing or decreasing the amount of perspective distortion.
The action resulting from pressing these keys depends on the current display and selection mode. In normal model display they cycle the currently selected node or object, however, they are also used to change the time in shadow mode or cycle the current acoustic ray. Holding down the Shift key cycles either the current object, the date or the current receiver point. Holding down the Control key cycles the current zone.

Home
Zooms to fit the current model extents completely within the displayed canvas.

Esc
Switches to default mode.

End
Switches to dialog mode.

3.8.2 Dialog Mode
As in a Windows dialog box, dialog mode allows the use of cursor keys to move between and edit values in text controls. CONCEPT shifts to dialog mode whenever the user selects or edits a control in the Direct-Input area, or presses the End key. If the interface should ever not act as expected (for example not reacting to a keyboard shortcut) simply press the Escape key to reset to default mode.

3.9 Entering Numeric Data
CONCEPT passes all numeric data entered in all edit boxes or controls through its own equation parser. As a result, you can enter numeric values directly or use resolvable mathematical equations of any complexity. For example, you could add up several numbers by entering \(55.6 + 16.8 + (15/4.55)\) or use more complex mathematical functions such as \(\text{TRUNC}(55.6 \times (\text{TAN}(\pi/12) + \text{SIN}(\pi/6)))\). All angles used within trigonometric functions must be in radians, even if the result is to be in degrees.

All directly entered decimal values are assumed to be in floating point notation. As a result, any of the following are valid and equivalent input: \(900, 900.0, 9e2\) or \(900.0000\). There are two exceptions to this:

Time Data
All time values in CONCEPT are based on the 24 hour clock. When entering times, there are a number of options: colon separated, decimal hours or military time. For example, the following are all valid and equivalent input: \(15:30, 15.5, 15.500\) or
1530. The display format is always colon separated. Equation parsing is not performed if a colon is detected in the entered string.

*Dimension Data*

As all internal dimensions in CONCEPT are stored in millimetres, it is the interpretation of entered dimensional values that is determined by the *Displayed Units* setting in the *Preferences* dialog box. For example, when set to metres, CONCEPT automatically multiplies the result of any entered dimension by 1000 to convert to millimetres internally. Similarly, decimal inches are multiplied by 25.4.

When entering *imperial feet*, however, the process can get a little more complex. At the most basic level, you can use either decimal feet or simply enter a single quote or space between the feet and inch components, and a double quote or further space between the inch and fractional component, if used. When parsing the resulting string, CONCEPT looks for occurrences of a space, period, single quote, double quote or forward slash. As a result, any of the following are valid and equivalent input: 4.5, 4 6, 4’6” and 4’ 6”.

Fractional inches can be included as follows: 4’6”3/8, 4 6 3/8, or 4’ 6” 6/16. Simply typing the inch component or fractional components will result in the value being interpreted as feet so you must precede it with one or more zeros.

As you can imagine, including such complex notation within an equation could get quite confusing, especially for the parser. As a result, you should only include decimal feet in equations. If any of the above tokens are found in a string, CONCEPT expects to find separate foot, inch and fractional component. Thus, you cannot include spaces or division signs in any equations involving imperial feet.

**3.9.1 Equation Functions**

The following is a list of mathematical functions available within the equation parser. Within the brackets, x represents a decimal value or any number of other functions, as long as the resulting equation is resolvable.

- **ABS(x)** Absolute value of x.
- **ACOS(x)** Arc cosine of x.
- **ASIN(x)** Arc sine of x.
- **ATAN(x)** Arc tangent of x.
- **COSH(x)** Hyperbolic cosine of x.
- **COS(x)** Cosine of x.
- **DEG(x)** Converts x radians to degrees.
- **EXP(x)** Exponential, e to the power of x.
• $\text{LOG10}(x)$  Logarithm of $x$ to the base 10.
• $\text{LOG}(x)$  Natural logarithm of $x$.
• $\text{POW10}(x)$  Returns 10 to the power $x$.
• $\text{RAD}(x)$  Converts $x$ degrees to radians.
• $\text{ROUND}(x)$  Rounds $x$ to nearest integer.
• $\text{SINH}(x)$  Hyperbolic sine.
• $\text{SIN}(x)$  Sine of $x$.
• $\text{SQRT}(x)$  Square root of $x$, ($x^{0.5}$).
• $\text{SQR}(x)$  The square of $x$, ($x^2$).
• $\text{TANH}(x)$  Hyperbolic tangent of $x$.
• $\text{TAN}(x)$  Tangent of $x$.
• $\text{TRUNC}(x)$  Truncates $x$ to its integer value.
4 OPERATIONAL CONCEPTS

4.6 Interactive Modes

Interactive modes only affect the operation of the mouse within the model canvas when manipulating objects. As with any application that involves some level of complex user interaction, there are particular times when the operation of the mouse and keyboard need to be tailored slightly to suit a specific task. This is particularly true in this application, where model objects can be interactively manipulated in a number of different ways. There are three interactive mode you need to be familiar with:

Select Mode

This is the default mode. In this mode the cursor is used to pick and drag select objects. When a selected object or node is clicked and dragged, it is translated by a vector defined by the distance between the initial cursor position and the current cursor position. This means that objects can be moved in any axis and along any plane, using the Shift and Control keys to alter the height of the cursor.

Rotate Mode

Rotation mode, on the other hand, means that the dragged object is rotated around the About Point by an angle defined by the line drawn from the initial cursor position, through the About Point to the current cursor position. The axis about which this rotation occurs depends on the current view. In perspective and plan view, it is always the Z-Axis. In a side view it is the X-Axis and front view it is the Y-Axis.

Measurement Mode

When this mode is entered, you can use the mouse to take measurements off the model. Simply select a reference point to begin with and then take consecutive measurements by clicking on objects in the current view.

4.7 Selection Modes

In order to facilitate accurate modelling, there are two levels of interactive selection and manipulation, object-based and node-based. The Select menu, the F3 function key or the mouse can be used to change between these two modes.

4.7.1 Object Mode

In this mode, objects are selected and manipulated in their entirety. For more information on selecting and manipulating objects, see the sections entitled Object Selection and Object
Transformations. To change to this mode using the mouse, simply click in an empty area of the model or select a previously unselected object by clicking on one of its line segments.

4.7.2 Node Mode

In this mode, individual object nodes can be selected and manipulated. For more information on selecting and manipulating nodes, see the section entitled Editing Nodes. To change to this mode using the mouse, simply double-click a selected object.

4.8 The About Point

Certain transformations, such as rotation and scaling, require an origin point about which the transform is centred. Rather than re-positioning the entire model around the geometric origin (0,0,0), a dynamic origin is used and called the About Point. This point can be set either interactively with the mouse, using the Direct Input Area, or from within the Transform dialog box.

4.8.1 Interactive Location

To position the About Point interactively with the mouse, select the About Point item from the Select menu or choose directly from the toolbar. When you click the left mouse button within the Model canvas, you will be able to drag and position its image, in this case a small red point symbol, as you would any node within the model. This way you can use snap modes to accurately set its position, which occurs as soon as the left mouse button is released.

4.8.2 Direct Input

You can set the location of the About Point directly when there are no objects or nodes selected. You can tell when this is possible because the Direct Input button’s caption changes to “About Point”. Simply enter the required coordinates in the three edit boxes provided and press the Enter key, or click the button with the mouse. You can make use of formula and equations here, as you can in nearly all other edit boxes.
5 FILE MANAGEMENT

5.6 Model and Data Files

CONCEPT makes use of a number of different types of file for storing material definitions, location data and model information. CONCEPT’s native file format for storing model information is the ZON file. In addition, two files are automatically loaded on start-up, CONCEPT.LIB and CONCEPT.LOC. These are also referred to directly when displaying some dialog boxes.

Below is a list of file extensions used and a description of the data they store. For a more detailed discussion of their contents, see the section on File Formats.

- **ZON** Binary CONCEPT model data.
- **MOD** ASCII object data for transfer between CONCEPT models.
- **RAY** ASCII ray data from CONCEPT ray-tracing calculations.
- **DXF** Model data for transfer to/from AutoCAD and other CAD software.
- **WRL** VRML object data for 3D display using browser.
- **RAD** Model data for output to RADIANCE.
- **LIB** Material and manufacturer data.
- **POS** Positional information for towns.
- **LOC** Location and weather data.
- **FRQ** Sound spectrum data.

5.6.1 Loading a Model File

In order to view or edit a model, you must load it into memory. For details on loading and saving models, see the tutorial in Appendix A. After loading a file, CONCEPT defaults to the last view saved in the model file. If nothing appears, then the file was either empty or the model is very large (or very small) compared to the stored grid dimensions. Simply select the Fit Grid item from the View menu (or press Ctrl+F) to fit the grid to the extents of the model. Once loaded, the full name of the file will appear in the File menu, in the section immediately above the Exit item. To reload this file during a later session, simply select this menu item when it is available.
5.6.2 Creating a New Model

To create a new model you must remove the existing model. You can do this by selecting New from the File menu or using the toolbar. This clears the memory buffers, re-initialises the environment and erases the current file name.

If you wish to retain the current grid, display settings and file name, you could create a new model by simply deleting all objects in the current model. Either way, if you have made changes to the current model, you will be prompted to save them before freeing memory.

You should check the statusbar to make sure that ‘None’ is displayed in the object count indicator. You are now ready to add objects to your new model.

5.6.3 Importing Data

As opposed to loading, where new data replaces existing, importing a model file adds the new data to the existing model. In this version, only ASCII MOD, Acoustic RAY files and AutoCAD DXF files can be imported. After importing data, CONCEPT automatically resizes the display grid to fit the new model. For detailed information on importing AutoCAD DXF files, see the section on DXF File Translation.

5.6.4 Exporting Data

CONCEPT can export data in a number of different formats for use by other applications. These include Virtual Reality Modelling Language (VRML), AutoCAD Drawing Exchange Format (DXF), Radiance lighting simulation program (RAD) and image file formats.
6 **View Management**

6.6 **Graphic Representation**

By default, CONCEPT displays a perspective wire-frame view of the model. You can, however, choose from a number of other 2D and 3D orthographic projections as well as displaying other information. Use the View menu to select a Plan, Front, Side, Perspective or Axonometric view of the model and the Display menu to select from a range of alternate graphical information. Alongside each of the view types, and some of the display settings, there are keyboard shortcuts. For example, the F5-F8 keys select plan, front, side and perspective views. The F9 key displays the basic model whilst Ctrl+F9 displays shadows on the model.

6.6.1 **Rotating the View**

You can rotate the current perspective view with the mouse or by using the cursor keys.

*Right Mouse Button*

In perspective or axonometric view, clicking the right mouse button in the Model canvas allows you to rotate the model interactively until the correct view is achieved. You simply drag the mouse to the left or right, up or down as the model rotates around the current perspective focal point.

*Cursor Keys*

You can use the cursor keys to rotate the view in 10 degree increments. Holding down the Shift key reduces this to 1 degree whilst the Control key allows you to pan in any of the four directions.

6.6.2 **Zooming In and Out**

There are a number of ways to zoom in and out of the model in any view.

*Incremental Zoom*

You can zoom in and out incrementally in default mode using the + and - keys. Each zoom is a 10% increment or decrement about the centre of the current view. You do not have to hold the shift key down to access the + key on the main keyboard.

*Zoom Window*

To zoom in on a particular region of the current view, select Zoom Window from the View menu or use the toolbar. Simply click the left mouse button at one corner of the desired region, drag the pointer to the opposing corner and release it.
Zooming to Fit

You can zoom out to the full extents of the model by selecting Zoom All, also from the View menu, using the toolbar, or pressing the Home key.

6.6.3 Changing Perspective Parameters

In perspective view the position of the eye point, focal point and picture plane determine the degree of perspective distortion. To simplify the task of view selection, these three are positioned parametrically depending on the perspective lens setting in the Display Setup dialog box. Alternatively, you can hold down the Control key whilst using the + and - keys to incrementally adjust this parameter.

6.6.4 Changing the Display

CONCEPT has quite a range of information to display at different times, much of which is dependant on what calculations have been performed. For a description of the information available for display, see the Display menu. When a particular set of information is not available, the corresponding menu item is disabled.
7 **THE CURSOR SYSTEM**

7.6 **An Interactive 3D Cursor**

Part of the research into CONCEPT included the development of an innovative 3D interface to greatly simplify the process of modelling. Part of this interface involved the design of an intuitive 3D cursor system. Many computer aided design programs require you to work two dimensionally, constantly resetting the horizontal work plane to some arbitrary height in the third dimension. CONCEPT’s cursor system allows you to work intuitively in perspective and other 3D views.

7.6.1 **The Cursor Plane**

In order to locate a 2D cursor within a 3D model, an imaginary line must be drawn between the user’s eye and the mouse arrow. This line is then projected into the model and intersected with the current cursor plane. By default this is the ground plane, at Z=0. However, whenever you move the cursor up, the default plane resets to the current cursor height. You can change this plane using keyboard modifiers and selected objects.

7.6.2 **Moving Up and Down**

The cursor is very similar to other systems in that it displays a set of crosshairs in the XY plane. However, there is also a vertical component. Moving the mouse normally moves the cursor in the XY plane. Pressing the Control or Shift keys allows you to move vertically. The crosshairs still appear in the XY plane, along with a vertical line indicating how high the cursor is above or below the ground plane. The keys and their respective planes of movement are as follows:

<table>
<thead>
<tr>
<th>Key Modifier</th>
<th>Plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>X - Y</td>
</tr>
<tr>
<td>Control</td>
<td>X - Z</td>
</tr>
<tr>
<td>Shift</td>
<td>Y - Z</td>
</tr>
</tbody>
</table>

7.6.3 **Relational Control**

Due to the integration of a relational CAD system that exploits inherent geometric relationships between building elements, there will be times when the cursor does not respond to the above keys. This is when the cursor is fixed in a specific plane. This occurs when adding more than three nodes to a planar object or when adding a window or door to a wall plane. These nodes must be coplanar, therefore the cursor will not deviate from this plane when adding or moving these nodes.
7.7 Cursor Snap Modes

By default the cursor snaps to the Snap Grid setting specified in Display Setup dialog. This means that it moves only in integral units of this value. There are quite a few other snap options available to speed up the modelling process.

You can change snap mode at any time using the toolbar or simply pressing the key corresponding to the first letter in its name, even in the middle of selecting or dragging nodes or objects (n, g, p, l, a or o). The following snap modes are currently available:

**NONE**

The cursor position is unrestricted and moves at whatever increment is determined by the 2D pixel ratio of the screen which, in turn, depends on the zoom setting.

**GRID**

The cursor will only move in increments equal to the current Snap Grid setting.

**POINTS**

The cursor will snap to the nearest visible object node when within range of the default select tolerance (set in the Preferences dialog box). Otherwise it snaps to the current snap grid setting. A small P symbol appears above the cursor point to indicate when it has found a snap point.

**LINES**

The cursor snaps to the nearest point on a line segment belonging to the nearest object, if within range. Otherwise it snaps to the current snap grid setting. A small L symbol appears above the cursor point to indicate that it has found a line to snap to.

**ALIGN**

In this setting, whenever the cursor is moved, the model is searched for other nodes that line up along the three major axis. If a node is found, the cursor snaps to that axis. It is possible for the cursor to snap to two axis simultaneously. When snapping to an axis, X, Y and/or Z symbols appears above the cursor point to indicate that a snap has been found. In orthographic view, axial snap occur irrespective of node height. In perspective and axonometric view, only nodes on roughly the same horizontal plane are tested.

**ORTHO**

In this snap mode, the cursor is restricted to orthographic movement along the axis of greatest difference between a nodes original position and the mouse point. Depending on the relative movement, small X or Y symbols appear above the cursor.
It is usually best to select and begin dragging a node before entering this mode to ensure the correct starting or reference position.

**MID POINTS**
Snaps to the geometric mid-point of the closest line segment in an object. A small M symbol appears above the cursor point to indicate that it has found a line to snap to.

**END POINTS**
Snaps to the end of the closest line segment in an object. A small E symbol appears above the cursor point to indicate that it has found an end point. This differs from the Points snap mode in that the mouse need not be anywhere near a node, simply near the line segment that node belongs to.

**INT POINTS**
Snaps to the closest intersection between two lines. Whilst there is a small vertical tolerance, the two lines must actually intersect in 3D space. This mode differentiates between lines that intersect at their end points and those that intersect somewhere between. Both are detected, however small I and E symbols are used to indicate each type.

**CENTRE**
In this snap mode, the cursor snaps to the geometric centre of the closest object. This is simply the spatial average of all vertices that make up that object, weighted equally.

It is important to familiarise yourself with these various snap modes as you can change modes at any time, even when halfway through entering an object. This can greatly simplify the modelling process and increase model accuracy.
8 OBJECT SELECTION

8.6 Selecting an Object

Selecting an object in CONCEPT simply tags that object as being the recipient of whatever command or set of commands are then carried out. You can only operate on selected objects, which are those highlighted in yellow. If the geometry is locked, when geometric acoustic reflections have been calculated for example, selected objects are highlighted in red.

8.6.1 Direct Selection

You can select an object by simply clicking the left mouse button on or close to some part of the desired object. When proximity checking, CONCEPT first tests the nodes of all objects within range. If any nodes are within the default selection tolerance (set in the Preferences dialog box), the object containing the closest node is selected. If no nodes are found, the distance to each line segment in range of the selection point is then calculated. If any distance is less than the specified tolerance, the object containing the closest line to the selection point is selected.

Co-linear Objects
When two or more objects share the same line segment, the oldest object (created first) is always selected first. To cycle through other objects within range of the selection point, press the SPACE bar. This will select the next object possibly picked and deselect the previous one. If adding objects to an existing selection set, holding down the Shift key whilst pressing the SPACE bar will leave the original selection set unchanged, otherwise it will be cleared before the next picked object is selected.

Selected Objects
CONCEPT always checks the proximity of currently selected objects before replacing the selection set. This means that selecting a point very close to an already selected object will result in CONCEPT thinking that you now wish to move or rotate that object. If you select one of the nodes of an already selected object, the cursor snaps to the selected node, allowing for very accurate interactive placement.

Nothing Found
If no objects are found near the selection point, a selection rectangle is displayed. You can drag this rectangle in any direction you wish. Any objects whose nodes are entirely within this rectangle will be selected.
8.6.2 Menu Selection

You can select entire sets of objects from the main menu. This allows you to choose all objects in the model, the previous selection set, the children or parents of objects in the current selection set, even all of the walls in the model. For a description of all the options available, examine the Select menu. To add or remove particular element types from an existing selection set, simply hold down the Shift key whilst selecting the menu command.

8.6.3 Keyboard Selection

You can also use the Shift+PgUp and Shift+PgDn keys to cycle through visible objects in the model, one by one. In object selection mode, the PgUp and PgDn keys do the same job. This selects the previous or next objects from the current object. If multiple objects are selected, the current object is usually the oldest object in the set or the last object added.

8.7 Keyboard Modifiers

When selecting an object, you can use the Shift key to toggle the selection state of objects. When holding down the shift key and selecting a new object, this object is added to the current selection set, instead of replacing it. When selecting an already selected object, the shift key removes that object from the selection set. This applies to direct selection, indirect selection and menu selection sets, but not to keyboard selection as you have to use the shift key to access this anyway.
# Adding and Deleting Objects

## 9.6 Creating Objects

Objects can be created within CONCEPT either interactively with the mouse or automatically from a customisable library of parametric objects.

### 9.6.1 Adding New Objects Interactively

To interactively add a new object to the current model, the mouse is used to insert and position new object nodes within the Model canvas. To do this, simply select one of the items in the Model menu or an appropriate toolbar button. You can add a new object at any time.

The three basic point, line and plane objects are available, as are some more specialised objects such as walls, zones and speakers. There are a number of child objects available, each prefaced by the word *Insert* instead of *Add*.

*Creating an Object*

When one of the Model menu or toolbar items have been selected, CONCEPT waits until the left mouse button is clicked in the Model canvas before creating the object and its first node. You are then able to immediately drag this first node into position while still holding down the mouse button. Releasing the mouse button positions the first node.

*Adding Subsequent Nodes*

You can add subsequent nodes by selecting an existing node in the new object and dragging the inserted node into position. This way, you do not have to add nodes in any particular order. Selecting any node in the new object inserts a new node between the selected one and its next ordinal node. Selecting the last node in the object appends a new node to the end of its node list.

*Completing the Object*

You complete the interactive creation of an object by performing any of the following actions:

- Click in an unoccupied area of the screen
- Choose another menu command or
- Select a toolbar button

The *Select* button is usually a good choice if using the toolbar. When one of these occur, CONCEPT completes the object and resumes interactive mode.
9.6.2 Adding Library Objects

The Add New Object dialog box provides a means of adding parametric or manufacturer designed objects to the model. You can invoke this from the Model menu or by pressing the Insert key. If an object is currently selected, CONCEPT assumes you wish to insert a child window or door, otherwise it defaults to a set of basic parametric geometry.

Basic Geometry
This allows you to create complex parametric constructions from multiple objects. These range from simple rectangular zones and spheres to complex hip and gable roofs. The number and type of parameters required varies with each construction.

Element Types (Windows, Panels, Doors, Points, Speakers and Lights)
Selecting one of these element types displays a list of matching objects from the current library file (the default is CONCEPT.LIB). Manufacturers of such objects can create their own libraries with full product descriptions and order codes.

When a window, panel or door is inserted as a child object (when invoked with a plane object currently selected), it is positioned relative to the centre of the parent object. When added as a new object, its first node is located at the insertion point.

9.7 Object Types

When an object is added, it is automatically assigned a building element type and the default material for that type. The available element types are Void, Roof, Floor, Ceiling, Wall, Partition, Window, Panel, Door, Point, Speaker Light, Appliance and Line. The element type simply adds a little extra architectural knowledge to the building model.

Whilst any object can be a child or parent of any other object, there are a number of special relationships which are based on architectural logic. These relationships apply when, for example, a window or door is created as the child in a wall. In this case, the child actually creates a hole in the parent and is restricted in its movement to be internal to the parent. A list of base and child objects is given below along with a description of any special relationships that are automatically established.

9.7.1 Base Object Types

The following is a list of base objects and the element types they are assigned.

Points
Point objects, as the name suggests, are single-node objects. When created, they are assigned the default Point material. Once the first node is added, the display updates and normal interactive mode is resumed.
Lines
A line object is a simple multi-node line with no restrictions on nodal position. It is assigned the default Line material.

Planes
A plane consists of any number of coplanar nodes, with the last linked back to the first. The plane equation is derived from the first three non-linear nodes, all subsequent nodes are restricted in their movement to the plane thus defined. Plane objects are assigned the default Ceiling material.

Walls
A wall object is simply an extruded line object. You create the parent line and, when complete, CONCEPT automatically extrudes a number of vertical planes corresponding to the number of segments in the line. Any changes to the parent line will automatically update each child plane. The parent, obviously, is assigned the default Line material, whereas extruded planes become Partition objects.

Zones
A zone object is simply an extruded floor plane. Once you create the parent plane, CONCEPT automatically creates a new model zone, extrudes each line segment and adds a ceiling plane. The name of the new zone defaults to ‘Zone X’, where X is the ordinal number of the zone. The parent plane becomes a Floor, the vertical extrusions become Walls and the top plane becomes a Ceiling.

Speakers and Lights
Creates a sound or light source. Depending on which you initially chose, the Light or Speaker type is assigned to the object. These are simply point objects with a second node indicating a direction vector. The second node is automatically added such that Speaker objects face along the positive X axis whilst Light objects point straight down towards the negative Z axis.

9.7.2 Child Object Types
In order to insert a child object, such as a window or door, you must have the parent object already selected. The child object is then tagged as a child and a relationship with the parent is established. The type of relationship depends upon the type of object inserted. In most cases, new object nodes will be restricted in their movement to inside the plane of the parent object.
**Partitions**

Partitions are simply child wall objects. The partition line’s nodes are restricted in their movement to the inside of the plane defined by the parent object. You create the parent line and, when complete, CONCEPT automatically extrudes a number of vertical planes corresponding to the number of segments in the line. Any changes to the parent line will automatically update each child plane. The parent is assigned the default Line material, whereas extruded planes become Partition objects.

**Windows**

A window is a transparent or semi-transparent hole in a plane. If in a roof or ceiling plane, the window becomes a skylight. The window’s nodes are restricted in their movement to inside the plane of the parent object, and its surface area is removed from the parent.

**Panels**

A panel is an area of different material within a larger planar object. It too is coplanar to and belongs entirely within the boundaries of its parent, and its surface area is also removed from the parent.

**Doors**

A door object is similar to a window object in that it is coplanar to and belongs entirely within the boundaries of its parent, however, it also represents a means of access/egress within its zone. The surface area of doors is also removed from the parent.

**Voids**

Voids create holes within a parent object and, as such, their nodes are also restricted to inside the plane of the parent object. Its surface area is removed from the parent.

### 9.8 Deleting Objects

You can delete an object whenever it is selected by choosing Cut from the Edit menu or simply pressing the Delete key. When deleting, CONCEPT automatically cleans up orphan or childless relationships. Once deleted, you can paste the objects back by choosing the Paste item from the Edit menu or selecting Undo.

### 9.9 Copying Objects

You can copy selected objects in four ways, by exporting and importing them, copying and pasting them to the clipboard or duplicating them directly. You can use the export and import commands to transfer any number of objects within or between model files.
9.9.1 Copy and Paste

The *Copy* and *Paste* commands in the *Edit* menu can be used to store and retrieve objects on the clipboard. Pasted objects become the current selection set and will always return in exactly the same position as when originally copied. It is usually best to copy the selection set, move or transform the original objects and then paste back the copies in their original location.

9.9.2 Duplicate

The *Duplicate* command in the *Edit* menu is used to create an exact copy of each selected object. The duplicate is offset by the vector set in the *Duplicate Offset* dialog box. By default, the duplicated object is not linked to the original. However, if the *Link Duplicates* option is selected, the duplicate object is linked by an offset relationship to the original. Any changes to the original object will be reflected in the duplicate.

9.9.3 Transform

New objects can also be added using the *Transform Selection* dialog. This allows the transformation to create an array of duplicate objects instead of being applied directly to the selection set.
10 **OBJECT RELATIONSHIPS**

10.6 **Relationship Types**

CONCEPT is based on a comprehensive relational CAD system that exploits a simple set of inherent relationships between building elements to greatly simplify the modelling process. Establishing relationships between objects is mostly automatic, however, you may wish to link and unlink specific objects as you refine your model.

10.6.1 **Parent/Child Relationships**

All relationships are based on a standard parent/child hierarchy. Transforming a parent object transforms all of its children, whilst transforming a child is independent of the parent. Almost all relational information is stored at node level. Thus, relationship types are defined as a combination of nodal restrictions.

The five basic nodal restrictions are as follows:

- **LOCKED:**
  Node is locked to a parent node. It is fixed in position and cannot be moved unless the parent node is moved.

- **OFFSET:**
  Node is locked relative to a parent node, offset by the object’s extrusion vector.

- **VECTOR:**
  Node is restricted in movement to the line representing the extrusion vector of its parent object.

- **COPLANAR:**
  Node is restricted in movement to the 3D plane defined by its parent.

- **INTERNAL:**
  Node is restricted in movement such that it must always be inside the polygon defined by its parent.

Locked and offset nodes are highlighted in grey instead of red and cannot be interactively edited. All other nodes can be edited, if the new position does not violate any set restrictions. Individual nodal relationships can be viewed and edited using the *Edit Node* dialog box.
10.7 **Linking Two or More Objects**

To link two objects, simply select them both and choose the *Link Objects* item from the *Select* menu. When linking the objects there are a number of factors that determine which one becomes the parent and which one the child.

If one of the objects is a *window, door, panel* or *void*, and the other is a *wall, floor* or *ceiling*, the choice is obvious. If, however, the element types cannot be so easily resolved, then the oldest (created first) of the two becomes the parent and the object created most recently becomes the child.

10.7.1 **Linking Multiple Objects**

When more than two objects are selected, the oldest object in the selection set is designated as the parent object, all subsequent objects becoming its children.

10.8 **Unlinking Objects**

To unlink an object, simply select it and choose the *Unlink Objects* item from the *Select* menu. Unlinking an object removes all links with any other objects in the model. CONCEPT automatically cleans up lost or orphaned children. This process cannot be undone, and a message indicating this is displayed.

10.9 **Fixing Links**

Whilst constantly checking and updating links, there may be times when CONCEPT cannot resolve a particular link. This can happen when a node is moved such that it is no longer coplanar or a wall is made smaller than one of its child windows. In this last case, the child window cannot help but have some of its nodes external to its parent, thus violating one of its relationships.

Any such objects are highlighted in red and an error message is displayed in the status bar. When selected, such objects appear as pale blue.

To automatically fix links, simply select the highlighted objects and choose the *Fix Links* item from the *Select* menu. Whilst nearly all violations are easily rectified, obviously some, as in the case with the small wall and large child window situation, will require user intervention.
11 OBJECT TRANSFORMATIONS

11.6 Types of Transformation

The geometry engine allows objects and nodes to be transformed in a number of different ways. Most make use of a definable origin known as the About Point and a variable number of parameters. Some may also be done interactively with the mouse or using the direct input area.

The seven basic transformations are:

Rotation:
Objects or nodes are rotated around the About Point by a specified azimuth and altitude angle. This rotation is always performed in two stages, first the altitude angle and then the azimuth. Positive angles are always anti-clockwise and up.

Rotation - Axis:
Objects or nodes are rotated around one of the three major axis by a specified angle, with the About Point as the origin. Positive angles are always anti-clockwise, when viewed from a positive direction (i.e.: X > 0).

Translation:
This is a straight move from the object or node’s current position to a position offset by the specified vector.

Scaling:
Objects or nodes are scaled relative to the About Point by the specified amounts in each of the major axis.

Extrusion:
New objects are created from an existing object by adding nodes offset by the specified distance along the objects normal. If the object is not planar, its parent’s normal is used or, by default, the Z axis. A new object is created for each line segment in the transformed object, as well as a cap or lid object when the Cap Extrusions option is set. Newly created objects become children of the transformed object and relational links are established.

Extrusion - Axis:
This is the same as Extrusion, except that the extrusion vector is specified in the three major axis, irrespective of the object’s normal.
Revolve:

New objects are created from an existing object by adding nodes determined by the rotation of the selected object around the selected axis by a specified angle, in the specified number of segments. A new object is created for each line segment and for each segment of rotation, each becoming a child of the transformed object.

Other transformations are simple implementations of one or more of the above. For example, to mirror an object simply select it, set the about point and scale it in the required axis by -1.0.

11.7 Interactive Transformation

Only axial rotation and translation are possible using the mouse. You can move selected objects by simply clicking and dragging them around using the 3D cursor features. It is important that you familiarise yourself with the different interactive modes used by CONCEPT. If you drag an object by selecting very close to one of its nodes, the cursor snaps to that node, allowing very accurate interactive placement and alignment.

Axial rotation requires that you have set the About Point first. As the mouse is dragged, the object is rotated around the about point by the specified number of degrees.

11.8 Nudging or Keyboard Translation

Pressing the X, Y or Z keys whilst an object is selected will move that object in the corresponding axis by an amount equal to the current snap grid setting. The cumulative amount of movement is indicated in the direct input area. Holding down the **SHIFT** key results in negative movement in each axis.

11.9 Direct-Input Translation

You can also move selected objects or nodes by typing in a translation vector in the direct input area and clicking the *Move* button or simply pressing *Return* key. Using this method it is possible to use a mathematical formula or equation in any or all axis.

11.10 Transform Selection Dialog Box

For complicated and accurate transformations, you can use the *Transform Selection* dialog box. Use this to apply any of the basic transformations to the current selection set.
12 **Object Properties**

12.6 **The Object Data Structure**

In order to construct even the simplest model, and then analyse its performance, each object needs to contain a significant amount of information. Apart from their geometry, objects need to know what section of the building they belong to, what function they perform, what way they face, what portion is exposed to the outside, what they are made from, how well light, heat and sound can pass through them, how much they cost, are they selected, do they cast or receive shadows, do they reflect solar radiation, etc.

Much of this information can be inferred from how an object was created and its geometric properties, or even calculated from a database of material data. However, there will be times when you will want to change some of this information, so you should have some idea of how it is stored and used.

12.6.1 **Object Zone**

A zone is simply a group of objects that, together, create a clearly defined space within the model. Each object stores the ordinal index of the zone to which it belongs. This information is used to simplify the display, calculate volume information, determine daylight factors and when exporting the model to other applications.

12.6.2 **Element Type**

This refers to the object’s function within the building fabric, specifying that it represents a wall, a floor, an internal partition, or even a window. For an explanation of the defined element types, see the section entitled *Element Types and Materials*. This information is used when calculating building costs, searching for lights, speakers or receiver points, displaying shadows and calculating thermal performance.

12.6.3 **Alternate Material**

One of the fundamental features of the CONCEPT model is editability, the ability to be able to drag around and rearrange zones very quickly and easily. When two zones are positioned right next to or on top of each other, there will be some portions of a wall, floor or ceiling that overlap wall, floor or ceiling elements of the adjacent zone. It is unlikely that the same material will be used in the overlapping and non-overlapping sections.

Defining an alternate material allows you to move zones around as much as you want without ever having to worry about how much of a particular wall will be external cavity-brick, for example, and how much will be internal single-brick. This only applies to *Voids,*
**Roofs, Floors, Ceilings and Walls.** By default, the alternate material is the same as the normal material.

For **Windows, Doors, Panels, Voids and Sources**, the alternate material is used when the object is activated. An object can be activated to simulate opening a window at a particular time or turning on a heater. During the activation period, the alternative material replaces an object’s normal material during time-based calculations.

### 12.6.4 Relationship Links

In addition to its geometric relationship to other objects, CONCEPT imbues objects with relational information that greatly simplifies editing and manipulation of the model. For more information on these relationships and how they are established, see the sections called **Base Object Types** and **Object Relationships**. Such relational information is used every time an element within the geometric model is edited, an object’s position changed or its surface area recalculated.

### 12.6.5 Vector

Every object has a vector component that is used to store extrusion or offset information, or even the direction light and sound sources are pointing. It is simply a point whose distance relative to the geometric origin defines the vector. Editing an object’s vector automatically updates dependant relationships.

### 12.6.6 Attributes

Object attributes are currently used to set activation and de-activation times. These are mainly used for **Windows, Doors, Sources** and **Appliances** to simulate such activities as opening a window or turning on a heater. These are used in thermal performance and energy use calculations.

*Point and line* objects can also have a radius attribute. This has not internal effect, but is used when exporting data to other applications.
13 ACTIVATING AN OBJECT

In order to simulate complex occupant behaviour, CONCEPT allows objects to be active and inactive. This only applies to Windows, Sources and Appliances. For planar objects, such as walls, floors, roofs and ceilings, the primary/alternate material is determined by proximity to other objects (i.e.: if they overlap). Windows, sources and appliances have to be activated at specific times.

Activation times are used to switch between the primary and alternate materials. When activated the alternate material is used. Thus, it is possible to open and close a window, draw blinds and switch between entirely different types of sources at different times of the day.

You can activate an object using either the Object Properties dialog box or the Object Panel on the right hand side of the main screen.

13.6.1 Specifying On/Off Times

The simplest way of activating an object is to specify an on and off time. These values use the 24hr clock. If an on time after an off time is specified, then the object is simply active overnight.

13.6.2 Specifying an Operational Profile

It is also possible to specify an operational profile for any object. CONCEPT maintains a library of profiles which can be assigned to any number of objects. This allows the percentage activation of the object to be defined for each hour of the day, for both weekdays and weekends. For more details on specifying an operational profile, see the Operational Profile Browser dialog box.
14  **EDITING NODES**

14.6  **Node Selection**

An object’s nodes can only be selected and manipulated individually when in node mode. You can enter this by double-clicking a selected object or pressing the F3 key. When in this mode, nodes in selected objects are highlighted with small red selection squares. Locked nodes are highlighted in grey.

If a particular node does not appear highlighted, then there are probably two nodes in that location. If an even number of highlighted nodes are drawn in exactly the same location, they will erase each other and no highlight will appear. This is an obvious way of determining if two nodes are coincident, however, it can cause some confusion in orthographic projections (a future version will resolve this).

Highlighted nodes can be selected and operations performed on them. Selected nodes appear dark grey within the bounding red or grey square. There are a number of ways to select and deselect nodes.

14.6.1  **Interactive Selection**

You can select nodes interactively with the mouse in the same way you select objects. When nodes are highlighted, clicking the mouse within the selection square selects that node. Clicking the mouse in an unoccupied area of the model displays a selection box that can be dragged over particular nodes. In the same way as selecting objects, holding down the Shift key toggles the selection state.

14.6.2  **Keyboard Selection**

In node mode you can select individual nodes from the keyboard using the PageUp and PageDown keys. These simply cycle through the highlighted nodes. The Shift key cannot be used here as Shift+PageUp and Shift+PageDown cycle through currently visible objects.

14.6.3  **Menu Selection**

In node mode, the All, None and Invert items in the Select menu all work with nodes instead of objects. All other selection-based items in this menu will revert to object mode and change the object selection set.

14.7  **Node Manipulation**

Individual or groups of nodes can be manipulated using the mouse or the keyboard.
14.7.1 Interactive Manipulation

Selecting and dragging a node moves or rotates it in exactly the same way as selecting and dragging an object. If more than one node is selected, the resultant movement vector applies to all of them. Once again, the *Shift* and *Control* keys can be used to change the cursor height interactively.

When moving nodes with a COPLANAR and INSIDE linkage, the application will not allow them to be moved outside of their parent object. Similarly, the nodes of planar objects are restricted to interactive movement in that plane. The exception to this is when a POINT or LINE snap setting shifts the node outside the plane. This is allowed as it is often quite useful when relocating a plane on a node-by-node basis.

14.7.2 Nudging or Keyboard Translation

Pressing the X, Y or Z keys whilst a node or group of nodes is selected will move them in the corresponding axis by an amount equal to the current snap grid setting. The cumulative amount of movement is indicated in the direct input area. Holding down the *Shift* key results in negative movement in each axis.

14.7.3 Direct-Input Translation

The effect of direct-input data depends on how many nodes are selected. If a single node is selected, the Direct-Input button changes to *Edit Node* and the actual coordinates of the node are displayed. Any entered values will be interpreted as absolute coordinates and change the node directly. You can still use relative coordinates in any of the fields by prefacing the entered value with the @ symbol. It should be noted that this method of translation overrides the planar restrictions of a node, allowing planes to be relocated on a node-by-node basis.

When a single node is selected, the help text in the status bar displays its ordinal number as well as the distance from the selected node to its next and previous nodes.

If more than one node is selected, the Direct-Input button changes to *Move* and the previous translation vector is displayed. You can move the selected nodes by typing in a relative translation vector.

14.7.4 Edit Node Dialog Box.

You can view and edit an individual node’s properties when in node mode by simply selecting the Edit Nodes item in the *Display* menu or using the toolbar. This invokes the *Edit Node* dialog box. This allows you to change particular details of the object linkage mechanism for individual nodes.
15 **MANAGING ZONES**

15.6 **Model Zones**

A zone is simply a group of objects that, together, create a clearly defined space within the building model. Conceptually, a zone is any area of similar internal conditions. In most cases the dominant conditions are thermal, however, zones may be based on other considerations such as acoustics or lighting. In some cases, it may even be appropriate to include entire buildings within a single zone when looking at site overshadowing.

Whilst a model can contain any number of zones, it will always contain an *Outside zone*. This is automatically created and cannot be removed or renamed. You can use this zone to store external objects such as fences, site boundaries, trees and external shading devices.

15.6.1 **The Current Zone**

Whenever an object is created, it is placed in the current zone. The current zone is either the last zone added or the last zone set as current in the *Zone Management* dialog box. The current zone is usually highlighted in black and shown at the top of the Information window. You can cycle the current zone through all visible zones using the *Ctrl+PageUp* and *Ctrl+PageDown* keys.

15.6.2 **Managing Zones**

Zone management is carried out using the Zone Management dialog box, invoked using the *Zones…* item in the *Edit* menu, the toolbar or by pressing *Alt+Z*. Use this dialog to *add*, *rename*, *delete*, *hide*, *condition* or *lock* zones.

15.7 **Adding a Zone**

New zones can be created in the following ways:

*Interactively Adding a Zone Object*

Zones can be added using the *Add Zone* item in the *Model* menu or directly from the toolbar. The new zone is named *Zone X*, where X is its ordinal number in the zone list. The new zone object, as well as its extruded walls and ceilings become members of the new zone.

*Adding a Parametric Zone*

The *Add New Object* dialog box allows you to create a rectangular zone by simply entering its length, width and height. The new zone floor object, as well as its child walls and ceilings are added to the new zone. Once again, the new zone is named *Zone X*, where X is its ordinal number in the zone list.
Extruding a Closed Planar Object

Whenever the Object Transformation dialog is used to extrude a closed planar object, you are prompted to create a new zone. Answering yes simple creates the new zone and adds the new objects to it.

Using the Zone Management Dialog

The Zone Management dialog box can be used to create a new empty zone.

15.8 Deleting a Zone

Whilst you can delete all of the objects in a zone interactively, you can only delete the zone itself within the Zone Management dialog box. Simply select the zone you wish to delete from the displayed list and press the Remove button.
16 **THE ELEMENT LIBRARY**

16.6 **How the Library Works**

The default element library (CONCEPT.LIB) is read into memory when CONCEPT first starts up. It contains some standard materials and building elements that can be customised at any time to suit your needs using HEATWIN. Whenever a model is saved, the elements currently in memory are saved along with the model. Thus, whenever a new model is loaded, its element library replaces the current library.

CONCEPT element libraries contain two lists, the first a list of material properties and the second a list of composite building elements constructed from one or more layers of these materials. The individual material properties are used by HEATWIN to determine the overall properties of the composite element.

CONCEPT only reads in and stores element properties. Thus, whilst you can create and edit materials within CONCEPT, all reference to their individual material components is lost. To create and edit materials within a material library, you must use HEATWIN.

As element libraries are completely customisable, and take up space within the model, you should know how to manage your libraries effectively. Library management is possible using the *Edit Element Library* dialog box, invoked by selecting the *Element Library*… item in the *Edit* menu or directly from the *Object Properties* dialog box. Within this dialog box you can selectively add, edit and delete elements.

16.7 **Element Types and Materials**

In order to increase the architectural knowledge base within the model, CONCEPT assigns each new object an element type. This is based on that object’s function within the building fabric and is used in spatial and performance-based calculations. The number and definition of different element types is reasonably dynamic. The following are currently defined for internal use by CONCEPT:

**VOID**

Void objects are the archetypal null object. They have no mass, do not restrict the flow of air, are completely transparent, and do not cast shadows. They are primarily used to create holes within other objects or as position holders and construction lines.
**ROOF**

A roof object is defined as an exposed planar surface that provides rain catchment for the building. It can be any shape and at any angle, however, its default surface normal is always chosen such that it points in an upward direction.

**FLOOR**

Floor objects define the boundaries of zones and, when summed, their surface areas determine the floor area of the building. In order to clarify the shadow display, it was decided that floors should not cast shadows. Otherwise, floors on the ground plane always shade themselves completely, obscuring any sun patches. The default surface normal of a floor object is always chosen such that it points in a downwards direction.

**CEILING**

Like roof objects, a ceiling object’s default surface normal is always chosen such that it points in an upward direction.

**WALL**

Wall objects represent the main structure of most buildings. They can be of any shape and at any angle.

**PARTITION**

Partition objects are basically internal wall objects. They are assumed to have no external exposure in heat flow calculations.

**WINDOW**

Window objects can exist as both individual and child objects. If you wish, a window object can even contain child windows of its own. They represent areas where air and light can enter a building.

**PANEL**

A panel object represents an area of different material within a larger object, such as a timber insert, for example.

**DOOR**

Door objects represent portals for access and egress. When inserted as library objects, they default to sitting at the bottom (minimum Z value) of the parent object.

**POINT**

A point object is a single-node entity. They are used primarily in acoustic calculation functions as point receivers at which the response of the zone is
calculated. When selected, it is possible to assign a radius to a point object (making it a sphere) using the Object Attributes dialog box.

**SPEAKERS and LIGHTS**

Speaker and light objects are simply vector sources emitting either sound or light. Vector objects have two nodes, the first defining the source position, the second its orientation.

**LINE**

Line objects represent cables or distance markers. When selected, it is possible to assign a radius to a line object (making it a cylinder) using the Object Attributes dialog box.

It is important to understand that literal element assignment is not paramount in an CONCEPT model. There are no absolute rules for the use of certain elements in certain parts of the building. Element types do have an effect on specific calculations, based on their properties as outlined above. However, you shouldn’t get too hung up on not being able, for example, to define an element type for a set of sloping stairs, or whether to make a balcony railing a wall or a partition. Other than the effects described above, it probably won’t make a difference anyway.
17 **LOCATIONS AND WEATHER DATA**

17.6 **Local Condition Data**

Practically all building performance calculations are dependant on local conditions at the site. Such parameters as sun position, solar radiation, rainfall, prevailing winds and external temperatures are fundamental to both the design and analysis of a building.

As this data is rarely available for every site, CONCEPT uses two different types of library file to specify local conditions, one containing location data, the other weather data. This allows positional information, which is readily available, to be specified independent of weather data, which is only available from localised weather stations.

17.7 **Location Data**

Location data consists simply of the latitude, longitude and time zone for a particular location. This, along with daylight savings information, is all that is required to determine solar position and calculate shadows. As a result, this data also affects thermal performance calculations by determining overshadowing and solar incidence angles.

On initial startup, CONCEPT defaults to PERTH in Western Australia (-32, 116 and +08:00). However, you can change this at any time using the *Solar Position* dialog box. This can be invoked from either the *Solar Position*... item in the *Calculate* menu or directly from the *Job Details* dialog box. Location data is also saved along with the model. As a result, you can change your default location on startup by simply saving your desired initial condition as a ZON file and adding its name at the end of the *Target* edit-box in the Shortcut you use to invoke CONCEPT.

17.8 **Weather Data**

Weather data consists of monthly statistics on temperature, rainfall, humidity, solar radiation daylight hours, etc. This is required for both lighting and thermal calculations. Unfortunately, accurate weather data only really exists for sites where there is a local weather station, and cannot readily be interpolated between sites. As a result, weather data has only been provided for a number of major towns and cities within Australia. With time, the list of sites for which this data is available will grow, so keep visiting the CONCEPT Web Site for updates.

You can select weather data sets using the *Weather Data* dialog box, invoked from either the *Solar Position* dialog or the *Thermal Performance* dialog.
18 SHADOW AND REFLECTIONS

18.6 Shadow Calculations

CONCEPT can calculate and display shadows for any complex geometry, at any time or date and at any location. Shadows are projected onto the ground plane or any number of planar surfaces using well established algorithms for determining sun position [Spencer 1965, Szokolay 1996]. Refined formulae for declination and the equation of time were included as per Carruthers, Roy and Uloth [1990].

Location data can be entered directly or selected from an extensive list of both local and international towns and cities.

18.6.1 Displaying Shadows

To display shadows, simply select the Shadows item in the Display menu or press Ctrl+F9. By default, CONCEPT displays the shadow of all visible objects on the ground plane. If more than one object is selected, shadows are projected only for those selected objects.

18.6.2 Shadow Information

When displaying shadows, the information window displays the current time and date, as well as a host of other information related to shadow projection such as the position of the sun and the sunrise/sunset times. If a single planar object is selected, the incidence angle, amount of incident solar radiation and the horizontal and vertical shadow angles for that object are also displayed. If the amount of incident radiation is zero, it is likely that you have not yet specified a weather data file.

18.6.3 Casting Shadows on Objects

As it is often just as important to analyse internal sun penetration as external shading, CONCEPT displays the geometric model in wireframe, meaning that all planes are shown as transparent. Therefore, it is necessary to be quite specific about which objects should receive shadows.

18.6.4 Tagging Objects as Shaded

You specify that an object or group of objects should receive shadows by first selecting them, and then choosing the Shaded Surface item from the Tag Object(s) As pull-right in the Select menu. Whenever this item is chosen, the set of currently selected objects become the only shaded surfaces. If no objects are selected, the shaded surface set is cleared.
You can add and subtract objects from the shaded surface set using the \textit{Object Properties} dialog box. Simply check or uncheck the \textit{Receives Shadows} checkbox in the \textit{Properties} group.

Only planar objects can actually receive shadows. When more than one object is tagged as shaded, shadows are still displayed on the ground in order for you to locate the sun, but only in outline. You can turn this off by unchecking the \textit{Display Ground Shadows} item in the \textit{Options} menu.

18.6.5 Changing the Time and Date

CONCEPT always works in local time, not solar time. You can set the local time and date directly using the \textit{Set Solar Position} dialog box, or by using the keyboard interactively. When the display is set to Shadows, the following keys allow you to interactively change solar position.

\textit{PgUp / PgDn}

These keys cycle through the time of day in 15 minute intervals, restricted to being between sunrise and sunset. As there will be times when the sun is very close to parallel with the ground plane, shadows may not appear at times very close to these extremes. Similarly, very long shadows that project far in front of the perspective picture plane may suffer some distortion. You can correct this by simply rotating the model such that the shadow projects away from the picture plane.

\textit{Shift+PgUp / Shift+PgDn}

These keys cycle the current date in 7 day intervals. Once again, if the current time is before sunrise or after sunset, it is modified to fit between this band.

18.6.6 Setting the North Point

By default, True North is taken to lie in the direction of the positive Y axis. This can be changed in the \textit{Set Solar Position} dialog box. This allows the effect of orientation to be determined whilst still benefiting from grid alignment.

\textbf{Note:} CONCEPT works only with True North. You must manually account for magnetic north if you wish to use that as your reference.

18.7 Reflection Analysis

Any planar object can be defined as a solar reflector. This simply means that the object generates both a shadow and a reflection patch. This patch is shown in white whenever
shadows are displayed. Just like shadows, reflection patches are calculated for each object tagged as receiving shadows, as well as the ground plane.

It should be noted that a solar reflector will still create a reflection even if it is fully shaded by the sun.

18.7.1 Tagging Objects as Solar Reflectors

You specify that an object or group of objects should reflect solar radiation by first selecting them, and then choosing the Solar Reflector item from the Tag Object(s) As > pull-right in the Select menu. Whenever this item is chosen, the set of currently selected objects become the only solar reflectors. If no objects are selected, the solar reflector set is cleared.

You can add and subtract objects from the solar reflector set using the Object Properties dialog box. Simply check or uncheck the Solar Reflector checkbox in the Properties group.
19 **OVERSHADOWING**

19.6 **The Stereographic Diagram**

Whilst it is possible to determine when a particular point on a site will be in shade using shadow analysis, a much more efficient method is to use a stereographic diagram. This allows the point’s shading profile for the entire year to be displayed in one clear image.

You can display a stereographic diagram by first selecting a single object and then choosing the *Stereographic Diagram*... item in the *Calculate* menu, which will display the *Stereographic Diagram* dialog box.

19.7 **Description**

Stereographic diagrams are used to represent the sun’s changing position in the sky throughout the day and year. In form, they can be likened to a photograph of the sky, taken looking straight up towards the zenith, with a 180° fish eye lens. The paths of the sun at different times of the year can then be projected onto this flattened hemisphere for the current location.

Building forms and other obstructions are shown as dark grey blocks. Whenever the plotted sunpath enters one of these blocks, the centre point will be shaded by the corresponding building. When the sunpath is not obscured by any grey block, then the centre point receives direct sun.

19.7.1 **Plotted Lines**

There are a number of different types of line shown on the stereographic projection. By understanding what each of these lines represent, you will be able to quickly read and interpret such diagrams, making them an extremely useful design tool.

*Azimuth Lines*

Azimuth angles run around the edge of the diagram in 15° increments. A point’s azimuth from the reference position is measured in a clockwise direction from True North on the horizontal plane. True North on the stereographic diagram is the positive Y axis (straight up the screen) and is marked with an N.

*Altitude Lines*

Altitude angles are represented as concentric circular dotted lines that run from the centre of the diagram out, in 10° increments from 90 to 0. A point’s altitude from the reference position is measured from the horizontal plane up.
Date Lines

Date lines represent the path of the sun through the sky on one particular day of the year. They start on the eastern side of the graph and run to the western side. There are twelve of these lines shown, for the 1st day of each month. The first six months are shown as solid lines whilst the last six months are shown as dotted, to allow distinction even though the path is cyclical.

Hour Lines

Hour lines represent the position of the sun at a specific hour of the day, throughout the year. They are shown as figure-8 type lines (Analemma) that intersect date lines. The intersection points between date and hour lines gives the position of the sun. Half of each hour line is shown as dotted, to indicate that this is during the latter six months of the year.

19.7.2 Partial and Complete Shading.

True stereographic diagrams can only be calculated for a single point. This is because the point is either in shade, or it isn’t. For larger objects, they can be partially shaded. With an object of complex shape, it is quite difficult to display areas of partial and complete shading on the diagram. Thus, when the selected object that is the subject of the stereographic diagram is not a single point, the diagram is generated from, and is only valid for, its geometric centre.
20 INCIDENT SOLAR RADIATION

20.6 Solar Exposure

There are quite a few situations in which a measure of the amount of solar radiation falling on particular surfaces is useful. These range from sizing solar collectors to an objective measure of the effect a proposed building may have on a neighbour’s solar access rights.

You can calculate incident solar radiation using the Solar Exposure dialog box, invoked using the Solar Exposure... item in the Calculate menu.

20.7 Calculating Solar Radiation

Solar radiation calculations require that you have already selected a weather data file. Hourly direct and diffuse radiation values are stored within the weather data at each location for each day of the year. Incident radiation is calculated from beam and diffuse values as per Szoklay [1987].

20.7.1 Optimising Tilt Angles

When calculating the amount of solar radiation incident on a particular object over an entire year, CONCEPT displays the maximum summer and winter solar altitudes of the sun when it is directly in front of that object. If the object faces directly north, this is equal to the maximum solar altitude for that location.

In addition to these maximum altitude angles, it also shows the optimum tilt angle of the selected plane. This is calculated based on annual totals, accounting for incidence angles when the sun is higher in the sky compared to when it is lower in winter. This is set to 12.5° less than the maximum altitude angle. The truly optimum angle may vary slightly depending on the angular difference between the seasonal altitude maximums as well as variations in solar radiation. The optimum angle normally occurs somewhere between 10 and 15 degrees less than the maximum summer solar altitude.

20.7.2 Sizing Photovoltaic Arrays or Solar Heating Systems

If you know the efficiency with which a particular heating system or set of photovoltaic cells converts radiant energy to electrical or heat energy, you can quickly multiply this by the incident radiation over any period to calculate its output.

If you create and measure a simple 1m square plane at the desired position and tilt angle, you can quickly determine the size of the required panel by dividing the required output by the actual output of the test square. This gives the required surface area in m² to provide the required output.
20.7.3 Percentage Window Shading

As all calculations of incident radiation involve a determination of exactly how much a particular object is in shade, a percentage shading value is displayed with all calculations. Annual and monthly percentage shading values are averages of all the percentage shading values worked out over the calculation period.

20.7.4 Percentage Visible Sky

If you select a POINT object instead of a plane, CONCEPT calculates the percentage of the sky visible from that point instead of the percentage shading. This only works for instantaneous radiation calculations as it does not change over time.
21 SHADING DEVICE DESIGN

21.6 Solar Shading

Shading devices can be designed in three ways within CONCEPT. The first and most obvious is by trial and error, creating and modifying shades interactively whilst monitoring their effect. The second way is to automatically generate shades for a selected window object based on a set of parametric information. The third way is to cut a profile of the sun path through a group of selected planes and modify them to fit.

21.6.1 Interactively Designing Shades

The shading effect of any and all objects within a model can be quickly and easily displayed. Whenever an object is modified, its shading effect is quickly recalculated when the display is updated. Thus, by creating and modifying a set of individual shading planes, it is possible to effectively design a complex shading system in a very short space of time.

21.6.2 Parametric Shading Devices

Using the Optimised Shading Design dialog box it is possible to generate a number of different types of shading device optimised for a particular window and time of year. This way shades can be designed to completely shade a selected window from, for example, the 13th of September to the 1st of April, from 9am in the morning to 5pm at night. You can invoke this dialog by first selecting the window you wish to shade and then choosing the Shading Device... item in the Calculate menu.

21.7 Cutting Solar Profiles

Cutting a solar profile simply means creating a new line object by projecting the sun’s path through the sky onto a planar object. This represents the line within that plane that will perfectly shade the selected point throughout the day. This is useful if you wish to determine the exact profile of a shade for a specific date.

For this to be possible, you need one or more planes to cut and a focal point which, when joined to the sun by a straight line, represents the cutting edge. The focal point for this calculation is the current About Point. You can set this to a new location using the toolbar or by choosing the About Point item in the Select menu.

To successfully cut a solar profile you must:

1). Set the desired date for the cut using the Solar Position dialog.

2). Move the About Point into the desired position.
3). Select the planes you wish to cut.

4). Choose the Cut Solar Profile item from the Calculate->Shading menu.

The profile that results can be used to shape the planes that it cuts such that they shade the About Point exactly for the specified date. If a new line does not appear, it is likely that the sun’s path does not cut the selected planes. If this is the case, either move the About Point or extend the selected planes in length.

Using this method to shade a window requires successively setting the About Point to each of the windows lowest nodes and cutting a profile for each. Once a profile for each important node has been cut, simply align the nodes of the shade planes with the profile point that is furthest from the window.

**TIP:** Holding down the Control key when this item is selected cuts a yearly profile. This is defined as the sun’s position at the currently selected time for each day of the year. This will appear as an elongated figure 8 which is known as an analemma. This is the line that will shade the selected point at that exact time every day of the year.

### 21.8 Sun Planes

It is sometimes useful to be able to extrude an object such that it points directly at the current sun position. This is especially useful in a city like Sydney where building heights are restricted by sun access planes that protect the right to light of public places and heritage buildings.

To successfully extrude an object towards the sun:

1). Set the desired solar position by date/time using the Solar Position dialog.

2). Select the objects you wish to extrude.

4). Choose the Extrude Towards the Sun item from the Calculate->Shading menu.

### 21.9 A Sun’s Eye View

When designing complex shading devices, it is often useful to be able to view exactly what a shade will cover at different times of the year. This can be done quickly by viewing the model from the current sun position.

As the sun’s rays are almost parallel, the view from the sun is orthographic. Thus not only is the eye point moved, the nature of the perspective display is also affected.
To successfully view the model from the current sun position:

1). Set the desired solar position by date/time using the Solar Position dialog.

2). Choose the Shadows item from the Display menu.

3). Choose the View from Sun item from the Calculate->Shading menu.

To reset the perspective display, select Standard as the Perspective Zone setting in the Display Setup dialog box.
22  THERMAL PERFORMANCE ANALYSIS

22.6 Thermal Simulation Engine

CONCEPT implements the Admittance Method for calculating internal temperatures, as specified in the CIBSE Guide and outlined in Steve Szokolay’s *Thermal Design of Buildings*. This is a steady state solution to the problem of dynamic heat flow and, as such, is very quick to calculate but lacks the precision of more computationally intensive techniques such as the response factor and finite difference method used in dedicated thermal analysis packages such as TAS, ESP2 and DOE2.

However, for purposes of conceptual design and analysis, this method is more than adequate. In fact, the overshadowing and direct solar radiation calculation routines used within CONCEPT are generally much more accurate than those used in these thermal analysis packages as they are based on the detailed and exact geometry of the building, not solely on surface area and orientations.

22.7 Thermal Calculations

CONCEPT performs two different types of thermal calculation, internal temperature prediction and heat load estimation. The calculation methods used for each type are slightly different as internal temperatures are based on fluctuations about a daily mean whilst heat loads are based on absolute losses and gains for a fixed thermostat setting.

Both of these calculations are dependant on pre-calculated volumes and inter-zonal adjacency values. This means that zone volume and the surface areas of any overlapping elements in adjacent zones, as well as the exposed area of external surfaces, is calculated and stored on disk prior to thermal analysis. This calculation is automatically performed when required and is characterised by yellow sampling rays and the progressive white dots used to highlight areas of adjacency. Pre-calculating this information is important as it is referred to quite often during different stages of the thermal calculation process.

22.7.1 Hourly Temperatures

The calculation of internal temperatures requires hourly weather data and thermal performance details of materials used in the model. These are automatically included within the distributed location (LOC) and material library (LIB) files.

Internal temperatures calculations include the following effects:

- *Conduction loss* through the building fabric,
- *Direct and indirect solar gains* through transparent and opaque materials,
- Global ventilation rates due to vents and envelope leakage,
- Internal gains from sporadic and scheduled heat sources,
- Inter-zonal gains from adjacent spaces,
- Air-Infiltration through the building fabric.
- Ventilation through open windows.

Accurately accounting for losses and gains from adjacent zones requires an iterative solution as the effects are bi-directional between zones. This requires a multi-stage calculation, the first neglecting any inter-zonal gains to determine an initial temperature for each zone. Subsequent stages are then an iterative process of temperature resolution, each iteration updating the hourly internal temperature of each zone until the maximum difference between any new temperature value is less than 0.1 of a degree from the previous.

Given that adjacency and exposure values are pre-calculated, hourly incident solar radiation values are calculated and stored for each exposed surface as part of the first stage. As this is a steady state calculation based on the admittance, thermal lag and decrement of materials, no preconditioning of spaces is required. However, in order to more accurately accommodate long thermal lags for both internal and external zone divisions, CONCEPT calculates temperatures from two days in advance of the current day. The 1st and 2nd of January therefore use temperature and radiation values from December 30 and 31.

### 22.7.2 Temperature Distribution

In order to determine the overall performance of a passively designed building, it is possible to calculate the frequency distribution of internal temperatures for each zone throughout the year. This is shown as a graph of internal temperature (in °C bins) vs the number of hours those during the year those temperatures occurred within the zone.

The overall distribution curve can be compared against the curve of outside air temperature to determine the relative performance of the space. An ideal shape for these curves is as ‘Bell’ curve (normal distribution), centred within the specified comfort band and with the smallest temperature range.

### 22.7.3 Annual Heat Gains

As a further analysis tool, it is possible to display the relative effects of fabric, solar, ventilation and internal gains on the overall heat losses or gains within the zone. This is displayed as a coloured diagram or contour map showing the average hourly effect during each month of the year.

Using these diagrams, it is possible isolate the effects of each component and optimise the design so that these occur at the right time of the day and year.
22.8 Heating and Cooling Loads

The calculation of heating and cooling loads require an upper and lower thermostat settings. The underlying premise is that when internal environment temperatures fall outside this range, conditioning is used to make up any losses and gains, thereby maintaining internal comfort. Heating loads then occur only when the air temperature is below the lower thermostat setting and the zone is experiencing a net heat loss. Similarly, cooling loads occur only when the air temperature is above the upper thermostat setting and the zone is experiencing a net heat gain.

Heat loads are calculated only for those zones marked as conditioned in either the Zone Management or Thermal Performance dialog boxes.

Options within the Thermal Performance dialog box allow for a quick approximation. As the calculation of incident solar radiation is the most time-consuming component, the quick approximation uses monthly average solar radiation values based on the method given by Szokolay in *Thermal Design of Buildings*. Thus only one 24hr solar calculation is performed on the 15th of each month, with those averaged values used for each day of that month.

22.9 Energy Costs

An energy costs for heating and cooling can be specified in the Model Settings dialog box. Given as a flat rate per kilowatt hour, this allows some assessment of potential operational costs.
23  **NATURAL AND ARTIFICIAL LIGHTING**

23.6  **Daylight Factor Calculations**

CONCEPT implements the Building Research Establishments (BRE) split flux method for calculating the percentage of direct and reflected natural light reaching points within the model. The direct and externally reflected components are determined geometrically whilst the internally reflected component is calculated from the BRE formula.

The *Daylight Factor* itself represents the percentage of natural light available from an overcast sky that is visible from a specified point within a building. An unobstructed view of the sky would result in a 100% daylight factor. This factor considers the contribution of internally and externally reflected light.

If the design illuminance of the sky at the current location is known, natural light levels can be displayed as a lux value representing the Design Sky illuminance multiplied by the Daylight Factor.

23.6.1  **Sky Factor**

The *Sky Factor* is the percentage of the actual sky visible from a particular point. This value does not consider any reflected component in any form.

23.7  **Artificial Lighting Calculations**

CONCEPT uses the Point-By-Point method for determining artificial light levels within an enclosure. This simple calculates the sum of contributions from all light sources visible from the measurement point.

The contribution of diffuse light can be determined by sampling the illuminance of all surfaces visible from the measurement point and summing their contribution. This is a trial method and is not fully implemented in this release.

The lighting levels produced using these algorithms are to be used as a guide only, as they are intended for use as a relative scale to measure the effect of model changes.

23.8  **Radiance Output**

For more accurate and comprehensive lighting analysis, CONCEPT outputs *Radiance* data for direct input into the *Radiance* lighting simulation package written by Greg Ward at Lawrence Berkley Laboratories. This is a very accurate simulation tool that is available as
public domain software. CONCEPT includes support for the automatic generation of material data and control files (RIF files) as well as various CIE sky models.

To output a set of RAD files, select Export… from the File menu and select Radiance model as the type of file.
24 Reverberation Times

24.6 Statistical Acoustics

Statistical reverberation times are still a major design tool used by architects and acousticians alike. In order to design for good acoustics, you need to know a little about sound behaviour.

24.6.1 Sound Behaviour in Rooms

When a source begins generating sound within a room, the sound intensity measured at a particular point will increase suddenly with the arrival of the direct sound and will continue to increase in a series of small increments as indirect reflections begin to contribute to the total sound level. Eventually an equilibrium will be reached where the sound energy absorbed by the room surfaces is equal to the energy being radiated by the source. This is because the absorption of most building materials is proportional to sound intensity, as the sound level increases, so too does the absorption.

If the sound source is abruptly switched off, the sound intensity at any point will not suddenly disappear, but will fade away gradually as the indirect sound field begins to die off and reflections get weaker. The rate of this decay is a function of room shape and the amount and position of absorbent material. The decay in highly absorbent rooms will not take very long whereas in large, reflective rooms, this can take quite a long time.

This gradual decay of sound energy is known as reverberation and, as a result of this proportional relationship between absorption and sound intensity, it is exponential as a function of time. If the sound pressure level (in dB) of a decaying reverberant field is graphed against time, one obtains a reverberation curve which is usually fairly straight, although the exact form depends upon many factors including the frequency spectrum of the sound and the shape of the room [cf: Diagram 2].

24.6.2 Reverberation time

Wallace Sabine carried out a considerable amount of research in this area and arrived at an empirical relationship between the volume of an auditorium, the amount of absorptive material within it and a quantity which he called the Reverberation Time (RT).

As defined by Sabine, the RT is the time taken for a continuous sound within a room to decay by 60 dB after being abruptly switched off and is given by;

\[ RT = \frac{(0.161V)}{A} \]
where $V$ is the volume of the enclosure ($m^3$) and $A$ is the total absorption within the enclosure (sabine). The term $A$ is calculated as the sum of the surface area ($m^2$) times the absorption coefficient of each material used within the enclosure.

The absorption coefficient of any material, as originally defined by Sabine, is the ratio of the sound absorbed by that material to that absorbed by an equivalent area of open window. Thus a perfectly absorbent material would have an absorption coefficient of 1 and an absorption unit of 1 sabine represents a surface capable of absorbing sound at the same rate as 1$m^2$ of open window.

Such a formulation is particularly useful as it starts to recommend the most effective volume of rooms for particular reverberation times. Given that we know the range of values of RT for specific purposes, we can determine a relationship between room volume and internal surface area. From this ratio, and the fact that each member of the audience increases the amount of absorption in the auditorium, volumes of rooms can be specified in metres cubed per person, which is a very useful figure at the initial stage of design.

24.6.3 Improving Accuracy

For fairly reverberant rooms with a uniform distribution of absorptive material, Sabine's formula gives a good indication of the expected behaviour. This is because Sabine assumes the sound decays continuously and smoothly, a situation requiring a homogenous and diffuse sound field without great variation in room surfaces. As the absorption in a room is increased, however, the results obtained by this formula become less accurate. In the limiting case of a completely dead room (an anechoic chamber), where the absorption coefficients of the boundaries are 1.0 and the reverberation time should obviously be 0.0, Sabine's formula results in a finite RT.

Several different approaches have been used to derive equations which give values of reverberation time in better agreement with measured results from less reverberant rooms. One of these, the Norris-Eyring formula, assumes an intermittent decay with the arrival of fewer and fewer reflections. This gives the following formula;

$$RT = \frac{(0.161V)}{\left(-S \ln(1 - a)\right)}$$

where $S$ is the total surface area ($m^2$) and $a$ becomes the average absorption coefficient. This equation gives the correct value of 0.0 for a completely dead room but is more complex and only strictly valid for rooms with the same value of $a$ for all surfaces.

When the materials of a room have a wide variety of absorption coefficients, the best predictions are obtained by the Millington-Sette equation. This is simply a matter of substituting an effective absorption coefficient $a_e = -\ln(1-a)$ into Sabine's equation to give;
\[ RT = \frac{(0.161V)}{(S - s_i \ln(1 - a_i))} \]

where \( s_i \) is the surface area of the \( i \)th material and \( a_i \) its actual absorption coefficient.

*Note:* This formula indicates that highly absorbing materials are far more effective than would be anticipated in influencing the reverberation time. For example, when the actual absorption coefficient is greater than 0.63, the effective absorption coefficient is greater than one.

### 24.6.4 Method Selection

When calculating reverberation time values for zones, CONCEPT automatically determines and displays the best method to use based on the distribution of absorbing materials.

### 24.6.5 The Validity of Statistical Formula

It is clear that all of the equations described so far are purely statistical in nature and, as such, neglect all of the geometric information about the room (its shape, the position of absorbing materials, the use of reflectors, etc). Thus, whilst they can closely indicate the reverberation time, they cannot be used to predict any acoustic anomalies within a room, such as discernible echoes and acoustic shadowing. For this, *Acoustic Raytracing* analysis is required.
25 **ACOUSTIC RAYTRACING**

25.6 General Overview

Geometric acoustic raytracing is an extremely important tool in the acoustic design of any enclosure. As the basic geometry of any space is fundamental to its acoustic performance, geometric acoustics has a serious role to play at the conceptual stages of any design.

To extract as much information as possible from the model, CONCEPT uses acoustic rays in two separate ways, to determine the impulse response of the room using the image method, and to inform the shape of the enclosure using sprayed rays.

25.7 The Image Method and Distributed Rays

The image method is an exhaustive algorithm for calculating all possible reflection paths between a sound source and any number of point receivers. It does this by calculating the virtual image positions of the source when reflected about every plane within the enclosure. This can be done for any depth of reflection, however the calculation time increases exponentially with reflection depth. As a result, for most enclosures a maximum reflection depth of 4 or 5 is usually sufficient.

25.7.1 A Hybrid System

When set to 4 or 5, the image method does not represent late reflections well. Thus CONCEPT implements a hybrid system that generates rays either spherically or randomly and performs more traditional acoustic raytracing on them.

If a ray passes relatively close to a receiver point, then there is a significant likelihood that another ray exists that reflects off the same set of planes, but passes exactly through the centre of the receiver point. The image method algorithm is then used to generate and validate this likely ray. Using this method, it is possible to generate thousands of reflected rays up to a depth of 32 or more reflections in a relatively short space of time.

In contrast to the image method, that calculates all possible reflection paths up to a set reflection depth, the Hybrid Image Method is not exhaustive and only returns sample rays of any depth. These late reflections are, however, extremely important in the analysis of the late arriving sound field and can be used to quickly isolate echoes and other such acoustic anomalies.

25.7.2 Selecting Source and Receiver Points

Whenever a raytracing calculation is begun, it first checks for tagged sound source and receiver point objects. If either is not found, it searches through the model looking for the
first visible SPEAKER object and tagging all visible POINT objects as receivers. To specify a particular source or set of receiver points, select the new source object or set of points and choose the appropriate Tag Object(s) As > item in the Select menu.

25.7.3 Radius of Influence

The radius of influence of receiver points is the main factor in how long the Hybrid Image Method calculation will take to run and how many rays it will find. A large radius, compared to enclosure size, will result in every generated ray segment being tested against every receiver point. It is usual to set this radius to approximately 10% of the enclosure dimensions. The radius of influence of receiver points is set in the Preferences dialog box, as is the maximum number of receivers in the points list.

25.7.4 Tagging Acoustic Reflectors

It is possible to tag specific objects as acoustic reflectors. When the Test acoustic reflectors only checkbox is ticked, only tagged planes will reflect rays. This can be used to speed up calculations and focus only on important surfaces. To tag a plane or set of planes as acoustic reflectors, first select those planes you wish to tag and then choose the Acoustic Reflector item in the Tag Object(s) As > pullright in the Select menu.

25.7.5 Raytracing an Enclosure

To run the combination of Image and Hybrid Image methods on an enclosure, you should create a SPEAKER and at least one POINT object in the zone you are interested in. Only visible zones are included in raytracing calculations so you should also turn off those zones you are not interested in to speed up the calculation. Finally, choose the Image Method... item in the Calculate menu to display the Trace Acoustic Rays dialog box.

You can use the Hybrid Image Method exclusively by choosing the Distributed Rays... item in the Calculate menu to display the Hybrid Image Method dialog box. This provides a number of further algorithms and controls for generating rays.

25.8 Spraying Rays

Spraying rays around an enclosure can be an extremely useful way of shaping walls and other surfaces to reflect a sound source to its maximum effect. To spray rays you will need both a SPEAKER and at least one POINT object visible in your model. You can then invoke the Spray Rays dialog box using the Sprayed Rays... item in the Calculate menu.

Rays are sprayed in a circular disk centred at the source point and in the direction of the source vector. Both the angular distribution and rotation of the disk can be set, as can the density of rays. Whenever an object is moved or edited in the model, including the source,
the sprayed rays are automatically updated. Thus the source can be moved around or a reflector rotated by trial and error until the optimum angle is found. You can also tag specific planes as acoustic reflectors (see above) to focus in on their effect.

25.9 The Concept of Sound Rays

If one assumes that the dimensions of a room are large compared to wavelength, then sound waves may be considered in much the same way as light rays when treated in optics. This situation frequently occurs in architectural acoustics, especially in large auditoria. To continue the light analogy, sound rays are reflected from hard planar walls in accordance with the laws of reflection, i.e.: the incident ray, the reflected ray and the normal to the surface all lie on the same plane and the angle of incidence is equal to the angle of reflection. In the same way, sound rays incident on a curved surface will be either focussed (for concave) or dispersed (for convex).

The concept of a sound ray and the geometrical study of sound ray paths play an important role in the design of large rooms and auditorium, enabling troublesome echoes and flutter effects to be detected and dealt with at the design stage. A limitation of the geometrical approach is that usually only primary and possibly secondary reflections can be studied before the sound ray being followed becomes 'lost' in the reverberant or late-arriving sound field. Also, the dimensions of most enclosures relative to the wavelengths of sound mean that geometric acoustics is only really valid for frequencies of 500 Hz and above.

25.9.1 Using Geometric Acoustics

Statistical methods are useful at the earliest stages of design, however, they are quite limited in their capacity to predict acoustic faults. This is because most faults result from the geometry of the enclosure. A simple geometric analysis done on the drawing board can easily correct most of these at the earliest stages of design. As the design develops, more and more geometric information becomes available so why not use it.

Architects and building designers need to be able to determine not only how much absorber to use, but what type of absorber and where to best put it. This is where the consideration of reflected sound rays can be very useful.
26  **ENVIRONMENTAL IMPACT AND EMBODIED ENERGY**

The concepts of environmental impact and embodied energy are still relatively new. As a result, there is a significant amount of information available, but no real standard for the definition of an accepted index or its application to the analysis of buildings.

Having said that, there is sufficient information to be able to determine what form an accepted index will take and what results are required. Thus, rather than ignore such analysis, provision for an environmental impact index and embodied energy rating has been included within CONCEPT. This allows its use where detailed information is available.

26.6  **A Bridge Between Design and LCA**

CONCEPT material data structures allow both initial energy and ongoing maintenance energy values to be input. These are linked to actual objects via a cost/m², cost/m³ or cost/unit basis. Thus, if embodied energy or life cycle information is available for the materials used, it can be input and evaluated as the design progresses.

To fully integrate LCA analysis into CONCEPT is at least a couple of years off. However, in its current form, it is intended to serve as a geometric spreadsheet, summing up the surface area, volume and weight of materials used in the fabric of the building. This data can then be output to LCA software or a simple spreadsheet and compared.

26.7  **Greenhouse Gas Emissions**

Similarly, data for the greenhouse gas content/emission of many building materials is becoming available. Thus, there are facilities in the material data structure to specify both initial and ongoing emissions for the building fabric.
27 **MATERIAL COSTS ESTIMATION**

Material costs are part of each elements material data. As a result, cost schedules can be easily produced for the building as a whole, for individual zones or by materials type. These are available in the *Calculate* menu.

Element costs can be specified on a per square metre, per cubic metre basis or as a one off cost per item. This allows significant flexibility when building in safety factors or incorporating unique components.

In addition, maintenance costs are also allowed for as well as lifespan information for future replacement costing.
28  **FILE FORMATS**

28.6  **Binary and ASCII Files**

Binary files contain only a series of numbers that are machine readable and make no sense when viewed directly. ASCII files, however, contain text that is usually meaningful to the user and can be displayed in a text editor. CONCEPT uses both types of file to store model data.

28.7  **Binary Files Used By CONCEPT**

28.7.1  **ZON Files (*.zon)**

The native model file used to store CONCEPT models is the binary ZON file. This contains building model data, materials definitions, calculation results, acoustic rays if generated, and current date, time, location and view settings. The ZON file does not store climate data as this is quite large, however, it does store a reference to the climate data file and the specific climate index.

28.7.2  **LIB Files (*.lib)**

LIB files are binary files containing libraries of material data. LIB Files contain two sections, the first containing raw material data and the second containing the details of composite constructions made up from those materials. CONCEPT only reads the second section. You can import materials into a zone from a LIB file.

28.7.3  **LOC Files (*.loc)**

LOC files are binary files used to store location and climate data. They can contain any number of locations, including monthly summaries and hourly data for the entire year.

28.7.4  **3DS Files (*.3ds)**

3DS files are a popular binary format for storing 3D material and geometry data. Originating from the early 3D Studio Rendering software, these files are now supported by many commercial and public domain programs, including AutoCAD r13 and r14. 3DS files are the preferred method of transferring 3D models from AutoCAD to CONCEPT. For more details on the use of 3DS files, refer to the 3DS File Translation section.

28.8  **ASCII Files Used By CONCEPT**

For maximum flexibility, some CONCEPT files are saved in ASCII format and make use of tokens to indicate data. A token is simply a recognised string ending with a full colon. This
allows other text to be placed anywhere within the file as long as it is not between a token and its data.

The usual comment characters ( #, /*, */ and // ) are also recognised. The # and // characters indicate that the rest of that particular line should be ignored. The /* and */ symbols, however, indicate that all characters between them should be ignored, regardless of the number of carriage returns encountered.

28.8.1 MOD Files (*.mod)

The MOD file is an ASCII version of the ZON file, designed for displaying and printing model geometry as well as for compatibility between different releases. Below are example zone and object entries. You can edit these files manually if you dare.

ZONE {
    name:  Zone 1
    flags: 5187
    maxtemp: 24.000
    mintemp: 21.000
    heat: 0.000
    vent: 100.000
    volume: 76.020
    precision: 0
    axis: 0
    seating: 0
    percentage: 0
    type: 0
}

ENTITY {
    flags: 21612
    zone: Zone 1
    vector: 0.000 0.000 2400.000 0
    vertex: 7900.000 2400.000 0.000 0
    node: 0 1.000 0 -1
    vertex: 12900.000 1700.000 0.000 0
    node: 0 1.000 0 -1
    vertex: 14200.000 6900.000 0.000 0
    node: 0 1.000 0 -1
    vertex: 6600.000 7200.000 0.000 0
    node: 0 1.000 0 -1
    link: -1
    element: 2
    material: 5
    overlap: 5
    equation: 0.000x + 0.000y + 1.000z + 0.000
    area2: 31.500
    axis: 0
}
28.8.2  RAY Files (*.ray)

RAY files are ASCII files used to store geometric acoustic rays separately from the model file. This allows ray information to be displayed or printed as well as allowing archives of various alternative arrangements. Below are example header and ray entries, altitude and azimuth angles are in radians.

HEADER {
  model: c:\temp\examples\hall.zon
  source: -3700.000 10000.000 2250.000 0
  checksum: 1259596.125
  gridpts: 9
  gridpt: 2100.000 12300.000 2700.000 0
  gridpt: 5597.912 15548.867 1200.000 0
  gridpt: 9732.560 17053.756 2000.000 0
  gridpt: 12081.791 17908.807 5800.000 0
  gridpt: 17250.100 19789.918 9400.000 0
  gridpt: 6400.000 11000.000 1200.000 0
  gridpt: 10800.000 11000.000 2000.000 0
  gridpt: 16100.000 11000.000 2600.000 0
  gridpt: 18800.000 11000.000 9400.000 0
  radius: 1000.000
  level: -66.630
  delay: 889.280
  rays: 534
  imgdepth: 3
  trcdepth: 20
  depth: 3
  freq: 5
} 

RAY {
  grid: 1
  depth: 1
  bound: 1 end
  distance: 16.192
  level: -2.032
  delay: 15.490
  azi: -1.109
  alt: -0.032
}

RAY {
  grid: 2
  depth: 1
  bound: 1 end
  distance: 19.148
  level: -1.283
  delay: 11.587
  azi: -0.870
  alt: -0.003
}
28.8.3 POS File (*.pos)

POS files are ASCII files used to store positional information for towns and cities. They store only the name, latitude, longitude and reference time zone for each position. You can create or edit these files using any text editor as their format is quite straightforward. All values are in degrees. The REF value is simply the longitude of that location’s timezone.

# FORMAT: NAME LAT. LONG. REF.
Location: PERTH_WA -32.5 116.0 120.0
Location: Albany_WA -35.0 118.0 120.0
Location: Broome_WA -18.0 122.5 120.0
Location: Carnarvon_WA -25.0 114.0 120.0
Location: Esperance_WA -34.0 122.0 120.0
Location: Geraldton_WA -29.0 115.0 120.0
Location: Kalgoorlie_WA -31.0 121.5 120.0
Location: PtHedland_WA -20.0 121.0 120.0
Location: Wiluna_WA -27.0 120.0 120.0
Location: Wyndham_WA -16.0 128.0 120.0

28.8.4 DXF Files (*.dxf)

DXF files are ASCII Drawing Exchange Files originating from an ASCII AutoCAD format. These are, by default, almost an industry standard for the transfer of 2D CAD information. Nearly all CAD applications can read and write these files. For more details on the use of DXF files, refer to the DXF File Translation section and the For more details, see the DXF Output dialog box.

To create a DXF file, select the Export... item from the File menu and select files of type ‘AutoCAD DXF File’. To import a DXF file, select the Import... item from the File menu and select files of type ‘DXF File’. The following is an example of what a DXF file may contain.

999
THIS_IS_A_DXF_FILE
0
SECTION
2
ENTITIES
0
POLYLINE
8
Outside
62
0
66
1
10
0.000000
20
0.000000
30
28.8.5 RAD Files (*.rad)

RAD files are ASCII files containing RADIANCE primitives. RADIANCE is a public domain radiosity-base lighting simulation program written by Greg Ward at Lawrence Berkley Laboratories. RAD file output from CONCEPT is quite sophisticated, producing both RAD and RIF files if required. For more details, see the RADIANCE Output dialog box. A useful front end to RADIANCE (RadTool.exe) is also included in this CONCEPT release.

To create a RAD file, select the Export... item from the File menu and select files of type ‘Radiance Scene File’. The following is a small sample of a RAD file.

```plaintext
# Material definition.
vvoid plastic DblBrickWall_Plastered
  0
  5  0.965 0.965 0.965 0.00480 0.00000

vvoid plastic ConcreteFloor_Tiles
  0
  5  0.753 0.753 0.753 0.05600 0.00000
```
# Plane definition.
ConcreteFloor_Tiles polygon zone02.rad00000
0
0
15
2.30000 2.50000 0.00000
2.20000 7.80000 0.00000
13.10000 6.90000 0.00000
13.30000 1.00000 0.00000
2.30000 2.50000 0.00000

DblBrickWall_Plastered polygon zone02.rad00001
0
0
12
2.30000 2.50000 0.00000
2.30000 2.50000 2.40000
2.20000 7.80000 2.40000
2.20000 7.80000 0.00000

DblBrickWall_Plastered polygon zone02.rad00002
0
0
33
2.20000 7.80000 0.00000
2.20000 7.80000 2.40000
13.10000 6.90000 2.40000
13.10000 6.90000 0.00000
6.75305 7.42406 0.60000
6.75305 7.42406 1.80000
8.54695 7.27594 1.80000
8.54695 7.27594 0.60000
6.75305 7.42406 0.60000
13.10000 6.90000 0.00000
2.20000 7.80000 0.00000

#LightMarker:
Spotlight_Aimed polygon zone02.rad00007
0
0
9
4.30000 5.80000 2.30000
4.30000 6.80000 2.30000
3.55000 5.80000 2.30000

# Sky definition.
!gensky 4 1 12.00 +s -a -32.000 -o 116.000 -m 120.000

skyfunc glow sky_mat
0
0
4
1 1 1 0

sky_mat source sky
0
0


28.8.6 VRML World Files (*.wrl)

VRML is an emerging standard for the description of 3D geometry. There are quite a few public domain VRML viewers and plug-ins for web browsers. These are an excellent tool for interactive walk-thru presentations as well as visually checking your model.

You can automatically create and view a VRML file using the As VRML Scene... item in the Display menu. This requires that you have a VRML viewer installed on your machine. The most common viewer is the CosmoPlayer plugin from Silicon Graphics available for both Internet Explorer and Netscape. The first time you select this item, you will be asked to find your VRML viewer. Simply locate and select the netscape.exe or iexplorer.exe files. To change your viewer, hold down the CONTROL key whilst selecting this item.

To create a VRML file, select the Export... item from the File menu and select files of type ‘VRML World File’. The following is a small sample of a VRML file.

```vrml
#VRML V1.0 ascii

ShapeHints {
  shapeType UNKNOWN_SHAPE_TYPE
  vertexOrdering UNKNOWN_ORDERING
  faceType UNKNOWN_FACE_TYPE
}

DirectionalLight { # Solar Position.
  direction 70933897216 -65362120704 114351800320
  intensity 1.0
}

Group { # First_Zone.

  Material {
    diffuseColor 1.000 0.000 0.000
    transparency 0.000
  }
```

```
shininess 0.200
}

Coordinate3 {
  point [
    -57.074 144.718 -63.064,
    -25.031 143.096 -58.125,
    -28.938 98.917 -17.875,
    -26.094 98.027 -16.750,
    -27.344 84.574 -4.500,
    -62.781 84.644 -8.375,
  ]
}

IndexedFaceSet { # 0001.
  coordIndex [ 0, 1, 2, 3, 4, 5 ]
}

Material {
  diffuseColor 1.000 0.000 0.000
  transparency 0.000
  shininess 0.200
}

Coordinate3 {
  point [
    -57.074 144.718 -63.064,
    -52.688 186.576 -101.125,
    -48.983 186.356 -100.525,
    -8.142 149.846 -62.523,
    -9.375 137.049 -50.875,
    -20.531 136.968 -52.000,
    -19.875 142.884 -57.375,
  ]
}

IndexedFaceSet { # 0002.
  coordIndex [ 0, 1, 2, 3, 4, 5, 6 ]
}

28.8.7  **POV-Ray Files (*.pov)**

POV files are used by POV-Ray, a copyrighted freeware raytracing package from the Persistence of Vision Development Team, available from [http://www.povray.org](http://www.povray.org). CONCEPT can export POV-Ray files as well as controlling the operation of POV-Ray to automatically render images. For more details, see the **POV-Ray Output** dialog box.

To create a POV file, select the *Export...* item from the *File* menu and select files of type ‘POV-Ray Scene File’. The following is a small sample of a POV file.

```
#version 3.0

#include "colors.inc"
```
global_settings {
    ambient_light rgb < 1.0, 1.0, 1.0 >
    assumed_gamma 1.0
}

// Camera.
#declare View_1 =
camera {
    angle 60.00
    location < 12100.000, 1000.000, 2500.000 >
    look_at < 7148.004, 1000.000, 5532.165 >
}
camera { View_1 }

// Material.
#declare DblBrickWall_Plastered =
texture {
    pigment {
        color rgb < 1.000, 0.502, 0.251 >
    }
    finish {
        ambient 0.200
        diffuse 0.600
        specular 1.000
        roughness 0.000
        reflection 0.015
    }
}

// zone_100000.
polygon {
    5,
    < 2300.000, 0.000, 2500.000 >,
    < 2300.000, 2400.000, 2500.000 >,
    < 2200.000, 2400.000, 7800.000 >,
    < 2200.000, 0.000, 7800.000 >,
    < 2300.000, 0.000, 2500.000 >
    texture { DblBrickWall_Plastered } }

// zone_100003.
light_source {
    < 4300.000, 2300.000, 5800.000 >
color Spotlight_Aimed
spotlight
point_at < 4300.000, 900.000, 5800.000 >
radius 30.0
falloff 45.0
tightness 10
}
// Ground.
plane {
  <0, 1, 0>, -1
  pigment { rgb < 0.36, 0.25, 0.2 > }
}

// Sky Definition.
light_source { <86427.0, 586951.0, 804996.1> rgb <1, .95, .85> * 0.5 }
sky_sphere {
  pigment { rgb < 0.196078, 0.6, 0.8 > }
}

28.8.8 IES Lighting Data Files (*.ies)

IES files contain information about the level and distribution of light from a luminair. These are used to accurately define the properties of light sources for electric lighting calculations. They contain both the lumen output of lamps within the luminair as well as the candela output in each direction.

IES files can be loaded from within the Source/Receiver Properties dialog box. This is done by clicking the Import icon in toolbar alongside the Output Profiles graph. The following is a small sample of an IES file.

IES #1, PENDANT DIFFUSING SPHERE WITH INCANDESCENT LAMP
LAMP=INCANDESCENT
TILT=NONE
1    1000. 1.0 21  1 1 1   1.00   1.00    .80
1.0 1.0       0.
.00   5.00 15.00 25.00 35.00 45.00 55.00 65.00
75.00 85.00 90.00 95.00 105.00 115.00 125.00 135.00
145.00 155.00 165.00 175.00 180.00
50.00 72.5     72.5     72.5     72.5     72.5     72.5
72.0     71.5     70.5     70.0      68.5     67.0
62.5     58.0      54.5     51.0     48.0     46.5
45.0      44.0     44.0
29  **DXF FILES**

29.6  **DXF Translation**

DXF is possibly the most widespread CAD exchange format in use by CAD packages on small computer systems. It was developed by the AutoCAD developers and has received its popularity mainly from the high number of AutoCAD stations. Most CAD systems can export and most also import DXF, at least for 2D data.

CONCEPT’s DXF support is limited primarily to 2D entities. Whilst it will recognise complex 3D entities such as faces and meshes, the ACIS solids from Release 13 and 14 are not fully supported. To import this data, use the `3DSOUT` command in AutoCAD to generate a 3DS scene file.

A DXF file is a text only file which consists of the following sections: *header, tables, blocks, and entities*. As CONCEPT’s internal representation of geometric objects is substantially different from AutoCAD and other CAD applications, it does not support DXF block objects such as cross-hatching, text, dimensions or XREF objects. The following is a list of DXF objects and how they are interpreted by CONCEPT.

<table>
<thead>
<tr>
<th>ENTITY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINE</td>
<td>Translated into line objects. If a thickness is defined, is interpreted as a rectangular plane in the Z direction relative to the world coordinate system.</td>
</tr>
<tr>
<td>POINT</td>
<td>Translated into point objects.</td>
</tr>
<tr>
<td>CIRCLE</td>
<td>Translated into a closed line object. The number of segments is determined by the degrees-per-segment setting in the DXF dialog.</td>
</tr>
<tr>
<td>ARC</td>
<td>Translated into an open line object. The number of segments is determined by the degrees-per-segment setting in the DXF dialog.</td>
</tr>
<tr>
<td>SOLID</td>
<td>Translated into a number of closed planar objects with a height in the Z direction relative to the world coordinate system.</td>
</tr>
<tr>
<td>POLYLINE</td>
<td>Translated into a line object. If a thickness is defined, is interpreted as a rectangular plane in the Z direction relative to the world coordinate system. Polyline objects can also contain meshes and other multi-plane objects. CONCEPT will interpret</td>
</tr>
</tbody>
</table>
these subject to the setting in the DXF file dialog.

3DLINE
Translated into an open or closed line object.

3DFACE
Translated into plane objects.

3DSOLID
These are binary objects which are ignored by CONCEPT. Interpretation requires the ACIS (AME in R12) constructive solid geometry engine. Exploding an ACIS object produces a series of REGIONS.

REGION
These are binary objects which are ignored by CONCEPT. Interpretation requires the ACIS (AME in R12) constructive solid geometry engine. Exploding a REGION produces a series of individual line or arc segments.

ATTDEF
Ignored in this release.

ATTRIB
Ignored in this release.

BLOCK
Ignored in this release.

DIMENSION
Ignored in this release.

INSERT
Ignored in this release.

SHAPE
Ignored in this release.

TEXT
Ignored in this release.

TRACE
Ignored in this release.

For more information on DXF file conversion, see the DXF Conversion dialog box.

29.7 DXFOUT: Writing a DXF File in AutoCAD

You can generate a drawing interchange file from an existing AutoCAD drawing by means of the DXFOUT command:

Command: dxfout

29.7.1.1 Release 14

Release 14 automatically displays the File Save As dialog box. As BLOCK and TABLES entries are ignored, a partial DXF file is the preferred option for exporting to CONCEPT. This is done by clicking in the Options... button in this dialog and ensuring that the format is ASCII and the Select Objects box is checked. If you enter a filename and click Save, AutoCAD will prompt you to select the objects you want in the file.
29.7.1.2  Release 13 and Before

When AutoCAD prompts you, respond with a filename or press Enter to accept the default. The default name for the output file is the same as that of the current drawing, but with a file type of .dxf. If you specify an explicit filename, you do not need to include a file type; .dxf is assumed. If a file with the same name already exists, the existing file is deleted. If you specify the file using a file dialogue box, and a file with the same name already exists, AutoCAD tells you; allowing you to OK or Cancel the deletion.

Next, DXFOUT asks what precision you want for floating-point numbers and permits output of a partial DXF file containing only selected objects. A partial DXF file is the preferred option for exporting to CONCEPT.

Enter decimal places of accuracy (0 to 16)/Objects/Binary <6>:

If you respond with "objects" (or just "o"), DXFOUT asks you to select the objects you want written to the DXF file. Only the objects you select are included in the output file - symbol tables (including Block Definitions) will not be included. Once you've selected the desired objects, AutoCAD again prompts you for the numeric precision:

Enter decimal places of accuracy (0 to 16)/Binary <6>:

CONCEPT does not read binary DXF files so simple specify the number of decimal places required.

29.8  Reading and Writing DXF Files in CONCEPT

To create a DXF file, select the Export... item from the File menu and select files of type ‘AutoCAD DXF File’. To import a DXF file, select the Import... item from the File menu and select files of type ‘DXF File’. 
30 3DS FILES

30.6 3DS Translation

3DS files are AutoDesk’s 3D Studio and 3DS Max geometry description files. They are a relatively popular format for storing 3D models, with a huge range of objects available on the internet. As these files contain geometry as well as material, camera and light data, this is the preferred 3D file format for importing AutoCAD geometry into CONCEPT. You should use DXF files only for 2D line drawings and very simple 3D models.

30.7 3DSOUT: Writing a 3DS File in AutoCAD

You can generate a 3DS file from an existing 3D AutoCAD drawing by means of the 3DSOUT command:

Command: 3dsout

AutoCAD prompts you to select the objects you wish to save and then displays the File Save As dialog box. Once you enter a filename, the 3DS Options dialog box is displayed. As CONCEPT does not support smoothing of triangulated surfaces, you can speed the process up by unchecking the smoothing and welding options.

30.8 Reading 3DS Files in CONCEPT

To import a 3DS file, select the Import... item from the File menu and select files of type ‘3D Studio File’. CONCEPT fully supports 3DS materials, cameras and lights. A new zone is created for each 3DS mesh object. AutoCAD and 3DS models contain only triangulated surfaces. This is fine for lighting and shadow analysis, however, thermal analysis requires a little more care in the preparation of the model.
31 **ELEMENT DATA**

CONCEPT requires an extensive set of data to describe any material. This includes acoustic, costing, environmental, lighting and thermal properties. It is, however, very flexible in the specification of this information, meaning that only data specific to each required calculation need be entered.

Thus, only surface properties are needed for an accurately lighting simulation, only transparency and reflectivity for shadow calculations, absorption characteristics for acoustic analysis and heat flow properties for thermal simulation.

Materials within CONCEPT are stored within ZON and MOD files themselves as well as in LIB files. LIB files are simple library files that contain both element and material data, linking a composite panel back to its constituent components. Materials can be edited directly within CONCEPT or using the HEATWIN application and editing libraries directly.

See the *Element Library* section for more details.

### 31.6 Establishing a Standard Material Definition

There is a real need in the building industry for a standard materials definition, available to architects and engineers from manufacturers and suitable in a range of software. Work is currently being carried out in this area, however, it was too premature for inclusion in this work. Regrettably, yet another proprietary format for material data was established for this application.

For those familiar with C++ or similar pseudo-code, the following is the material data structure used within CONCEPT:

```c
//
// MATERIAL DATA.
// -----------------------------------------
// Specifies all the information required
// to define a single homogenous material.
// -----------------------------------------
//

// Materials in composite panel.
#define MAXMATERIALS 16

struct MaterialData {
    int type;
    char name[SIZE_32BYTES];

    // Section.
    int fillDensity;
```
// Acoustic.
float diffusion;
float absCoeff;

// Thermal.
float thickness;
float specificHeat;
float conductivity;
float resistivity;
float density;

// Visual.
COLORREF color;
float transparency;
float roughness;
float specularity;
float emissivity;

// Future expansion.
float spare[5];

}


// ELEMENT_DATA.
// -----------------------------------------
// Specifies all the information required
// to define a composite panel made up of
// multiple single homogenous materials.
// -----------------------------------------
// Define different entity
// types as building elements.
#define ELEMENT_VOID 0
#define ELEMENT_ROOF 1
#define ELEMENT_FLOOR 2
#define ELEMENT_CEILING 3
#define ELEMENT_WALL 4
#define ELEMENT_PARTITION 5
#define ELEMENT_WINDOW 6
#define ELEMENT_PANEL 7
#define ELEMENT_DOOR 8
#define ELEMENT_SPEAKER 10
#define ELEMENT_LIGHT 11
#define ELEMENT_POINT 12
#define ELEMENT_APPLIANCE 13
#define ELEMENT_LINE 14

// How to charge for material.
#define COST_PER_SQM 0
#define COST_PER_UNIT 1
#define COST_PER_M3 2

struct ElementData {
int type;
char name[SIZE_64BYTES];

// Acoustic.
float data[HOURS_24FLOATS];
float extDiffusion;
float intDiffusion;

// Thermal.
float solarAbsorption;
float solarGainFactor;
float thermalDecrement;
float thermalLag;
float admittance;
float uValue;

// Additional thermal.
float thermalResistance;
float extEmissivity;
float intEmissivity;

// Visual.
float transparency;
float extSpecularity;
float intSpecularity;
float extRoughness;
float intRoughness;
COLORREF intColor;
COLORREF extColor;

// Miscellaneous.
float greenhouseGas;
float thickness;
float unitCost;
float weight;
int costType;

float embodiedEnergy;

int iDefault;
int iSpare;

// More costs.
float maintenanceCost;
float maintenanceEnergy;
float maintenanceEnergy;
float expectedLife;

};
struct BldgElemData : public ElementData {

    // Product info.
    char supplier[SIZE_64BYTES];
    char code[SIZE_64BYTES];

    // Size.
    float dim[3];

    // Material information.
    int index[MAXMATERIALS];
    float width[MAXMATERIALS];
    int layers;
};

31.7 Available Material Libraries

CONCEPT material libraries and ZON files containing other peoples material data can be swapped and exchanged over the internet. See the following web sites for regularly updated material libraries:

32 Bibliography


Szokolay, S.V. 1987, Thermal Design of Buildings, RAIA Education Division, Canberra, Australia.

Index

1 A Quick Tutorial........................................................................................................................................5
  1.1 Creating A Simple House................................................................................................................5
    1.1.1 Creating the First Zone .............................................................................................................5
    1.1.2 Adding Window .......................................................................................................................7
    1.1.3 Nudging the North Window ....................................................................................................8
    1.1.4 Editing the Floor Plan .............................................................................................................9
    1.1.5 Adding a Second Zone ............................................................................................................10
    1.1.6 Adding a Window Interactively .............................................................................................10
    1.1.7 Adding a Roof .......................................................................................................................12

2 Geometric Modelling ..........................................................................................................................14
  2.1 Creating Objects ............................................................................................................................14
    2.1.1 Creating a New Object Interactively .....................................................................................14
    2.1.2 Moving Up and Down in the Z Axis ....................................................................................14
    2.1.3 Changing the Model View ....................................................................................................14
    2.1.4 Changing the Snap Mode ....................................................................................................15
    2.1.5 Creating a New Object Numerically .....................................................................................15
    2.1.6 Entering Dimensions ............................................................................................................15
    2.1.7 Using Equations ..................................................................................................................15
    2.1.8 Creating a New Library Object ............................................................................................15
    2.1.9 More Complex Objects ........................................................................................................16
  2.2 Editing Objects ...............................................................................................................................17
    2.2.1 Object Selection ....................................................................................................................17
    2.2.2 Pick-Selecting an Object with the Mouse .............................................................................17
    2.2.3 Drag-Selecting an Object with the Mouse ............................................................................17
    2.2.4 Adding or Removing Objects from Selection Set ...................................................................17
    2.2.5 Object Transformations .......................................................................................................17
    2.2.6 Editing Object Nodes ..........................................................................................................18
    2.2.7 Object Properties .................................................................................................................18
  2.3 Model Zones ....................................................................................................................................20
    2.3.1 What is a Zone ......................................................................................................................20
    2.3.2 Zone Management ...............................................................................................................20
    2.3.3 Zone Objects .......................................................................................................................20
    2.3.4 The Current Zone ...............................................................................................................21

3 Model Analysis ..................................................................................................................................22
  3.1 Example Models ............................................................................................................................22
    3.1.1 Loading an Example Model .................................................................................................22

4 Shadows and Reflections ..................................................................................................................23
  4.1 Displaying Shadows .......................................................................................................................23
    4.1.1 Shadow Information ..............................................................................................................23
    4.1.2 Setting the Date, Time and Location ....................................................................................23
    4.1.3 Ground Shadows ..................................................................................................................24
10.1 Calculating Cost Schedules .................................................................43
10.2 Calculating Material Costs .................................................................43

11 Comparative Analysis .................................................................................44
11.1 To Perform a Batch Calculation ..............................................................44
11.2 To Compare Batched Results .................................................................44

12 HEATWIN .................................................................................................45
12.1 Introduction ............................................................................................45
  12.1.1 The Workspace ..................................................................................45
  12.1.2 The Display ........................................................................................46
  12.1.3 Keyboard Shortcuts ..........................................................................46
  12.1.4 Mouse Buttons ..................................................................................47
12.2 Building Elements ..................................................................................48
  12.2.1 To Add a New Element ......................................................................48
  12.2.2 To Delete the Current Element ...........................................................48
  12.2.3 To Edit the Current Element .............................................................48
12.3 Element Layers .......................................................................................48
  12.3.1 To Insert a New Layer .......................................................................48
  12.3.2 To Delete a Layer ..............................................................................49
  12.3.3 To Edit a Layer ..................................................................................49
12.4 Materials .................................................................................................50

13 PSYCHWIN ...............................................................................................51
13.1 Introduction ............................................................................................51
  13.1.1 The Workspace ..................................................................................51
  13.1.2 Keyboard Shortcuts ..........................................................................52
  13.1.3 Mouse Buttons ..................................................................................52
13.2 The Psychrometric Chart .........................................................................53
  13.2.1 Overview ...........................................................................................53
  13.2.2 The Chart Cursor ..............................................................................53
  13.2.3 To Move the Cursor With the Mouse ..................................................54
  13.2.4 Move the Cursor With the Keyboard ..................................................54
  13.2.5 Enter Values Directly ........................................................................54
  13.2.6 Graph Extents ...................................................................................55
  13.2.7 To Set the Graph Extents .................................................................55
  13.2.8 Psychrometric Values .......................................................................55
13.3 Locations and Weather Data .................................................................57
  13.3.1 To Add a New Location .....................................................................57
  13.3.2 To Delete the Current Location ..........................................................58
  13.3.3 To Edit the Current Location .............................................................58
  13.3.4 Climate Data .....................................................................................58
1 **A QUICK TUTORIAL**

1.1 **Creating A Simple House**

This tutorial is intended as a quick introduction to the use of the CONCEPT application. It is followed by some more in-depth analysis using some of the example models included with this distribution.

1.1.1 **Creating the First Zone**

1. To create a zone, select the Add Zone item from the Model menu or click the icon in the left hand vertical toolbar.

2. Move the mouse into the Model Canvas, clicking and holding down the left mouse button somewhere within the displayed model grid. A dotted red cross will appear with a small square box indicating the cursor position.

3. Keeping the left mouse button held down, drag the newly created node into the position indicated immediately below. At this stage accuracy is not important as the node can be moved at any time.

4. Release the mouse button to set the node’s position. A small yellow cross will appear at the cursor position enclosed in a small red square.

5. Press the ‘A’ key to set the snap mode to Align. You should check the snap mode selection combo box in the to right of the screen to ensure that it shows the word ‘Align’.

6. Click and drag, remembering to hold the left button down, the next point into position, as shown below. You should notice a small X appearing above the cursor to indicate that you are aligned with the first point in the X axis.

7. Click and drag the third point into position, as shown below. You should notice a small Y appearing above the cursor to indicate that you are aligned with the second point in the Y axis.
8. Click and drag the fourth and final point into position, as shown below. You should notice both an X and a Y appearing above the cursor to indicate that you are aligned with the first point in the Y axis and the third point in the X axis.

9. Select the toolbar button or press the Escape key to complete the object. You can also select any other object creation button or menu item, or even hit the F2 key to repeat the last command. You will then be prompted to name the zone you have just created.

   ![Zone Name Prompt]

10. Enter the name ‘Bedroom One’ and select the OK button.

The zone is now complete and should be displayed as shown below. It consists of a floor object, which is the parent of the derived wall and ceiling objects. The default extrusion height is set in the Model Settings dialog, invoked using the Preferences item in the File menu.
1.1.2 Adding Window

1. After an object is added, it is highlighted in yellow to indicate that it is currently selected. To clear the selection set, hit the Escape key or click in an empty area of the Model Canvas.

2. To add a window to the zone, you must first select the walls into which the windows are to be placed. To do this, first select the north wall by clicking on one of its line segments, as shown below.

3. If you select the floor object, simply press the Space bar to cycle through other objects that share the same line segment.

4. To select the west wall, hold the shift key down whilst clicking on one of its line segments.

5. If you inadvertently select the floor or ceiling object again, simply press the Space bar whilst continuing to hold down the Shift key.

6. Select the Insert Library Object... item in the Model menu or simply press the Insert key. This will display the following dialog box.

7. Because you have two planar surfaces selected, CONCEPT assumes you wish to insert child objects, the default for which is a window. Enter a window height of 1200mm, a width of 3600mm and a sill height of 600mm in the three Object Parameter edit boxes and select the OK button.

The two new windows should appear as follows. The next step is to move the northern window slightly west. This can be done interactively with the mouse, however we are going to nudge it with the keyboard.
1.1.3 Nudging the North Window

1. We now need to select only the north window. We can do this by dragging a selection box over just that window. To do this, click the left mouse button at Point A indicated in the diagram below and drag it to Point B.

2. This should select only the window within the selection rectangle. Dragging from left to right selects all objects that are entirely within the selection box whereas dragging from right to left selects all objects with any of their nodes within the box.

3. To nudge the window, simply press the Shift key down and hit the X key 10 times.

   The X, Y and Z keys nudge the object in the positive X, Y and Z axis respectively. The Shift key simple nudges in the negative direction. The amount of nudge is equal to the current snap grid setting (in this case 100mm).

   The model should now look like that shown below.

Just a quick note on the relationships currently established in the model. With just the minimum information we have put into the model, it already knows that the flat element at the bottom of the model is a floor and that the vertical elements are walls, etc. It also knows that the windows are children of the north and west walls. If we now edit the floor plan, both the walls and windows will update.
1.1.4 Editing the Floor Plan

1. To edit the floor plan we need to select the floor object. To do this, we could simply click on one of its line segments. However, we are going to press the Page Down key to cycle through the objects in the model. In fact, you only need to hit Page Down once.

   If CONCEPT does not seem to respond to this key, press the Escape key to reset the focus to the Model Canvas and try again.

![Floor Plan Image]

2. To edit nodes, either double-click on the floor object or select the Node Mode item in the Select menu. You should now see each node highlighted with a red square.

![Node Image]

3. The next step is to click in the very first node in order to select it. The interior of the red square should now turn dark grey.

4. Now click once again in the selected node square and drag the node to the east. You should still be set to ‘align’ snap mode so a Y should be visible above the cursor.

![Node Drag Image]

5. Notice that the walls and ceiling have reshaped and the window has remained within the west wall. You should experiment with moving different nodes to see what effect they have on the overall model based on the default relationships that have so far been established.

The next step in our simple model is to add a second zone. This will be added to the east of the existing zone and will be immediately adjacent.
1.1.5 Adding a Second Zone

1. To create the second zone, select the **Add Zone** item from the Model menu or click the icon in the left hand vertical toolbar again.

2. We now wish to snap to an existing point, so press the ‘P’ key. You should check the snap mode selection combo box in the to right of the screen to ensure that it shows the word ‘Point’.

3. Click and hold the left mouse button somewhere in the Model Canvas away from the existing zone. As you drag the new node close to the fourth node (as shown below), you should see a small ‘P’ appear above the cursor indicating that an existing point has been snapped to.

4. **Now click and drag the second point towards the third node of the existing zone.**

5. **Continue to add nodes until you have created a zone similar to that shown below.** You may want to use the align snap mode for the remaining nodes that do not snap to any existing points.

6. **Select the toolbar button or press the Escape key to complete the object.**

You should now add some windows and maybe doors to the new zone. At this stage we should introduce the interactive method of adding a window.

1.1.6 Adding a Window Interactively

1. The first step when adding a window interactively is to select the wall you wish to work with and zoom to a more appropriate view. To do this, first click in an empty
area of the Model Canvas to clear the selection set. Then click on the north wall to select it (clicking on an already selected object allows you to move it interactively).

2. To zoom in on this object, select the Zoom Window item in the View menu or select the icon in the main horizontal toolbar.

3. Drag a rectangle over the object you wish to zoom in on.

4. If the object is not directly in the centre, you can pan the view by holding down the Control key whilst dragging it with the right mouse button. Without the Control key, the right mouse button rotates the current perspective view.

   You can also use the + and - keys to zoom in and out.

5. To create the window, select the Insert Child Object → Window item from the Model menu or click the icon in the left hand vertical toolbar.

6. As we are not snapping to anything, hit the ‘G’ key to snap only to the current grid.

7. To add the first point, click somewhere within the selected object and drag the first node into position as shown below.

8. You should note that you do not have to hold the Shift or Control keys down in order to move vertically as CONCEPT already knows that you can only move within the plane of the parent object and that you are restricted to points within its boundary.

9. We are now going to use the keyboard to add the next node. If you look in the bottom right corner of the window, there are three edit boxes. These show the coordinates of the last entered point.

   We want to add a point 1200mm below this. We can do this by simply subtracting 1200 off the existing value. As CONCEPT passes all entered values through an equation parser, you can simply enter this directly, as shown below.
10. Select the Add Node button immediately above or simply press the Enter key. You can enter equations of any complexity in any value edit box, even in dialogs. See the on-line help for a list of functions you can use (sin, cos, log, pi, etc).

   The new node should appear as follows.

![Image of a node with coordinates]

11. Add the rest of the nodes required to construct the following window using whatever method you find the easiest.

![Image of a window being constructed]

The final step in the construction of our model is to add a roof. You can do this manually, or using a library object.

1.1.7 Adding a Roof

1. The first step in creating the roof is to add a new zone in which to create it. To do this, select the Zones... item from the Model menu or use the icon in the main toolbar. This displays the Zone Management dialog box.
2. To create a new zone, enter ‘Roof Zone’ in the edit box near the bottom and then select the Add button. A new zone will appear in the list and become the current zone.

3. Select the Close button.

4. Ensure nothing is selected in the model (everything is either blue or black, not yellow).

5. Select the Insert Library Object… item from the Model menu.

6. Select the Hip Roof option and enter the parameters as shown below.

7. To zoom to fit the entire model in the canvas, select the Zoom All item from the View menu or hit Control+ F. The roof should appear as below.

8. You could experiment with the roof by rotating it 90 degrees or adding one or two smaller ones and manipulating their nodes.
GEOMETRIC MODELLING

2.1 Creating Objects

You can create new objects in any of three ways:

- Interactively using the mouse,
- Numerically entering coordinates in the Direct Input Area or
- Parametrically using library objects.

A new object is not created until its first node is added. You can abort adding an object anytime by pressing the *ESCAPE* key or by selecting the toolbar button.

2.1.1 Creating a New Object Interactively

4. Select the *Add Plane* item from the *Model* menu (or any other *Add...* or *Insert...* item you require).

5. Move the mouse into the Model Canvas, clicking and holding down the left mouse button somewhere within the displayed model grid. A dotted red cross will appear with a small square box indicating the cursor position.

6. Keeping the left mouse button held down, drag the newly created node into its desired position.

7. Release the mouse button to set the node’s position. A small yellow cross will appear at the cursor position enclosed in a small red square.

8. Repeat steps 2-4 for each node in the object.

9. Select the toolbar button or press the *Escape* key to complete the object. Any other

You can add multiple objects consecutively using the *F2* key, instead of having to reselect the same toolbar or menu item each time. The *F2* key simply repeats the last command and works for all modelling commands.

2.1.2 Moving Up and Down in the Z Axis

You can move the cursor up and down using the *Shift* and *Control* keys. Whilst either of these keys is held down, the cursor plane changes from the XY plane to either the XZ or YZ planes, with the origin at the current mouse position.

- <SHIFT+DRAG> YZ plane
- <CONTROL+DRAG> XZ plane
- <None> XY plane

2.1.3 Changing the Model View

You can pan or rotate the current view whilst dragging nodes by simply clicking and dragging the *right mouse* button, ensuring that you keep the left mouse button still pressed.
In between adding nodes, you can change the view type. The available orthographic and perspective views are selected from the View menu.

2.1.4 Changing the Snap Mode

Whilst adding or dragging a node, you can also change the cursor snap mode using the A, L, G, N, O, P, M, I or C keys (thus setting to align, line, grid, none, ortho, points, midpoint, intersection or centre snap mode). Snap points are indicated by small letters that appear above the cursor indicating the type of snap detected.

2.1.5 Creating a New Object Numerically

1. Select the Add Plane item from the Model menu (or any other Add... or Insert... item you require).
2. Press the End key to activate the Direct Input Area or click in one of the three edit boxes.
3. Enter the X, Y and Z coordinates of the first object node.
4. To set the node, press the Enter key or click on the Add Node button immediately above the edit boxes.
5. Repeat steps 3 and 4 for each node in the object.
6. Select the toolbar button or press the Escape key to complete the object.

2.1.6 Entering Dimensions

By default, CONCEPT interprets all dimensions as millimetres. You can change this in the Preferences dialog box, invoked from the File menu. This units setting determines how dimensional information is both displayed and interpreted. See the on-line help file for details on how the use of more complex units such as feet and inches can effect equation parsing.

2.1.7 Using Equations

All numeric data entered in CONCEPT is first passed through an equation parser. This means you can use an equation anywhere you can use a number. An equation can be as simple as 270+2500+270, or as complex as TRUNC(15*SIN(RAD(30)) + 10*LOG(187.631)). See Part B for a list of functions.

2.1.8 Creating a New Library Object

1. Select the Insert Library Object... item in the Model menu, or simply press the INSERT key to invoke the Add New Object dialog box.
2. If no objects are selected when this dialog box is invoked, a set of parametric objects is displayed. If one or more planar objects are selected, it is assumed that you wish to insert a child object such as a window, door or void.
3. Select the type of object you wish to add from the Object Type selection box, and then the actual object from the displayed list immediately below.
4. Specify the parameters that define your new object as well as the insertion point. The insertion point defaults to the current About Point if no objects are selected, or the geometric centre of the currently selected object.

5. Select the OK button or hit the Enter key to insert the new object.

2.1.9 More Complex Objects

In addition to the basic point, line and plane object types, CONCEPT allows you to create more complex composite objects. These consist of multiple elements automatically generated from a parent object.

An example of this is the Zone, where simply entering a floor plane results in the automatic generation of walls and a ceiling object. Automatically generated objects retain relationship links with their parent object so that any interactive editing is reflected in the entire construction.

2.1.9.1 Object Links

You can link and unlink individual or groups of objects at any time using the Link Objects and Unlink Objects items in the Select menu. For a more comprehensive description of object linking, see the on-line help files supplied with this software.

2.1.9.2 Fixing Links

There may be times when object relationships become strained, such as nodes being moved outside their objects defining plane. When this happens, you can use the Fix Links item in the Select menu to automatically correct errant nodes. Objects with relationship problems are highlighted in red.
2.2 Editing Objects

2.2.1 Object Selection

In order to work on or edit an object it must be selected. There are several ways to select individual or groups of objects.

- Interactively using the mouse,
- Cycling displayed objects using the Page Up/Down keys,
- Using selection commands in the Select menu.

You can use the ESCAPE key to clear the current selection set or revert to object selection mode from node mode.

2.2.2 Pick-Selecting an Object with the Mouse

1. Move the mouse pointer over the object in the Model Canvas.
2. Click the left mouse button somewhere along one of the lines that make up the object. If a line is shared between two or more objects, you can use the SPACE bar to cycle through adjacent objects.

2.2.3 Drag-Selecting an Object with the Mouse

1. Move the mouse to an unoccupied area of the Model Canvas.
2. Click the left mouse button and drag the selection box so that it completely surrounds the desired object.
3. Release the mouse button to select the object.

2.2.4 Adding or Removing Objects from Selection Set

1. Holding the SHIFT key down, drag or pick select the objects you wish to add or remove, thus toggling their selection state.

2.2.5 Object Transformations

Once selected, you can apply a wide range of transformations to objects. This is done using the Transform Selection dialog box, invoked by selecting the Transform... item in the Edit menu, the toolbar button or the keyboard shortcut CTRL+T.
On the left hand side of this dialog is an area in which you can specify the point about which the transformation is to be applied. This is known as the *About Point* and is stored as a global variable. For more details on the use of this dialog, select its *Help* button.

The seven transformations available in this dialog are:

- **Rotation** using an azimuth and altitude angle.
- **Rotation - Axis** an angle around one of the major axis.
- **Translation** a movement vector.
- **Scaling** a size factor in each of the major axis.
- **Mirroring** inverts about the origin or cutting plane.
- **Extrusion** creates new objects extruding along normal.
- **Extrusion - Axis** extrudes along specified vector.
- **Revolve** creates new objects revolving around axis.

### 2.2.6 Editing Object Nodes

The individual nodes of an object can be edited interactively or numerically. You can enter node mode two ways:

- Double-clicking a selected object with the left mouse button,
- Selecting *Node Mode* from the *Select* menu (or the F3 key).

To return to object selection mode, press the ESCAPE key, the F3 key again, or select the *Object Mode* item in the *Select* menu.

#### 2.2.6.1 Node Selection

Just like objects, you can only work on selected nodes. Individual or groups of nodes can be both pick and drag selected, as well as toggled using the *SHIFT* key. When in node mode, the *All, None and Invert* items in the *Select* menu apply to visible nodes instead of objects.

#### 2.2.6.2 Manipulating Nodes

Individual nodes can be moved either numerically, interactively with the mouse, or nudged with the X, Y and Z keys. When a single node is selected, its coordinates are displayed in the Direct Input Area. New coordinates can then be entered directly. In node mode, transformations performed in the *Transform Selection* dialog box apply directly to selected nodes instead of the entire object.

### 2.2.7 Object Properties

When an object is first created, it is assigned a material and a set of properties appropriate to its function within the building. These properties can be changed at any time using the *Object Properties* dialog box. This can be invoked by pressing the *ENTER* key or selecting
Object Properties… from the Edit menu. For a more comprehensive description of each item in this dialog, select its Help button.

This dialog can be used to edit the properties of multiple selected objects. If the particular property varies within the selection, it is shown either greyed out or as not selected.

2.2.7.1 Assigning Materials

Materials are assigned to objects based on their element type. Each object has two material indexes, a primary material for when it is exposed or free-standing, and an alternate for when it is overlapping with an adjacent zone or when activated. Separate materials can be assigned using the two lists in the Properties dialog.
2.3 Model Zones

2.3.1 What is a Zone

A zone within CONCEPT represents an enclosed space. It contains all of the building elements that form its external envelope as well as others that affect its internal environment. For effective thermal and acoustic analysis, zones should also be areas with similar usage and internal conditions.

As CONCEPT automatically determines when two zones are adjacent, calculating overlapping surface areas and applying single windows and doors to adjacent surfaces, zones should be created as completely separate and enclosed entities.

This planning flexibility allows zones to be quickly rearranged or resized at any stage of the design, with no potential for double counting adjacent surfaces in cost schedules or other area-dependant calculations.

2.3.2 Zone Management

Zones are controlled using the Zone Management dialog box, invoked by selecting the Model Zones… item in the Edit menu or using the keyboard shortcut CTRL+ENTER.

Using this dialog, zones can be created, renamed, deleted, hidden or made current. For a more detailed description of items within this dialog, select its Help button.

2.3.3 Zone Objects

Using the Add Zone item in the Model menu or the toolbar button, it is possible to create an object that defines a zone. The object created represents the floorplan of the zone, with vertical walls and a ceiling automatically extruded from it. This way, a set of relationship links are established that allow changes in the floor plan to be automatically reflected in the walls and ceiling. When this object is deleted, the corresponding zone is also deleted.
2.3.4 The Current Zone

Whenever an object is added, it is assigned to the current zone. This is simply the zone that is currently active. An exception to this is when a Zone item is created. In this case, it is placed on a new zone with the default name Zone X, where X is the ordinal number of the zone.
3 MODEL ANALYSIS

3.1 Example Models

A number of example models are included with this distribution to demonstrate the wide range of performance analysis that can be carried out within CONCEPT. These models are located in the EXAMPLES subdirectory within the main CONCEPT installation directory.

3.1.1 Loading an Example Model

1. Select the Open... item in the File menu. This will display the standard Windows File Open dialog box.

2. For more information on the use of standard Windows dialog boxes, see the Microsoft Windows 95 User's Guide or select the Help button.

3. Enter the Examples folder by double-clicking on it with the left mouse button. This folder is created as a sub-directory within the original installation directory (usually: C:\PROGRAM FILES\CONCEPT\EXAMPLES) and should appear somewhere near the top of the list of files.

4. Select one of the model files displayed in the Examples folder by double-clicking it with the left mouse button.

5. If you have made changes to the current model, CONCEPT prompts if you wish those changes to be saved before replacing it with the newly selected model. To save changes, select the Yes button, to ignore changes select the No button and to abort loading the new model completely, select the Cancel button.
4 SHADOWS AND REFLECTIONS

Shadow analysis is becoming a more important and complex design issue as councils adopt more stringent controls, especially in major urban centres.

4.1 Displaying Shadows

1. Load the example model Site.zon.

2. Select the Shadows item from the Display menu.

3. Use the Page Down key to increment the time of day in 15 minute increments. The Page Up key decrements the time.

4. Use Shift+Page Down to increment the date in one week steps throughout the year. The Shift+Page Up key decrements the date.

4.1.1 Shadow Information

Whilst viewing shadows, the Information canvas immediately to the right displays the time and date as well as detailed solar position. If a single planar object is selected, detailed information as to the angle and amount of incident solar radiation is also displayed. The VSA and HSA items refer to horizontal and vertical shadow angles, two very important aspects of shading design.

4.1.2 Setting the Date, Time and Location

Whilst the Page Up and Page Down keys can be used to cycle through the time and date (using the Shift key modifier), setting the location and north arrow offset requires the Set Date, Time and Location dialog box. This can be invoked using the Sun Position... item in the Calculate menu or the keyboard shortcut CTRL+F4.

The default position file is set to CONCEPT.POS which contains a number of Australian towns and cities. Several other position files are included with this distribution, including international locations and all Australian postcodes. To load a new position file, select the File... button in the top left corner of the dialog.
If the location you require is not listed, you can simply enter its details manually. All you need is its latitude and longitude, as well as some idea as to its time zone. Positional information is stored with each model when it is saved.

### 4.1.3 Ground Shadows

By default, shadows are displayed only on the ground plane (Z=0). The shadows falling on a particular object are only visible if that object is tagged as a shaded surface. If shaded surfaces are found, ground shadows are not displayed unless specifically set to display in wireframe as a reference.

You can toggle ground shadows on and off in the Model Settings dialog invoked using the Preferences... item in the File menu.

### 4.1.4 Tagging Objects as Shaded Surfaces

1. Load the example model ContouredSite.zon.

2. Pick select any of the triangles that make up the sloping site. This should highlight the entire site in yellow.

3. Ensure that the site is set as a FLOOR element so that it does not cast a shadow onto itself (floor elements do not cast shadows).

4. Select the Tag Object(s) as ➔ Shaded Surface item from the Select menu.

5. Select the Shadows item from the Display menu.

The following shadow diagram should now be slowly displayed, showing the shadows as they are projected onto each triangle within the site. Tagging objects as shaded surfaces is
a very powerful tool in overshadowing analysis, allowing any surface on any other building to be examined in detail.

4.2 Internal Sun Penetration

As internal sun penetration is often just as important as external shading, the CONCEPT shading model is shown in see-through wireframe. If all objects were tagged as shaded surfaces, it would be very difficult to differentiate sun patches and shadows on different elements within the building. Therefore, to accurately examine sun penetration in a building, you need to be judicious in the objects you tag as shaded.

4.2.1 Displaying Internal Sun Penetration

1. Load the example model file LightShelf.zon.
2. Select the far wall and the floor plane, as shown below.

3. Select the Tag Object(s) as ➔ Shaded Surface item from the Select menu.
4. Select the Shadows item from the Display menu.

The following indicative diagram of internal penetration should now be displayed. You can now determine the shading effects of the light shelf elements at different times and dates using the Page Up and Page Down keys.
The *Shaded Surface* item sets only those selected objects as shading surfaces. To clear this tag from all objects in the model, select it whilst no objects are selected. You can edit this tag on individual objects using the *Object Properties* dialog box.

4.3 Solar Reflectors

In addition to shadows, CONCEPT can also display solar reflections off planar surfaces. Solar reflections are only cast onto the ground and on shaded surfaces.

It is important to note that the display of solar reflections in this release of the software is relatively limited. Reflections are calculated for all shaded objects, however, no account is taken of any interposing objects that may block such a reflection. For example, a mirror that is within the shade of a large tree will still cast a reflection.

4.3.1 Tagging Objects as Solar Reflectors

1. If not already open, load the example model file *LightShelf.zon*.
2. Select the light shelves, the two horizontal elements in the centre of each window, as shown below.
3. Select the Tag Object(s) as ➔ Solar Reflector item from the Select menu.
4. Now pick-select the ceiling plane. You may need to use the SPACE bar if you inadvertently select the side walls.
5. Select the Tag Object(s) as ➔ Shaded Surface item from the Select menu.
6. Select the Shadows item from the Display menu.
Four reflected patches of sunlight should now be visible on the underside of the ceiling. By cycling through the year it is possible to determine how far back in the office reflected light will penetrate.

An interesting exercise may be to angle the reflectors such that maximum penetration is achieved in winter without any possibility of direct glare into a standing person’s eyes.

The Solar Reflector item sets only those selected objects as solar reflectors. To clear this tag from all objects in the model, select the Solar Reflector menu item with no objects selected. You can edit this tag on individual objects using the Object Properties dialog box.

4.4 The Sun Path Indicator

In addition to simply viewing shadows, it is often more important for the designer to fully understand the movement of the sun throughout the day and the year. To aid this understanding, a sun-path indicator can be displayed.

This is a diagrammatic representation of the sun’s path through the sky on the current day. Each hour of the day is shown as a vertical dotted line enumerated at its top. The current sun position is indicated by a yellow sphere, with a yellow arrow indicating the direction of parallel solar rays.
You can toggle the sun path indicator on and off using the *Shadow Options → Display Sun Path* item in the *Display* menu.
5  **THE STEREOGRAPHIC DIAGRAM**

Stereographic diagrams are an essential part of both overshadowing analysis and shading design. In the one image, shading patterns for the entire year can be displayed. For more details on the use and interpretation of stereographic diagrams, see the on-line help files or select the *Help* button.

5.1  **Displaying a Stereographic Diagram**

1. If not already open, load the model file `Site.zon`.

2. Pick-select the single point indicated by the arrow.

3. Select the Stereographic Diagram... item from the Calculate menu.

4. The following dialog box will appear.

   ![Stereographic Diagram](image)

   The dark patches indicate the silhouette of surrounding buildings whilst the blue lines arcing across the diagram represent that sun path at different times of the year. When a blue line is inside a building silhouette, then the selected point will be in shade for all points within it. You can use the cursor keys and the mouse to change the time and date.
5.1.1 Interactive Operation

The *Stereographic Diagram* is a modeless dialog box, meaning that the application behind remains active and reactive to commands whilst it is displayed.

By moving the dialog off to the side of the screen, you can drag the selected point around the model with the mouse, instantly updating the diagram at the end of each move. This can be an extremely useful site analysis tool.

You can also select other objects. When a planar surface is selected, the stereographic diagram is generated from its geometric centre.

5.1.2 Linking Shadows and Shading

If shadows are displayed in the Model canvas, pressing the *ENTER* key or double-clicking the *left mouse* button in the stereographic diagram will update the shadow display to the time selected. This link allows the cause of the overshadowing to be quickly and visually determined.
6 SOLAR EXPOSURE

In addition to simply stating the times and dates when a point or plane will be in shadow, it is often necessary to quantify the percentage overshadowing of a surface and the amount of incident radiation it receives. This is essential for the optimised design of any form of solar collector. In addition, it can also be used to quantify solar access rights and determine the effects of a proposed new building on those rights.

6.1 Calculating Solar Exposure

1. Load the model file Facade.zon.

2. Select the window indicated by the arrow.

3. Select the Solar Exposure... item in the Calculate menu. The following dialog box will appear:

4. Select the Calculate button.

The scrolling list is then updated with information specific to the chosen surface. You can calculate solar exposure for each hour of the current day or for each month of the year. Simply select Average Daily Solar Exposure or Annual Solar Exposure.

6.1.1 Climate Data

Solar exposure is based on hourly readings of direct and diffuse radiation. As a result, you must specify the climate data file appropriate to your intended location. This can be done by selecting the Select Climate Data... button.

This displays the Climate Data Selection dialog. Simply select from the displayed list of locations or use the Select File.. button to load an alternate locations file.
7 LIGHTING ANALYSIS

Next to internal temperature, inadequate or unsuitable lighting is the most common source of discomfort for building occupants. CONCEPT provides for the calculation of both natural and direct artificial lighting levels.

7.1 Calculating Lighting Levels

1. Load the model file Classroom.zon.

2. Select the Lighting Levels... item in the Calculate menu. The following dialog box will appear.

3. Ensure that the settings in the displayed dialog are the same as those shown above, with both Electric Lighting and Daylighting Levels checked.

4. Select the OK button.

This will start both the daylight factor calculation and electric lighting calculations running. You should be able to see yellow rays being sprayed spherically within the enclosure. You can adjust the accuracy of this calculation using the Precision selector, set to low, medium, high or ultra-high. Similarly, you can set a range of conditions that will affect the final result.

The Design Sky value refers to the CIE design sky illuminance and defaults to the value in the selected locations file. However, it can be overridden here if required. This value determines the illuminance levels generated from the daylight factor calculation.

Once complete, the diagram will display the total lighting level in lux at each sensor point.
7.1.1 Displaying Electric Lighting Levels

1. Select the Sensor Point Values ➔ Electric Lighting Levels item in the Display menu.
   
   This displays only the light levels resulting from the artificial lighting system installed within the model. These are based on a regular grid of fluorescent lights designed to provide around 200 lux.

7.1.2 Displaying Daylighting Levels

1. Select the Sensor Point Values ➔ Daylighting Levels item in the Display menu.

   This displays only the light levels resulting from natural light through the windows and overhead skylights. This is based on the Daylight Factor Method and defines the worst case design condition occurring on an overcast day in winter.

7.1.3 Displaying Daylight Factors

1. Select the Sensor Point Values ➔ Daylight Factor item in the Display menu.

   This displays the percentage of the sky that is ‘visible’ from each sensor point. This method considers both external and internal inter-reflections as well as the specified sky distribution.

7.1.4 Displaying Sky Factor

1. Select the Sensor Point Values ➔ Sky Factor item in the Display menu.

   This displays the actual percentage of the clear sky dome visible from each sensor point. This is simply a linear percentage of the number of rays with a positive altitude that did not intersect any internal or external objects.
8 ACOUSTIC ANALYSIS

CONCEPT has a relatively sophisticated geometric acoustics engine which can be used for very detailed acoustic analysis. The aspects most immediately useful at the conceptual stages of design are statistical reverberation times and geometric reflection analysis.

8.1 Calculating the Statistical Reverberation Time

1. Load the model file Theatre.zon.

2. Select the Reverberation Time... item from the Calculate menu. The following dialog box will appear.

The graph in this dialog indicates the reverberation time (in seconds) inside the specified zone at each octave band. The scrolling list immediately below displays details about the zone and tabulated results.

For a more detailed description of each item within the dialog, see the on-line help files, or simply select the Help button.

8.1.1 Saving and Printing Results

The row of icons immediately to the right of the graph can be used to save tabulated results to a text file, print the graph or copy its image to the clipboard as an enhanced Windows metafile. In addition, profiles can be stored for direct comparison after changes are made to the model.
8.2 Geometric Reflection Analysis

Geometric acoustic analysis is fundamental to the design of acoustic ceilings and other sound reflectors. In fact, the design of most enclosures could benefit from some form of sound reflection analysis. CONCEPT provides a number of different analysis methods, the most immediately useful being to simply generate sprayed rays within an enclosure. For details on the more sophisticated methods available, see the section on Acoustic Analysis in the on-line help file.

8.2.1 Calculating Reflected Rays

1. If not already open, load the model file Theatre.zon.

2. Select the Front item from the View menu to display the model front-on.

3. Select the Sprayed Rays... item from the Calculate menu. The following dialog will appear.

4. Ensure the same values are entered in each of the text boxes within the dialog and select the OK button.

The following ray casting will be generated from the source point located above the stage, as it is the only source object in the model.
It is quite difficult to interpret such a result as there are too far many rays within the image. Therefore, the next step is to tag only those surface that are of interest and restrict reflections to those objects.

### 8.2.2 To Tag Objects as Acoustic Reflectors

1. Select the angled reflector above the stage as well as the five planes that make up the ceiling of the theatre.

![Surfaces to select](image1)

2. Select the Tag Object(s) as → Acoustic Reflector item from the Select menu.
3. Select the Sprayed Rays... item from the Calculate menu.
4. Ensure that the Test acoustic reflectors only item is checked. This is located at the very bottom of the dialog.
5. Select the OK button.

The generated rays should appear the same as in the following image. It is now much easier to determine the effects of each reflective surface.

![Generated rays](image2)

### 8.2.3 Interactive Regeneration

If the source point is selected and dragged to different locations around the stage, rays are automatically regenerated from the new position. Similarly, moving or rotating reflective surfaces also updates the rays.

This allows the effect of reflectors on sounds coming from different areas of the stage to be quickly determined, as well as optimum reflector angles.
8.2.4 Displaying Levels and Time Delays

In addition to the geometric path of rays, it is also possible to display their sound level and delay relative to the direct sound. This can be done by selecting the *Relative Level* or *Relative Delay* options from the Display Info list within the Spray Rays dialog.

8.3 Method of Images

CONCEPT also includes a number of more complex geometric algorithms for acoustic analysis. For a brief overview, load the TheatreRays.zon example model.

This should change the overall display to include an echogram at the bottom of the window. A number of new display modes should now be active in the Display menu.

8.3.1 Setting the Receiver Point

Within this model there are a number of different receiver points for which rays have been generated. You can cycle through these using the *Shift + Page Up* and *Shift + Page Down* keys.

8.3.2 Display Sound Rays

To display reflection paths, select the *Geometric Acoustics → Sound Rays* item from the Display menu. This displays the impulse response and the corresponding geometric path of each ray. You can use the left mouse button to click on individual impulses in the echogram or on rays in the geometric model. Selected rays are highlighted in both views.

Interactively rotating the model using the right mouse button will show the path of the currently selected ray in 3D.

Two lines are displayed within the graph. These represent the *Early Decay Time* (taken over the first 10dB) and the *Reverberation Time* (taken over 60dB). These are lines of best
fit, the extents of which are controlled by two cursor points, as shown in the diagram immediately below.

![Diagram of cursor points and lines of best fit]

Each cursor point has a small red node at its base. You can interactively move these by dragging either node with the left mouse button. The lines of best fit will interactively update. Control over the graph itself is provided by the Graph Setup dialog box. This can be invoked directly from the toolbar or using the Graph Setup… item in the View menu. You can use this dialog box to set the frequency at which the graph is calculated or the axis and cursor positions.

### 8.3.3 Intersection Points

To display intersection points, select the Geometric Acoustics → Intersection Points item from the Display menu. This displays all of the intersection points on selected surfaces. If no surfaces are selected, all intersection points are shown.

In this display, the graph at the bottom of the window now shows intersection angles. This is shown as the percentage of intersections at particular incidence angles in, by default, 5 degree increments. This angle increment can be changed in the Preferences dialog box.
Objects can be selected interactively, as described in Section C-1.3.1, or using the Page Up and Page Down keys. Each time the selection set changes the graph is updated. This display is useful as it can be used to determine the most suitable type of absorber for a surface.

### 8.3.4 Images and Polar Diagrams

In order to get a feel for the distribution of the arriving sound at each receiver point, it is possible to display the phantom image position of each source for each reflection. To do this, select the Images item from the Display menu. To zoom in and out on the image use the + and - keys.

A polar diagram can also be displayed. This shows the relative direction of each reflection. Rays can also be directly selected in this diagram. Once a ray is selected, its path can be seen by interactively rotating the model using the right mouse button. In this case the 3D view is displayed while the model is being moved.

Double-clicking the left mouse button in this view will change the display from azimuth to altitude.

### 8.3.5 Integrated Decay

This display shows the integrated decay curve, as described by Manfred Schreuder. As with the impulse response, two lines of best fit are displayed showing the Early Decay Time and the Reverberation Time.

The two limiting cursors can also be interactively relocated to account for a lack of high or low order reflections.
9 **THERMAL ANALYSIS**

Once a building model has been created, zoned and assigned the appropriate materials, it is possible to simulate the thermal performance of each space. Both hourly internal temperatures and monthly heating and cooling loads can be calculated.

This simulation is based on the Admittance method as specified in the CIBSE guide.

9.1 **Calculating Volumes and Adjacency**

In order to perform any thermal analysis, CONCEPT must first calculate the volume of each zone and how much of each surface is exposed to the outside or an adjacent zone. The results of this calculation are stored in an adjacency file (*.ADJ). These files are accessed during thermal performance and cost schedule calculations and require automatically recalculation when zone geometry changes.

9.2 **Calculating Monthly Heating and Cooling Loads**

1. **Load the model file** SimpleHouse.zon.

![SimpleHouse Zon File](image)

3. **Select the Thermal Performance... item from the Calculate menu.** The following dialog box will appear:

![Thermal Performance Dialog Box](image)

4. Ensure that the Calculation Type option is set to Heating/Cooling Loads, and that the required zones are air conditioned and have their thermostat temperatures set correctly.

5. **Select the Calculate button.**
CONCEPT will now cycle through the entire year calculating internal temperatures for each zone and the resulting loads. To view animated temperature profiles at any time during this calculation, hold down the Control key.

9.2.1 Heating and Cooling Costs

The scrolling list immediately below the graph displays additional thermal information as well as tabulated results. Part of these results are estimated heating and cooling costs. These are based on the cost of heating and cooling energy set in the Preferences dialog box. This can be invoked by selecting the Preferences… item in the Options menu or using the toolbar button.

9.3 Calculating Internal Temperatures

1. If not already open, load the model file SimpleHouse.zon.
2. Select the Thermal Performance… item from the Calculate menu. The Thermal Performance dialog will appear.
3. Ensure that the Calculation Type option is set to Hourly Temperatures.
4. Select the Calculate button.

The displayed graph should change to that displayed below.

The blue dotted line represents outside air temperatures whilst the yellow lines represent internal hourly temperatures for each visible zone. Selecting a particular zone in the top right hand corner of the dialog highlights its temperature profile in red.

The solid and dotted white lines (shown above in grey) represent direct and diffuse solar radiation respectively. The scrolling list immediately below the graph displays further thermal information as well as tabulated results.
9.3.1 Saving and Printing Results

The row of icons immediately to the right of the graph can be used to save tabulated results to a text file, print the graph or copy its image to the clipboard as an enhanced Windows metafile. In addition, individual zone profiles can be stored for direct comparison after changes are made to the model.

9.4 Calculating Temperature Distribution

1. If not already open, load the model file SimpleHouse.zon.
2. Select the Thermal Performance... item from the Calculate menu. The Thermal Performance dialog will appear.
3. Ensure that the Calculation Type option is set to Temperature Distribution.
4. Individually select each zone and ensure that they are no longer air-conditioned (select the Zone Air Conditioning... button and uncheck the Air Conditioned box).
5. Select the Calculate button.

The displayed graph should change to that displayed below.

This graph shows the number of hours each zone spent at each temperature relative to the outside air. For more interesting graphs showing the occurrence of fabric, solar and ventilation gains, as shown below, select from the various distribution graphs displayed.
10 Costs Schedules

As CONCEPT calculates surface areas and inter-zonal adjacencies for its thermal analysis functions, creating cost schedules is very easy. Once the correct materials have been assigned to each element in the model, cost, environmental impact and embodied energy schedules can be generated by either material or element type.

10.1 Calculating Cost Schedules

1. Load the model file SimpleHouse.zon.
2. Select the Cost and Env. Impact… item from the Calculate menu.
3. The following dialog box will appear:

10.2 Calculating Material Costs

4. If not already open, load the model file SimpleHouse.zon.
5. Select the Cost and Env. Impact… item from the Calculate menu.
6. The following dialog box will appear:
11 COMPARATIVE ANALYSIS

In order to fully assess the effects of any design decision, CONCEPT allows batch calculations to be performed and the results compared directly with other runs.

11.1 To Perform a Batch Calculation

1. Load the model file House.zon.

2. Select the Batch Calculate... item from the Calculate menu.
   The following dialog box will appear:

   ![Batch Calculation Dialog Box]

11.2 To Compare Batched Results

1. Select the Compare Results... item from the Calculate menu.

   ![Compare Results Dialog Box]

By selecting a previous run using the Compare results with... button, it is possible to directly compare the results of any two batch calculations.
12 HEATWIN
Heat Flow and Condensation Analysis

12.1 Introduction

HEATWIN is a supporting application included with the CONCEPT environmental design suite to help create new materials and manage material libraries. It can be invoked directly from the Concept group in the Start Up menu or from the Launch item in the Options menu.

12.1.1 The Workspace

The main HEATWIN workspace consists of the following functional areas:

- **Menubar and Toolbar**
  This provides a number of pull-down menus and toolbar buttons used to activate application commands. To activate menus or toolbar buttons, select them with the left mouse button.

- **Element Canvas**
  This area displays a sectional view of the element being analysed.

- **Statusbar**
  This area displays the status of the application as well as help text.
12.1.2 The Display

When first started, HEATWIN displays an example building section. This defaults to the first material in the default library. In most cases it is a cavity-brick construction consisting of clay brick, an air gap, another layer of clay brick and then plaster. The name of each material is displayed at the bottom of the graph.

The vertical axis of the display represents temperature whilst the horizontal axis represents distance (in this case thickness).

12.1.2.1 What the Graph Shows

The red dotted line that runs across the building section represents the temperature across each material layer.

The area between the blue lines represents an area of possible condensation, defined by the specified internal and external conditions and humidity ranges. The white area beneath the blue lines shows an area where condensation will definitely occur.

If ever the red dotted line falls below the upper blue line, condensation will occur at that point. This is indicated by a number of small droplets shown running down the surface of affected materials.

12.1.2.2 Manipulating the Display

The user can manipulate the graph using both the mouse and the keyboard.

- Material layers can be selected and then inserted, edited or deleted. The currently selected layer’s name is always highlighted in red.

- Internal and external temperature nodes can be selected and dragged up or down to determine the conditions under which condensation may occur.

- Layers in building sections can be added, changed or deleted interactively.

- Building sections can be cycled through to assess the effects of a particular set of conditions on an entire set of elements.

12.1.3 Keyboard Shortcuts

When the Element Canvas is active, the following keyboard shortcuts apply:

- `<UP ARROW>`: Increment int/ext temperature 1°C.
- `<DOWN ARROW>`: Decrement int/ext temperature 1°C.
- `<SHIFT+UP ARROW>`: Increment int/ext temperature 0.1°C.
<SHIFT+DN ARROW> Decrement int/ext temperature 0.1°C.

<LEFT ARROW> Selects previous layer
<RIGHT ARROW> Selects next layer
<SHIFT+LFT ARROW> Selects external temperature node
<SHIFT+RT ARROW> Selects internal temperature node
<CTRL+LEFT ARROW> Pan graph to the left
<CTRL+RT ARROW> Pan graph to the right

<PAGE UP> Displays the previous building section
<PAGE DOWN> Displays the next building section

<ENTER> Display Edit Material dialog box
<SHIFT+ENTER> Display Element Properties dialog box
<CTRL+ENTER> Display Material Library dialog box

<INSERT> Inserts new layer in section
<DELETE> Deletes current layer from section
<SHIFT+INSERT> Inserts new building section
<SHIFT+DELETE> Deletes current building section

<END> Redraws graph
<HOME> Fits displayed graph to screen
<+/-> Zoom in/out on graph

12.1.4 Mouse Buttons

In the Element Canvas, mouse buttons exhibit the following behaviour:

<LEFT BUTTON> Selects layers and temperature nodes.
<LEFT DBLCLK> Displays various edit dialog boxes.
<RIGHT BUTTON> Pans the graph within the canvas.
12.2 Building Elements

Using HEATWIN, it is possible to build up a library of building elements for heat flow and condensation analysis, or for use within CONCEPT. Elements can be quickly added, edited or deleted from the currently loaded library.

12.2.1 To Add a New Element

1. Select the Add... item from the Element menu, or use the keyboard shortcut Shift+Insert. The Element Properties dialog box will appear.

2. Simply enter the details of the new element and select the OK button. For more detailed help on individual items, select the Help button in the dialog itself.

12.2.2 To Delete the Current Element

1. Select the Remove... item from the Element menu, or use the keyboard shortcut Shift+Delete.

2. You will be prompted to confirm your intention to delete the current element. Select the OK button to confirm and the Cancel button to abort.

12.2.3 To Edit the Current Element

1. Select the Edit... item from the Element menu, or use the keyboard shortcut Shift+Enter. The Element Properties dialog box will appear.

2. Enter the new details of the element and select the OK button. For more detailed help on individual items, select the Help button in the dialog itself.

12.3 Element Layers

A building element consists of a number of layers of different materials. Layers can be inserted, edited and deleted at any time.

12.3.1 To Insert a New Layer

1. Click the left mouse button in the layer immediately before which you wish to insert the new layer.
2. Select the Insert Layer... item from the Element menu, or simply press the Insert key. The following dialog box will appear.

3. Select the material you wish to insert from the displayed list.
4. Enter the width of the inserted layer in millimetres.
5. Ensure that the index at which the material is to be inserted is correct. You can use this number to insert materials on the inside surface of an element by typing a number one greater than the current number of layers.
6. Select the OK button or press the Enter key.

The new layer will now be shown in the element construction and the heat flow and condensation graph updated automatically.

12.3.2 To Delete a Layer

1. Click the left mouse button in the layer you wish to delete.
2. Select the Delete Layer... item from the Element menu, or simply press the Delete key. The following dialog box will appear:

3. To confirm the deletion, select the OK button. To abort it, select the Cancel button.

12.3.3 To Edit a Layer

1. Click the left mouse button in the layer you wish to edit.
2. Select the Edit Layer... item from the Element menu, or simply press the Enter key. The following dialog box will appear.
3. Change the material and width of the selected layer.

4. Select the OK button or press the Enter key.

12.4 Materials

It is possible to add and delete new materials, if you know their correct characteristics. This information can be obtained from most architectural science texts.

The Material Library dialog box is used to manage basic materials in the library. This can be invoked using the Material Library… item in the Elements menu, or by pressing the F3 function key.

Materials can be added, updated or deleted using the three buttons immediately below the displayed list.
13  PSYCHWIN
Psychrometrics and Climatic Analysis

13.1  Introduction

PSYCHWIN is a supporting application included with the CONCEPT environmental design suite to help analyse climate data and manage location libraries. It can be invoked directly from the Concept group in the Start Up menu or from the Launch item in the Options menu.

13.1.1  The Workspace

The main PSYCHWIN workspace consists of the following functional areas:

- **Menubar and Toolbar**
  This provides a number of pull-down menus and toolbar buttons used to activate application commands. To activate menus or toolbar buttons, select them with the left mouse button.

- **Psychrometric Chart**
  This area displays the psychrometric chart, or weather data if loaded.

- **Statusbar**
  This area displays the status of the application as well as help text.
13.1.2 Keyboard Shortcuts

When the Element Canvas is active, the following keyboard shortcuts apply:

- `<UP ARROW>`  Move cursor up 1 vertical unit
- `<DOWN ARROW>` Move cursor down 1 vertical unit
- `<LEFT ARROW>`  Move cursor left 1 horizontal unit
- `<RIGHT ARROW>` Move cursor right 1 horizontal unit
- `<SHIFT+ARROWS>`  Same as arrows but in 1/10th units
- `<CTRL+ARROWS>` Pans graph in direction of arrow
- `<PAGE UP>` Displays the previous location data
- `<PAGE DOWN>` Displays the next location data
- `<ENTER>` Display Direct Input dialog box
- `<INSERT>` Inserts a new data point in the graph
- `<DELETE>` Deletes current data point in graph
- `<END>` Redraws graph
- `<HOME>` Fits displayed graph to screen
- `<+/->` Zoom in/out on graph

13.1.3 Mouse Buttons

- `<Left Mouse Button>`
  Whilst viewing the Psychrometric Chart, use this button to select and move the current cursor position. This is indicated by a small red box with a small red cross at its centre. To move this around the chart, simple select and drag it as required.

  When viewing Climatic Data there is no visible cursor, so this mouse button simply highlights the various data elements in different parts of the screen.

- `<Right Mouse Button>`
  This button allows you to interactively pan around the chart or graph. Useful if you have zoomed in using the toolbar or keyboard method described.
13.2 The Psychrometric Chart

13.2.1 Overview

Psychrometrics is basically the study of moist air. It is based on the relationship between air temperature and absolute humidity. For a given air temperature, there is a maximum amount of moisture vapour that can be supported within the air before condensation or precipitation occurs. This is known as the saturation humidity and is given in units of grams per kilogram (g/kg). The exact relationship is an exponential function of both air temperature and atmospheric pressure, given as follows:

\[ H_s = 622.0 \frac{\theta}{(7.5 P - \theta)}; \]

where \( \theta = 10^{8.10765 - (1750.286 / (235.0 + T))} \)

\( P \) is the atmospheric pressure (kPa) and \( T \) is the air temperature (°C).

From this relationship it is possible to either derive or relate a number of other measurable qualities of the air: wet-bulb temperature, relative humidity, vapour pressure, specific volume and enthalpy.

13.2.2 The Chart Cursor

The chart takes up the entire graphics canvas. At its centre is a small red box indicating the current cursor position within the chart. Displayed in the top-left corner are details as to the position of this cursor. The details displayed include positional information, given as a dry-bulb temperature and relative humidity, as well as other qualities of the air under those conditions.

The cursor operates in two distinct modes. In absolute mode the information refers to the absolute position and actual conditions. In relative mode, the information is given as a degree of change resulting from the movement from one position to another. In relative mode, the cursor becomes a red arrow, starting at what has been termed the From position and ending at the To position.

You can toggle between relative and absolute cursor mode using the Relative Values item in the Chart menu.

This cursor can be moved interactively using the mouse, incrementally using the cursor keys or directly by inputting its position in the Direct Input dialog box.
13.2.3 To Move the Cursor With the Mouse

1. First visually locate the cursor. It is represented by a small red cross surrounded by a slightly larger red square, as shown.

2. Click within the red square with the left mouse button.
3. Drag the cursor into the desired position and release the mouse button.

The information in the top left of the screen will automatically update.

13.2.4 Move the Cursor With the Keyboard

1. Press the Up Arrow cursor key and hold it down. The small cursor should start moving upwards within the graph. You can use any cursor key to move the cursor in each direction.

The axis of horizontal movement depends upon settings in Direct Input dialog box. To move the cursor in 1/10th units steps, hold down the Shift key along with the arrow key.

13.2.5 Enter Values Directly

1. Press the Enter key or double-click the left mouse button on the cursor position. The Direct Input dialog box will appear.

2. Enter the required temperature and vertical axis unit. The vertical axis can be set to use units of:
   - Relative Humidity (%)
   - Absolute Humidity (g/kg)
   - Vapour Pressure (kPa)

3. The To text boxes will be enabled whenever the cursor mode is set to relative.
4. Select the OK button or press the Enter key.

The vertical axis also affect the cursor keys.
13.2.6  **Graph Extents**

If you need to extend values beyond the default range displayed in the graph, you will need to extend it to the range you require.

13.2.7  **To Set the Graph Extents**

1. **Select the toolbar button or the Graph Extents... item in the Chart menu. The following dialog box will appear.**

   ![Set Chart Extents Dialog Box](image)

2. **Set the required maximum and minimum graph extents. The snap setting refers to intervals the cursor will move in when being dragged by the mouse.**

13.2.8  **Psychrometric Values**

The information displayed in the top left corner of the graph refers to a number of values derived from points within the graph. The values themselves and their meaning is as follows.

13.2.8.1  **Absolute Humidity (AH)**

Refers to the actual amount of moisture vapour present in warm air. It is given as the number of grams of water vapour per kilogram of dry air (g/kg).

13.2.8.2  **Atmospheric Pressure**

Refers to actual pressure being exerted on all objects by the shear weight of air immediately above in the atmosphere. It is usually given in kPa (sometimes hecta-pascals).

13.2.8.3  **Dry Bulb Temperature (DBT)**

Refers to the actual temperature of the air. It is measured using a normal thermometer and is usually given in degrees Celsius (°C) or degrees Kelvin (°K).

13.2.8.4  **Enthalpy**

Refers to the energy content of a given volume of air (as sensible and latent heat) and is given in units of kJ / kg.
### 13.2.8.5 Relative Humidity (RH)

Is basically a ratio between the current amount of moisture vapour in the air and the maximum amount that air can support before condensation and precipitation occurs. It is given by the absolute humidity divided by the saturation humidity, multiplied by 100 to give a percentage (%).

\[
RH = \left( \frac{AH}{SH} \right) \times 100 \%
\]

### 13.2.8.6 Saturation Humidity (SH)

Refers to the maximum amount of moisture vapour air at a particular temperature can support before condensation and precipitation occurs. It is given as the absolute humidity value (g/kg) at which this occurs.

### 13.2.8.7 Specific Volume (SV)

Refers to the volume, in cubic metres, of one kilogram of air at the current temperature and relative humidity. It is given in m$^3$/kg.

### 13.2.8.8 Vapour Pressure (VP)

Refers to the partial pressure of water vapour in the air. It is given in pascal (Pa) and, at normal temperatures, is linearly related to absolute humidity.

### 13.2.8.9 Wet Bulb Temperature (WBT)

Is a function of both air temperature and relative humidity. At very high relative humidities, evaporation is difficult as there is very high vapour pressure, thus the WBT will approach the DBT. At low levels of humidity, the effect of evaporation will be much greater, thus the WBT will be much less than the DBT as a result of its cooling effect.
13.3 Locations and Weather Data

Using PSYCHWIN, it is possible to create climate summaries or load weather data to build up a library of location data for use within CONCEPT. Location can be quickly added, edited or deleted from a library file.

13.3.1 To Add a New Location

1. Select the Add... item from the Location menu. The Edit Weather Data dialog box will appear.

2. Simply enter the details of the new location and select the OK button. For more detailed help on individual items, select the Help button in the dialog itself.

Tabbing through monthly data will result in a closed cycle, allowing you to enter one set of monthly data and then automatically jump back to select the next set of data to input.

It is possible to load hourly weather data in a variety of formats and have PSYCHWIN automatically generate monthly summaries from hourly data.
13.3.2 To Delete the Current Location

1. Select the Delete… item from the Location menu.
2. You will be prompted to confirm your intention to delete the current location.
3. Select the OK button to confirm or the Cancel button to abort.

13.3.3 To Edit the Current Location

1. Select the Edit… item from the Location menu. The Edit Weather Data dialog box will appear.
2. Enter the new details of the location and select the OK button. For more detailed help on individual items, select the Help button in the dialog itself.

13.3.4 Climate Data

PSYCHWIN displays a range of climatic data as monthly summaries. The details of each set of data is as follows.

13.3.4.1 Rainfall

Rainfall data is shown in mm and refers to the total amount of rain falling in each month.

13.3.4.2 Relative Humidity

The definition of relative humidity is given in the previous section. Values for average relative humidity are given for both morning and afternoon, at 0900 and 1500.

13.3.4.3 Temperature

Temperatures are shown in degrees Celsius. Average temperatures are determined from the numeric average of all days in a particular month. Average maxima and minima are calculated from the maximum and minimum temperatures reached on each day.

13.3.4.4 Solar Radiation

Solar radiation is given as an average daily value in W/m². This refers to the total amount of solar radiation falling on a horizontal surface during an average day in each month.

13.3.4.5 Degree Hours

Degree hours refer to the number of hours the dry-bulb temperature is above or below a given reference temperature, multiplied by the actual temperature difference for each hour.

Heating degree days use a base temperature of 18.3°C whilst cooling degree days use 20°C.

Such values allow quick and simple steady state heat flow analysis of buildings if the U-Value of all external surfaces is known.
13.3.4.6  Daylight Hours

This refers to the number of hours of daylight for an average day in each month.

13.3.4.7  Wind Direction

Wind roses have eight sides, corresponding to North, North-East, East, South-East, South, South-West, West and North-West. These show the direction from which the wind is blowing.

Each side has twelve lines which correspond to the 12 months of the year. These rotate from January to December in a clock-wise direction.

The length of each line does not refer to the strength of the wind, but to the percentage of time the wind was measured as coming from this direction. Thus the outer octagon represents 12.5 percent (100/8).